Publication Information

© 2015 Imagine Communications Corp.
Proprietary and Confidential.

Imagine Communications considers this document and its contents to be proprietary and confidential. Except for making a reasonable number of copies for your own internal use, you may not reproduce this publication, or any part thereof, in any form, by any method, for any purpose, or in any language other than English without the written consent of Imagine Communications. All others uses are illegal.

This publication is designed to assist in the use of the product as it exists on the date of publication of this manual, and may not reflect the product at the current time or an unknown time in the future. This publication does not in any way warrant description accuracy or guarantee the use for the product to which it refers. Imagine Communications reserves the right, without notice to make such changes in equipment, design, specifications, components, or documentation as progress may warrant to improve the performance of the product.

Trademarks

Magellan™, Magellan CCS Navigator™, Selenio™ MCP3, Selenio™ MCP1, Selenio 6800+™, Selenio X50™, Selenio X85™, Selenio X100™, Platinum™ SX Pro, Platinum™ SX Hybrid, Platinum™ Predator II-GX, Platinum™ Predator II-GRF, Platinum™ IP3, Platinum™ are trademarks or trade names of Imagine Communications or its subsidiaries.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. All other trademarks and trade names are the property of their respective companies.

Contact Information

Imagine Communications has office locations around the world. For domestic and international location and contact information, visit our Contact page (http://www.imaginecommunications.com/company/contact-us.aspx).

Support Contact Information

For domestic and international support contact information see:

- Support Contacts (http://www.imaginewithus.com/services/customer-care.aspx)
- eCustomer Portal (http://support.imaginewithus.com)
- Academy Training (http://www.imaginewithusacademy.com)
Contents

Preface........................................................................................................................................ 10
   Manual Information ................................................................................................................ 10
   Purpose................................................................................................................................ 10
   Magellan Router Control Panel Applications ..................................................................... 10
   Audience............................................................................................................................... 10
   Writing Conventions ............................................................................................................. 10
   Revision History .................................................................................................................... 11
   Obtaining Documents .......................................................................................................... 12
Unpacking/Shipping Information ............................................................................................. 13
   Unpacking a Product ............................................................................................................. 13
   Product Servicing .................................................................................................................. 13
   Returning a Product .............................................................................................................. 13
Safety....................................................................................................................................... 14
   Safety Terms and Symbols in this Manual ........................................................................ 14
   Ensuring Safety ..................................................................................................................... 14
   References ............................................................................................................................ 15
Directives and Compliances ..................................................................................................... 17
   Restriction on Hazardous Substances (RoHS) Compliance ............................................... 17
   Waste from Electrical and Electronic Equipment (WEEE) Compliance .......................... 18
Introduction............................................................................................................................... 19
   Product Description .............................................................................................................. 19
   Front and Back Panel Views ............................................................................................... 19
      Pushbutton Panels ............................................................................................................ 20
      Pushbutton Panels with OLED Displays ........................................................................ 21
      LCD Button Panels ......................................................................................................... 21
      LCD Button Panels with OLED Displays ....................................................................... 22
      Back Panel Views ............................................................................................................ 23
   Product Features .................................................................................................................. 24
      Pushbutton Panels ............................................................................................................ 24
      Pushbutton Panels with OLED ..................................................................................... 24
Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Panels</td>
<td>24</td>
</tr>
<tr>
<td>LCD Panels with OLED</td>
<td>25</td>
</tr>
<tr>
<td>Front Panel Controls</td>
<td>26</td>
</tr>
<tr>
<td>Safety Standards and Instructions</td>
<td>31</td>
</tr>
<tr>
<td>Magellan Router Control Panel Service and Support</td>
<td>31</td>
</tr>
<tr>
<td><strong>Installation</strong></td>
<td>32</td>
</tr>
<tr>
<td>Unpacking Panels</td>
<td>32</td>
</tr>
<tr>
<td>Siting Requirements</td>
<td>32</td>
</tr>
<tr>
<td>Adequate Rack Space</td>
<td>33</td>
</tr>
<tr>
<td>Proper Temperature</td>
<td>33</td>
</tr>
<tr>
<td>Electrical Requirements</td>
<td>33</td>
</tr>
<tr>
<td>Back Panel Connections</td>
<td>33</td>
</tr>
<tr>
<td>X-Y Ports</td>
<td>34</td>
</tr>
<tr>
<td>Service (Serial) Connection</td>
<td>34</td>
</tr>
<tr>
<td>Ethernet Connection</td>
<td>34</td>
</tr>
<tr>
<td>Mounting Panels</td>
<td>35</td>
</tr>
<tr>
<td>Tools You Will Need</td>
<td>35</td>
</tr>
<tr>
<td>Mounting Requirements</td>
<td>35</td>
</tr>
<tr>
<td>Panel Installation Procedure</td>
<td>35</td>
</tr>
<tr>
<td>Ethernet Setup</td>
<td>36</td>
</tr>
<tr>
<td>Supported Browsers</td>
<td>37</td>
</tr>
<tr>
<td>Setting Up Microsoft Internet Explorer</td>
<td>37</td>
</tr>
<tr>
<td><strong>Starting Panel Configuration</strong></td>
<td>38</td>
</tr>
<tr>
<td>Login Credentials</td>
<td>38</td>
</tr>
<tr>
<td>Adding Panels to a Database</td>
<td>39</td>
</tr>
<tr>
<td>Adding Panels by Polling</td>
<td>39</td>
</tr>
<tr>
<td>Adding Panels by Discovering</td>
<td>39</td>
</tr>
<tr>
<td>Adding Panels using the Create Command</td>
<td>40</td>
</tr>
<tr>
<td>Offline Configuration Editor</td>
<td>40</td>
</tr>
<tr>
<td>Installing the Offline Configuration Editor</td>
<td>40</td>
</tr>
<tr>
<td><strong>Software Configuration</strong></td>
<td>42</td>
</tr>
<tr>
<td>Summary Page</td>
<td>42</td>
</tr>
<tr>
<td>Physical Settings</td>
<td>43</td>
</tr>
<tr>
<td>Panel Versions and Licenses</td>
<td>43</td>
</tr>
<tr>
<td>Panel Options</td>
<td>44</td>
</tr>
<tr>
<td>Current Configuration</td>
<td>45</td>
</tr>
<tr>
<td>Alarm Definitions</td>
<td>45</td>
</tr>
<tr>
<td>Operation Modes</td>
<td>46</td>
</tr>
</tbody>
</table>

© 2015 Imagine Communications Corp.  Proprietary and Confidential.  Version 3.6 | Page 4
Configurations Page ................................................................. 54
Support Page .............................................................................. 56
Tools Page ................................................................................ 57
Users ......................................................................................... 58
Offline Configuration ................................................................. 59
On-Line Configuration ................................................................ 60

Panel Configuration ................................................................. 61
Devices You Can Control ......................................................... 61
Creating a New Panel Configuration ......................................... 62
  Configuration Navigation ........................................................ 63
  General Configuration ............................................................ 65
  Panel Gang Configuration ....................................................... 66
Deleting a Panel Configuration .................................................. 68
Duplicating an Existing Panel Configuration ............................ 68
Importing a Configuration into an Existing Configuration .......... 69
Function Buttons ....................................................................... 69
  Configuration Home Buttons .................................................... 69
  Undoing a Take ....................................................................... 70
  Unity ...................................................................................... 72
Magellan Router Control Panel Discovery via Magellan™ CCS Navigator ................................................. 72
  Process to Discover a Magellan Router Control Panel in Magellan CCS Navigator ...................... 73
  Process to Discover another Magellan Router Control Panel ......................................................... 76
Clean and Quiet Switching ......................................................... 76

Processing Configuration ......................................................... 77
Creating a Processing Configuration ........................................... 77
  Tabs in a Processing Configuration .......................................... 78
  Device Discovery and Mapping ................................................. 82
Deleting a Processing Configuration ............................................ 92
Creating a Processing Configuration on PB-OLED Panels .......... 92
  PB-OLED Panels - Notes ....................................................... 92
Controlling a Selenio™ Clean and Quiet (CQS) Module ............... 93
Configuration Templates ......................................................... 95
  Steps to create a Configuration Template ............................... 95
Presets ....................................................................................... 95
  How to Save (Map) a Preset ................................................... 95

Router Configuration ............................................................... 97
Create New Router Configuration ............................................. 97
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Router Configuration</td>
<td>99</td>
</tr>
<tr>
<td>Tabs in a Router Configuration</td>
<td>100</td>
</tr>
<tr>
<td>Support for 64 Levels</td>
<td>101</td>
</tr>
<tr>
<td>Other Devices in a Router Configuration</td>
<td>103</td>
</tr>
<tr>
<td>Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration</td>
<td>103</td>
</tr>
<tr>
<td>Platinum MADI (PT-MADI4X-OBG) in a Router Configuration</td>
<td>104</td>
</tr>
<tr>
<td>Platinum Frame Synchronizer (PT-FSDMX-IBG) in a Router Configuration</td>
<td>111</td>
</tr>
<tr>
<td>Router Configuration - Panel Operation Modes</td>
<td>112</td>
</tr>
<tr>
<td>Button Per Source (BPS) Mode</td>
<td>112</td>
</tr>
<tr>
<td>Category/Index Mode</td>
<td>114</td>
</tr>
<tr>
<td>Group Mode</td>
<td>116</td>
</tr>
<tr>
<td>Multibus Mode</td>
<td>118</td>
</tr>
<tr>
<td>Group Mode with Multibus</td>
<td>118</td>
</tr>
<tr>
<td>Selenio Preset Mode Panel</td>
<td>119</td>
</tr>
<tr>
<td>Panel Configuration with non-Ethernet Routers (XY Coax Connection)</td>
<td>119</td>
</tr>
<tr>
<td>Router Configuration - Panel Functions</td>
<td>124</td>
</tr>
<tr>
<td>Panel Modes</td>
<td>124</td>
</tr>
<tr>
<td>Detailed Settings for Operation Mode Panels</td>
<td>131</td>
</tr>
<tr>
<td>Enabling and Disabling Panels</td>
<td>132</td>
</tr>
<tr>
<td>Page Up/Down In Status Display</td>
<td>133</td>
</tr>
<tr>
<td>Router Configuration - Button Functions</td>
<td>133</td>
</tr>
<tr>
<td>Support for Copy/Cut/Paste/Drag and Drop Button Assignations</td>
<td>133</td>
</tr>
<tr>
<td>Pin/Unpin Functionality</td>
<td>135</td>
</tr>
<tr>
<td>Scrolling Dynamic Sources/Destinations</td>
<td>136</td>
</tr>
<tr>
<td>Previous/Next Buttons</td>
<td>136</td>
</tr>
<tr>
<td>Router Configuration - Other Functions</td>
<td>138</td>
</tr>
<tr>
<td>Process Templates in a Router Configuration</td>
<td>138</td>
</tr>
<tr>
<td>Dynamic Crosspoints</td>
<td>140</td>
</tr>
<tr>
<td>TRAX Functionality</td>
<td>144</td>
</tr>
<tr>
<td>Routers in Tieline Mode - Handling ThreadFull messages</td>
<td>150</td>
</tr>
<tr>
<td>Configuring Clean and Quiet Switching for a Platinum™ VX Router</td>
<td>150</td>
</tr>
<tr>
<td>Report Levels</td>
<td>153</td>
</tr>
<tr>
<td>Multiviewer Configuration</td>
<td>156</td>
</tr>
<tr>
<td>Creating a Multiviewer Configuration</td>
<td>156</td>
</tr>
<tr>
<td>Create New Multiviewer Configuration</td>
<td>156</td>
</tr>
<tr>
<td>Import Multiviewer Configuration</td>
<td>157</td>
</tr>
<tr>
<td>Multiviewer Discovery</td>
<td>157</td>
</tr>
<tr>
<td>Mapping buttons to Multiviewer Elements</td>
<td>157</td>
</tr>
<tr>
<td>Mapping Platinum SX Pro</td>
<td>157</td>
</tr>
</tbody>
</table>
Multiviewer Configuration for Pushbutton (PB) Only Panels .......................... 160
Creating a Multiviewer Configuration on PB Only Panels .................................. 160
PB Only Panels - Notes ......................................................................................... 160

Common Configuration Tasks ............................................................................... 161
Accessing Error Logs .......................................................................................... 162
Accessing the Imagine Communications Website ............................................. 163
Accessing the Imagine Communications Service Web Portal ........................ 163
Activating a Configuration .................................................................................. 163
LCD Panels without OLED ................................................................................ 164
Adjusting Default Button Colors ..................................................................... 164
Batch Exporting and Importing Configurations ................................................. 164
Batch Exporting Configurations ..................................................................... 165
Batch Importing Configurations ..................................................................... 166
Changing Access Lists (Router) ......................................................................... 166
Changing Appearance Options ......................................................................... 166
Changing Button Properties ............................................................................ 167
Changing Button Text Appearance .................................................................. 167
Global Button Text Settings ............................................................................. 167
Local Button Text Settings ............................................................................... 169
Changing Category Assignments ....................................................................... 169
Changing Communication Options .................................................................. 170
Changing Destination Assignments .................................................................. 170
Changing Index Assignments ........................................................................... 171
Changing Level Assignments ........................................................................... 172
Changing Logical Control Options ................................................................... 172
Changing OLED Text Appearance .................................................................. 174
Changing Panel Options .................................................................................. 174
Changing Panel Physical Settings .................................................................... 175
Changing Salvo Assignments ........................................................................... 175
Changing Source Assignments ......................................................................... 176
Copying a Panel Configuration to Other Control Panels ................................. 177
Creating Custom Pages .................................................................................... 178
Defining Alarm Conditions .............................................................................. 180
Deleting a Panel Configuration ......................................................................... 180
Duplicating a Panel Configuration .................................................................... 180

Mapping Platinum SX Hybrid/IP ..................................................................... 158
Mapping Selenio 6800+/Platinum Predator II.................................................. 159
Invoking the Multiviewer .................................................................................. 159

Notes
Contents

Editing Button Colors ................................................................. 180
Editing Button Types ................................................................. 181
Enabling User Access ................................................................. 189
Enabling or Disabling USB Port Functions .................................... 189
Enhanced Salvos ......................................................................... 189
Exporting Configurations ......................................................... 190
Fonts based on Configuration ....................................................... 190
Finding Panel-Specific Information ............................................... 191
Generating Button Labels ............................................................ 192
Generating Service Reports ......................................................... 192
Identifying a Panel ....................................................................... 193
Importing Configurations ............................................................. 193
Installing and Removing Fonts ...................................................... 194
Primary and Secondary Server IPs ............................................... 194
Reloading Configurations .............................................................. 195
Removing Local Aliases ............................................................... 195
Removing Local Salvos ............................................................... 195
Restarting a Panel ....................................................................... 196
Restoring Panel Defaults ............................................................. 196
Saving a Configuration ................................................................. 196
Selecting Panel Operation Modes .................................................. 196
Setting Screensaver Options ........................................................ 197
Setting the Panel License ID .......................................................... 197
Setting Up Local Aliases .............................................................. 198
Show/Hide Status on Destination buttons ....................................... 198
  Global Setting .......................................................................... 198
  Local Setting ............................................................................ 199
Synchronizing Database structure from another Router ............... 200
Upgrading Multiple Panels ............................................................ 201
Upgrading Panel Firmware ........................................................... 201
Using the Offline Configuration Editor ......................................... 202

Front Panel Configuration Tasks .................................................. 204
Adding a Device ........................................................................... 204
Selecting a Panel Configuration ................................................... 204
Selecting Destinations ................................................................. 205
Selecting Sources ....................................................................... 205
Selecting Salvos ......................................................................... 206
Selecting Display Names ............................................................... 206
Setting Connection Type ............................................................... 206
Setup Mode ........................................................................................................................................... 207
Changing a Panel ID ................................................................................................................................. 207
Changing a Panel IP Address ..................................................................................................................... 207
Changing a Panel Gateway Address .......................................................................................................... 208
Changing a Panel Subnet ............................................................................................................................ 208
Changing a MAC Address .......................................................................................................................... 208
Setting Primary and Secondary Server .................................................................................................... 209
Toggling Primary and Secondary Server .................................................................................................... 209
Viewing Hardware and Software Versions ................................................................................................ 209
Rebooting a Panel ...................................................................................................................................... 209
Invoking a Chop ......................................................................................................................................... 210
USB ......................................................................................................................................................... 210
Screensaver ............................................................................................................................................... 210

Frequently Asked Questions .................................................................................................................... 212

Specifications ............................................................................................................................................ 215
  Electrical Specifications ............................................................................................................................. 215
  Mechanical Specifications ......................................................................................................................... 215
  Input/Output Specifications ....................................................................................................................... 216

Index ......................................................................................................................................................... 217
Preface

Manual Information

Purpose

This manual details the features, installation, operation, maintenance, and specifications for the Magellan Router Control Panel.

Magellan Router Control Panel Applications

Magellan Router Control Panels are ideal for operations where professional end users require a small, flexible protocol translator to provide interoperability between routers and control systems made by more than one manufacturer.

Magellan Router Control Panels are perfect for any routing panel application especially in the following situations:

- Routing facilities requiring frequent relabeling of panel buttons
- Mobile or truck installations
- Remote or local control of router systems

Audience

This manual is written for engineers, technicians, and operators responsible for installation, setup, maintenance, and/or operation of the Magellan Router Control Panel.

Writing Conventions

This manual adheres to the following writing conventions.

<table>
<thead>
<tr>
<th>Term or Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Indicates dialog box, property sheet, field, button, check box, list box, combo box, menu, submenu, window, list, and selection names</td>
</tr>
<tr>
<td>Italics</td>
<td>Indicates email addresses, names of books and publications, and first instances of new terms and specialized words that need emphasis</td>
</tr>
<tr>
<td>CAPS</td>
<td>Indicates a specific key on the keyboard, such as ENTER, TAB, CTRL, ALT, DELETE</td>
</tr>
<tr>
<td>Code</td>
<td>Indicates variables or command-line entries, such as a DOS entry or something you type into a field.</td>
</tr>
<tr>
<td>Term or Convention</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>&gt;</td>
<td>Indicates the direction of navigation through a hierarchy of menus and windows</td>
</tr>
<tr>
<td>hyperlink</td>
<td>Indicates a jump to another location within the electronic document or elsewhere</td>
</tr>
<tr>
<td>Internet address</td>
<td>Indicates a jump to a Web site or URL</td>
</tr>
</tbody>
</table>

### Revision History

<table>
<thead>
<tr>
<th>Edition</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>August 2010</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>October 2011</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>March 2012</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>August 2012</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>October 2012</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>May 2013</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>October 2013</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>March 2014</td>
<td></td>
</tr>
<tr>
<td>3.3</td>
<td>July 2014</td>
<td></td>
</tr>
<tr>
<td>3.5</td>
<td>December 2014</td>
<td></td>
</tr>
<tr>
<td>Edition</td>
<td>Date</td>
<td>Comments</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 3.6     | July 2015 | • Support for Clean and Quiet Switching (See Clean and Quiet Switching (on page 76))  
• Clean and Quiet Switching for Platinum™ VX (See Configuring Clean and Quiet Switching for a Platinum™ VX Router (on page 150))  
• Clean and Quiet Switching for Selenio™ CQS (See Controlling a Selenio™ Clean and Quiet (see "Controlling a Selenio™ Clean and Quiet (CQS) Module” on page 93))  
• Previous/Next Function Buttons (See Previous/Next Buttons (on page 136))  
• Show Parameter Value functionality (See Show Parameter Value (on page 87))  
• Support for global and local LCD text layout options in Processing configurations. (See Changing Button Text Appearance (on page 167))  
• Support for 64 Levels in a Router configuration (See Support for 64 Levels (on page 101))  
• Report Levels (See Report Levels (on page 153))  
• Edits to Control Mode functionality, including Sticky Mode, and emulating the knob (See Control Mode (on page 46))  
• Minor edits to the Frequently Asked Questions section (See Frequently Asked Questions (on page 212))  
• Note added to Undoing a Take section (See Undoing a Take (on page 70))  
• Added a note to the Ganged Parameters section (See Ganging Parameters (on page 90))  
• Updated Supported Browsers (See Supported Browsers (on page 37))  
• Added a note about the Configuration Home to the Control Mode notes (See Control Mode Notes (on page 50))  
• Added a note about Breakaway Mode to the Control Mode section (See Control Mode (on page 46))  
• Added info about Operator/Administrator users being able to take control of a Software panel currently being controlled by another user. (See Control Mode (on page 46))  
• Added a note about the panel being in a locked state if switching configurations and publishing from Navigator occurs in parallel. (See Configurations Page (on page 54))                  |

### Obtaining Documents

Product support documents can be viewed or downloaded from our website. Alternatively, contact your Customer Service representative to request a document.
Unpacking/Shipping Information

Unpacking a Product

This product was carefully inspected, tested, and calibrated before shipment to ensure years of stable and trouble-free service.

1. Check equipment for any visible damage that may have occurred during transit.
2. Confirm that you have received all items listed on the packing list.
3. Contact your dealer if any item on the packing list is missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated components before you install the unit.

Keep at least one set of original packaging, in the event that you need to return a product for servicing.

Product Servicing

Except for firmware upgrades, modules are not designed for field servicing. All hardware upgrades, modifications, or repairs require you to return the modules to the Customer Service center.

Returning a Product

In the unlikely event that your product fails to operate properly, please contact Customer Service to obtain a Return Authorization (RA) number, and then send the unit back for servicing.

Keep at least one set of original packaging in the event that a product needs to be returned for service. If the original package is not available, you can supply your own packaging as long as it meets the following criteria:

- The packaging must be able to withstand the product’s weight.
- The product must be held rigid within the packaging.
- There must be at least 2 in. (5 cm) of space between the product and the container.
- The corners of the product must be protected.

Ship products back to us for servicing prepaid and, if possible, in the original packaging material. If the product is still within the warranty period, we will return the product prepaid after servicing.
Safety

Carefully review all safety precautions to avoid injury and prevent damage to this product or any products connected to it. If this product is rack-mountable, it should be mounted in an appropriate rack using the rack-mounting positions and rear support guides provided. It is recommended that each frame be connected to a separate electrical circuit for protection against circuit overloading. If this product relies on forced air cooling, it is recommended that all obstructions to the air flow be removed prior to mounting the frame in the rack.

If this product has a provision for external earth grounding, it is recommended that the frame be grounded to earth via the protective earth ground on the rear panel.

IMPORTANT! Only qualified personnel should perform service procedures.

Safety Terms and Symbols in this Manual

<table>
<thead>
<tr>
<th>△</th>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statements identifying conditions or practices that may result in personal injury or loss of life. High voltage is present.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>△</th>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statements identifying conditions or practices that can result in damage to the equipment or other property.</td>
<td></td>
</tr>
</tbody>
</table>

Ensuring Safety

- The unit should not be exposed to dripping or splashing, and no objects filled with liquids, such as vases, shall be placed on the unit.
- Operate built in units only when they are properly fitted into the system.
- For permanently cabled units without built in fuses, automatic switches, or similar protective facilities, the AC supply line must be fitted with fuses rated to the units.
- Units of Protection Class I with an AC supply cable and plug that can be disconnected must be operated only from a power socket with protective ground contact:
  - Do not use an extension cable—it can render the protective ground connection ineffective.
  - Do not intentionally interrupt the protective ground conductor.
  - Do not break the protective ground conductor or loosen the protective ground connection; such actions can cause the unit to become electrically hazardous.
• Before opening the unit, isolate it from the AC supply. Then, ensure that
  ▪ Adjustments, part replacements, maintenance, and repairs are carried out by qualified personnel only.
  ▪ Safety regulations and rules are observed to prevent accidents. Only original parts are used to replace parts relevant to safety.
• Use caution when cleaning the equipment; isopropyl alcohol or similar solvents can damage or remove the labels.
• Observe any additional safety instructions specified in this document.

References

AES3-2003
AES Recommended Practice for Digital Audio I/O Interfacing – Serial Transmission Format for Two-Channel Linearly Represented Digital Audio Data

ANSI/SMPTE 259M-2006
SDTV Digital Signal/Data – Serial Digital Interface

ANSI/SMPTE 276M-1995
Transmission of AES/EBU Digital Audio Signal Over Coaxial Cable

SMPTE 292M-2006
1.5 Gb/s Signal/Data Serial Interface

SMPTE 291M-2006
Ancillary Data Packet and Space Formatting

SMPTE 337M-2000
Format for Non-PCM Audio and Data in an AES3 Serial Digital Audio Interface

SMPTE 346-M 2000
Time Division Multiplexing Video Signals and Generic Data over High-Definition Interface

SMPTE 352-M 2002
Video Payload Identification for Digital Interfaces

SMPTE 424-M 2006
3Gb/s Signal/Data Serial Interface

SMPTE 425-M 2006
3Gb/s Signal/Data Serial Interface – Source Image Format Mapping
SMPTE 2020-1-2008
Format of Audio Metadata and Description of the Async Serial Bitstream Transport.

SMPTE 2020-2-2008
Vertical Ancillary Data Mapping of Audio Metadata - Method A

SMPTE 2020-3-2008
Vertical Ancillary Data Mapping of Audio Metadata - Method B

SMPTE RP 184-2004
Specification of Jitter in Bit-Serial Digital Systems

EIA/TIA-422-B 1994
Electrical Characteristics of Balanced Voltage Digital Interface Circuits

EN55103-1
EMC emission requirements applies to professional audio, video, audio-visual and entertainment lighting control apparatus

EN55103-2
EMC immunity requirements applies to professional audio, video, audio-visual and entertainment lighting control apparatus

ITU-R BT.601-5
Studio Encoding Parameters of Digital Television for Standard 4:3 and Wide-Screen 16:9 Aspect Ratios

ITU-R BT.709-5
Parameter Values for the HDTV Standards for Production and International Programme Exchange

RDD 06 - 2008
Description and Guide to the Use of the Dolby® E Audio Metadata Serial Bitstream

RDD 19 - 2011
Guidelines on the Use of Dolby® E with Video Signals at Frame Rates Greater than 30 Hz

TIA/EIA-232-E 1991
Interface Between Data Terminal Equipment and Data Circuit-Terminating Equipment Employing Serial Binary Data Interchange

47 Code of Federal Regulations
Part 15 FCC rules—Radio Frequency Devices
Directives and Compliances

This section provides information concerning compliance with EU Directive 2002/95/EC and EU Directive 2002/96/EC.

Restriction on Hazardous Substances (RoHS) Compliance

Directive 2011/65/EU—commonly known as the European Union (EU) Restriction on Hazardous Substances (RoHS)—sets limits on the use of certain substances found in electrical and electronic equipment. The intent of this legislation is to reduce the amount of hazardous chemicals that may leach out of landfill sites or otherwise contaminate the environment during end-of-life recycling. The Directive, which took effect on June 8, 2011, refers to the following hazardous substances:

- Lead (Pb)
- Mercury (Hg)
- Cadmium (Cd)
- Hexavalent Chromium (Cr-V1)
- Polychlorinated Biphenyls (PBB)
- Polybrominated Diphenyl Ethers (PBDE)

According to this EU Directive, all products sold in the European Union will be fully RoHS-compliant and “lead-free.” (See our website for more information.) Spare parts supplied for the repair and upgrade of equipment sold before July 1, 2006 are exempt from the legislation. Equipment that complies with the EU directive will be marked with a RoHS-compliant emblem.
Waste from Electrical and Electronic Equipment (WEEE) Compliance

The European Union (EU) Directive 2012/19/EU on Waste from Electrical and Electronic Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical and electronic waste products. The objective of the WEEE Directive is to assign the responsibility for the disposal of associated hazardous waste to either the producers or users of these products. As of July 4, 2012, the producers or users of these products were required to recycle electrical and electronic equipment at end of its useful life, and may not dispose of the equipment in landfills or by using other unapproved methods. (Some EU member states may have different deadlines.)

In accordance with this EU Directive, companies selling electric or electronic devices in the EU will affix labels indicating that such products must be properly recycled. (See our website for more information.) Contact your local sales representative for information on returning these products for recycling. Equipment that complies with the EU directive will be marked with a WEEE-compliant emblem.
Introduction

This section covers the following information:

- Product Description (on page 19)
- Front and Back Panel Views (on page 19)
- Product Features (on page 24)
- Safety Standards and Instructions (on page 31)
- Magellan Service and Support (see "Magellan Router Control Panel Service and Support" on page 31)

Product Description

Magellan Router Control Panels provide user-configurable access to all product control and status parameters for remote operation. They are equipped with user-programmable liquid crystal display buttons, as well as user-assignable device preset buttons. Magellan Router Control Panels combine the ease of operation of a button-per-crosspoint control panel, the clarity of LCD display buttons, and the flexibility of programmability.

Front and Back Panel Views

Magellan control panels are available in the following configurations:

- Pushbutton Panels (on page 20)
- Pushbutton Panels with OLED Displays (on page 21)
- LCD Button Panels (on page 21)
- LCD Button Panels with OLED Displays (on page 22)

These programmable control panels allow for numerous button function assignments via Navigator configuration utility software.

Note: Each panel's default operation mode is provided in its description information. See Control Panel Operation Modes for a list of operation modes available for each Magellan Router Control Panel type.
Pushbutton Panels

RCP-16PB

The RCP-16PB is a 1RU panel with 16 programmable pushbuttons. Its factory-default setup is 16×1 and its factory-default operation is button per source mode.

Figure 1: RCP-16PB Front Panel

RCP-48PB

The RCP-48PB is a 1RU panel with 48 programmable pushbuttons. Its factory-default setup is 48×1 and its factory-default operation is button per source mode.

Figure 2: RCP-48PB Front Panel

RCP-96PB

The RCP-96PB is a 2RU panel with 96 programmable pushbuttons. Its factory-default setup is 48×48 and its factory-default operation is button per source mode.

Figure 3: RCP-96PB Front Panel
Pushbutton Panels with OLED Displays

RCP-32PB-OLED

The RCP-32PB-OLED is a 1RU pushbutton panel with 32 programmable pushbuttons, an LED display, and a scroll knob. Its factory-default operation configuration is category/index mode.

RCP-64PB-OLED

The RCP-64PB-OLED is a 2RU pushbutton panel with 64 programmable pushbuttons, 2 LED displays, and 2 scroll knobs. Its factory-default operation configuration is category/index mode.

LCD Button Panels

Note: Changing Button Properties (on page 167) provides information on setting up LCD buttons. Brief descriptions of button functions are in the Front Panel Controls section. (Complete details of the multiple button functions possible can be found in the Magellan CCS Navigator software manual provided with your Magellan Router Control Panel).

RCP-16LCD

The RCP-16LCD is a 1RU panel with 16 programmable LCD buttons. Its factory-default operation configuration is grouping mode.
RCP-32LCD

The RCP-32LCD is a 1RU panel with 32 programmable LCD buttons. Its factory-default operation configuration is grouping mode.

Figure 7: RCP-32LCD Front Panel

RCP-64LCD

The RCP-64LCD is a 1RU panel with 64 programmable LCD buttons. Its factory-default operation configuration is grouping mode.

Figure 8: RCP-64LCD Front Panel

LCD Button Panels with OLED Displays

RCP-24LCD-OLED

The RCP-24LCD-OLED is a 1RU pushbutton panel with 24 programmable LCD buttons, an LED display, and a scroll knob. Its factory-default operation configuration is grouping mode.

Figure 9: RCP-24LCD-OLED Front Panel
RCP-48LCD-OLED

The RCP-48LCD-OLED is a 2RU pushbutton panel with 48 programmable LCD buttons, 2 LED displays, and 2 scroll knobs. Its factory-default operation configuration is grouping mode.

Figure 10: RCP-48LCD-OLED Front Panel

Back Panel Views

The following graphics show the back panel views of the Magellan Router Control Panels.

See Front Panel Controls (on page 26) for descriptions of the front panel components. See Back Panel Connections (on page 33) for descriptions of the back panel components.

Figure 11: Magellan Router Control Panel 1RU Back Panel

Figure 12: Magellan Router Control Panel 2RU Back Panel
Product Features

The Magellan Router Control Panels have one or more of the following features, as described.

**Pushbutton Panels**
- Available in 1RU and 2RU sizes
- Simple configuration setup via software
- 10/100 Base-T Ethernet connectivity to other peripheral devices
- Completely programmable push buttons
- Fast and intuitive operation
- Follow/breakaway support
- Ability to view and switch all levels of the router
- Can be configured as to operate in multi bus or single bus mode
- Button per source configuration with ability to page to more sources and destinations

**Pushbutton Panels with OLED**
- Available in 1RU and 2RU sizes
- 1RU models are equipped with a front panel LED display and selection control knob; 2 RU models are equipped with two front panel LED displays and two selection control knobs
- Simple configuration setup via software
- USB port available for downloading upgrades and alternate configurations
- 10/100 Base-T Ethernet connectivity to other peripheral devices
- Software-enabled grouping of multiple sources and/or destinations that can act as categories and indexes
- Completely programmable push buttons
- Fast and intuitive operation
- Follow/breakaway support
- Ability to view and switch all levels of the router
- Can be configured as to operate in grouping (with LCD buttons only), multibus, single bus, or button per source mode

**LCD Panels**
- Available in 1RU and 2RU sizes
- Simple configuration setup via software
- USB port available for downloading upgrades and alternate configurations
- Completely programmable and relegendable LCD buttons
- Choice of text size and backlight intensity in buttons
- Ability to display user-configured text in buttons
- Ability to display simple 1-bit graphics in button LCD displays
• Eight non-LCD function (auxiliary) buttons
• All button functions programmable
• 10/100 Base-T Ethernet connectivity to other peripheral devices
• Network setup via front panel LCD menu
• Inversion of the LCD display on active buttons (negative image)
• Software-enabled grouping of multiple sources and/or destinations that can act as categories and indexes
• Ability to create local salvos
• Ability to create local aliases
• Unicode support
• Can be configured as to operate in Category/Index mode or enhanced button per source

**LCD Panels with OLED**

• Available in 1RU and 2RU sizes
• 1RU models are equipped with a front panel LED display and selection control knob; 2 RU models are equipped with two front panel LED displays and two selection control knobs
• Simple configuration setup via software
• USB port available for downloading upgrades and alternate configurations
• Completely programmable and relegendable LCD buttons
• Choice of text size and backlight intensity in buttons
• Ability to display user-configured text in buttons
• Ability to display simple 1-bit graphics in button LCD displays
• Eight non-LCD function (auxiliary) buttons
• All button functions programmable
• Allows selection of alternate button definitions to provide a "virtual" panel of much greater size
• 10/100 Base-T Ethernet connectivity to other peripheral devices
• Network setup via front panel LCD menu
• Inversion of the LCD display on active buttons (negative image)
• Software-enabled grouping of multiple sources and/or destinations that can act as categories and indexes
• Ability to create local salvos
• Ability to create local aliases
• Unicode support
• Can be configured as to operate in grouping, multibus, single bus, or button per source mode
Front Panel Controls

For 2 RU panels (RCP-48LCD-OLED, RCP-64PB-OLED, RCP-64LCD), the bottom four function buttons are not programmable, and are reserved for saving and loading presets.

Figure 13: Pushbutton Panels - Front Panel Controls

Table 1: Pushbutton Panels - Front Panel Controls

<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LOCK</td>
<td>Lock key</td>
</tr>
<tr>
<td>2</td>
<td>FOL</td>
<td>Follow key</td>
</tr>
<tr>
<td>3</td>
<td>Varies</td>
<td>Programmable pushbuttons</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 2: Pushbutton Panels with OLED - Front Panel Control Descriptions

<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LOCK</td>
<td>Lock key</td>
</tr>
<tr>
<td>2</td>
<td>BRK</td>
<td>Breakaway key</td>
</tr>
<tr>
<td></td>
<td>FOL</td>
<td>Follow key</td>
</tr>
<tr>
<td>3</td>
<td>DEST</td>
<td>Destination key</td>
</tr>
<tr>
<td></td>
<td>SRC</td>
<td>Sources key</td>
</tr>
<tr>
<td>4</td>
<td>TAKE</td>
<td>Take key</td>
</tr>
<tr>
<td>5</td>
<td>Varies</td>
<td>Programmable pushbuttons</td>
</tr>
<tr>
<td>6</td>
<td>—</td>
<td>Status and alarm indicators</td>
</tr>
<tr>
<td>7</td>
<td>SHIFT</td>
<td>Shift key</td>
</tr>
<tr>
<td>8</td>
<td>PG UP</td>
<td>Page up key</td>
</tr>
<tr>
<td></td>
<td>MENU</td>
<td>Menu key</td>
</tr>
</tbody>
</table>

* Not available on RCP-16PB or RCP-48PB panels.
<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>PG DN</td>
<td>Page down key</td>
</tr>
<tr>
<td>9</td>
<td>PARM</td>
<td>Parameter key</td>
</tr>
<tr>
<td>10</td>
<td>CLEAR</td>
<td>Clear key</td>
</tr>
<tr>
<td>10</td>
<td>HOME</td>
<td>Home key</td>
</tr>
<tr>
<td>11</td>
<td><img src="image" alt="USB" /></td>
<td>USB port</td>
</tr>
<tr>
<td>12</td>
<td>Varies</td>
<td>OLED display</td>
</tr>
<tr>
<td>13*</td>
<td>—</td>
<td>Additional operation keys</td>
</tr>
<tr>
<td>14</td>
<td>—</td>
<td>Scroll knob</td>
</tr>
</tbody>
</table>

*Not available on RCP32PB-OLED panels.

Figure 15: LCD Button Panels - Front Panel Controls
<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BRK FOL</td>
<td>Breakaway key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Follow key</td>
</tr>
<tr>
<td>2</td>
<td>DEST MENU</td>
<td>Destination key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Menu key</td>
</tr>
<tr>
<td>3</td>
<td>SRC PRST</td>
<td>Sources key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Preset key</td>
</tr>
<tr>
<td>4</td>
<td>TAKE</td>
<td>Take key;</td>
</tr>
<tr>
<td>5</td>
<td>Varies</td>
<td>Programmable LCD buttons</td>
</tr>
<tr>
<td>6</td>
<td>—</td>
<td>Status and alarm indicators</td>
</tr>
<tr>
<td>7</td>
<td>SHIFT</td>
<td>Shift key;</td>
</tr>
<tr>
<td>8</td>
<td>PG UP PARM</td>
<td>Page up key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter key</td>
</tr>
<tr>
<td>9</td>
<td>PG DN LOCK</td>
<td>Page down key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lock key</td>
</tr>
<tr>
<td>10</td>
<td>CLEAR HOME</td>
<td>Clear key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Home key</td>
</tr>
<tr>
<td>11</td>
<td>—</td>
<td>USB port</td>
</tr>
<tr>
<td>12*</td>
<td>—</td>
<td>Additional operation keys</td>
</tr>
</tbody>
</table>

* Not available on RCP-16LCD or RCP-32LCD panels.
Table 4: LCD Button Panels with OLED - Front Panel Control Descriptions:

<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BRK, FOL</td>
<td>Breakaway key, Follow key</td>
</tr>
<tr>
<td>2</td>
<td>DEST, MENU</td>
<td>Destination key, Menu key</td>
</tr>
<tr>
<td>3</td>
<td>SRC, PRST</td>
<td>Sources key, Preset key</td>
</tr>
<tr>
<td>4</td>
<td>TAKE</td>
<td>Take key;</td>
</tr>
<tr>
<td>5</td>
<td>Varies</td>
<td>Programmable LCD buttons</td>
</tr>
<tr>
<td>6</td>
<td>—</td>
<td>Status and alarm indicators</td>
</tr>
<tr>
<td>7</td>
<td>SHIFT</td>
<td>Shift key;</td>
</tr>
<tr>
<td>8</td>
<td>PG UP, PARM</td>
<td>Page up key, Parameter key</td>
</tr>
<tr>
<td>9</td>
<td>PG DN, LOCK</td>
<td>Page down key, Lock key</td>
</tr>
<tr>
<td>10</td>
<td>CLEAR, HOME</td>
<td>Clear key, Home key</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>USB port</td>
</tr>
</tbody>
</table>
### Key Label Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Varies</td>
<td>OLED display</td>
</tr>
<tr>
<td>13*</td>
<td></td>
<td>Additional operation keys</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>Scroll knob</td>
</tr>
</tbody>
</table>

* Not available on RCP-24LCD-OLED panels.

### Safety Standards and Instructions

See the Safety Standards for Magellan Programmable Control Panels for a list of important safety instructions.

Carefully observe all safety alert symbols for dangers, warnings, and cautions. They alert installers and operators of possible dangers or important information contained in this document.

Keep in mind, though, that warnings alone do not eliminate hazards, nor are they a substitute for safe operating techniques and proper accident prevention measures.

### Magellan Router Control Panel Service and Support

See the Unpacking/Shipping Information for detailed information about service and support for your Magellan Router Control Panel.
Installation

Before your Magellan Router Control Panel can operate as part of your routing system, you must unpack, install, and configure components. This section covers topics specific to physical installation.

Configuration information is outlined in the Software Configuration (on page 42) section.

**CAUTION**
We recommend that you test your system before its final installation. Make sure you verify configuration, cabling, and proper system operation.

Unpacking Panels

The Magellan Router Control Panel package includes one Magellan Router Control Panel

**Note:** If your equipment was damaged during transit, see Returning a Product to determine what you must do to return the equipment.

This product was carefully inspected, tested, and calibrated before shipment to ensure years of stable and trouble-free service.

1. Remove all packaging material from the product and its associated components before you install the unit.
2. Check equipment for any visible damage that may have occurred during transit.
3. Contact the carrier if any item is damaged.

Keep at least one set of original packaging, in the event that you need to return a product for servicing. If the original packaging is not available, you can purchase replacement packaging at a modest cost, or supply your own packaging as long as it meets the following criteria:

- Withstands the weight of the product
- Holds the product rigid within the packaging
- Leaves at least 2 in. (51 mm) of space between the product and the container

Siting Requirements

Make sure that the following siting requirements are appropriate for your installation:

- Adequate Rack Space (on page 33)
- Proper Temperature (on page 33)
- Electrical Requirements (on page 33)
- Load Limitations (on page 33)
- Maximum Power Dissipation (on page 33)
- Protective Ground (on page 33)
Adequate Rack Space

Each Magellan Router Control Panel is designed for mounting into a standard width 19-in. (48.3-cm) rack. Frames are secured to the rack with standard front-mounting ears built into the chassis. Make sure to provide adequate space behind the mounting ears, and appropriate clearance for the connecting cables at the rear of the frame.

Proper Temperature

An ambient temperature should be maintained between 41°F (5°C) and 104°F (40°C) at a relative humidity of 10%-90% (non-condensing). No special cooling arrangements are necessary, but make sure to prevent excessive ambient heat rise in closed, unventilated equipment racks.

Electrical Requirements

Load Limitations

Each Magellan Router Control Panel requires one external power supply (PSU). The power consumption is 25 W maximum. A Magellan Router Control Panel operates with a single power supply.

Maximum Power Dissipation

These ratings refer to the total module power consumption (excluding that of the power supply) allowable within the Magellan Router Control Panel. The limits are based on the ability of the unit to dissipate heat over a temperature range of 41° to 104°F (5° to 40°C).

Protective Ground

Since the power supply does not present a shock hazard, the Magellan Router Control Panel does not have a protective safety earth ground.

Back Panel Connections

![Figure 17: Magellan Router Control Panel Back Panel Connections](image)
Magellan Router Control Panel Connection Descriptions

<table>
<thead>
<tr>
<th>Field Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>One pair of BNC X-Y ports (single looping X-Y)</td>
</tr>
<tr>
<td>2</td>
<td>9-pin RS-232 service port</td>
</tr>
<tr>
<td>3</td>
<td>RJ45 Ethernet connection (see page 26 for pin assignments)</td>
</tr>
<tr>
<td>4</td>
<td>Power connector</td>
</tr>
</tbody>
</table>

**X-Y Ports**

The X-Y control bus is a high speed serial interface by which routers and control panels are interconnected via standard 75Ω video coax cable. The ends of the X-Y bus must be terminated using standard 75Ω video terminators.

The Magellan Router Control Panel features one looped-through port (two BNC connectors). If either of the BNCs is used, the other associated X-Y port connection must be terminated with a 75Ω BNC terminator or connected to another device’s X-Y port. You do not need to terminate either of the BNCs if neither is used.

**Service (Serial) Connection**

The Serial connection is used only for service access. It does not provide typical protocol behavior as existed in previous control panels.

**Ethernet Connection**

The Magellan Router Control Panel implements an Ethernet connection for device configuration, field upgrades, implementation of the terminal/pass-through protocols; and connection to internal and/or third party control systems and routers.

The Ethernet connection uses 10/100 Base-T wiring. The pin assignments for the Ethernet connection are listed in Pin Assignments to Ethernet Connections.

**Table 5: Pin Assignments to Ethernet Connections**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transmit Data +</td>
<td>5</td>
<td>Not used</td>
</tr>
<tr>
<td>2</td>
<td>Transmit Data -</td>
<td>6</td>
<td>Receive Data -</td>
</tr>
<tr>
<td>3</td>
<td>Receive Data +</td>
<td>7</td>
<td>Not used</td>
</tr>
<tr>
<td>4</td>
<td>Not used</td>
<td>8</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Mounting Panels

Note: When power is applied to the Magellan Router Control Panel, it starts up automatically.

Tools You Will Need

The following tools and equipment are recommended for installation of the Magellan Router Control Panel:

- One standard 19-in. (48-cm) rack
- One medium Phillips screwdriver
- Four 10/32 Phillips-head rack mount screws
- For programming your Magellan Router Control Panel, a computer running a Microsoft® Silverlight® compatible web browser
- Navigator v.4.6.1 or higher
- Magellan CCS Navigator User Guide

Mounting Requirements

The Magellan Router Control Panel frame can be mounted in a standard width 19-in. (48.3 cm) rack using four 10/32 Phillips-head mounting screws. The back of the frame does not need to be supported. The frame can be mounted in either the front or the rear of the rack, thereby providing more efficient use of your equipment housing space. The rack ears can be attached to the frame in either direction, thereby allowing you flexible mounting options.

- The 1RU panel requires one unit of rack space, that is, 1¾ in. (44 mm) of standard rack space. The depth from the mounting surface is 2½ in. (64 mm).
- The 2RU panel requires two units of rack space, that is, 3½ in. (88 mm) of standard rack space. The depth from the mounting surface is 2½ in. (64 mm).

Panel Installation Procedure

Magellan Router Control Panels are usually installed as part of a larger routing control system.

- The maximum allowable distance for each segment of the X-Y coaxial cable run is 2,000 ft (609 m).
- There is no limit to the number of control devices added to the X-Y control bus.

To install the Magellan Router Control Panel in a control system

1. Mount the control panel in an rack that provides power and cooling facilities. The Magellan Router Control Panel is designed for mounting in a standard equipment rack.
2. Align the control panel so that all four screw holes in the mounting ears match up with those in the rack.
3. Secure the control panel to the rack with the rack screws and washers.

4. Connect the control panel to the appropriate port (Ethernet, X-Y) on the router frame’s rear panel.

   **Note:** For most installations, the control panel should be connected via the Ethernet port. To use the software configuration tools, an Ethernet connection is necessary. Only use the X-Y port to connect the control panel to a legacy device.

5. If the control panel is used in a multiple frame system, connect the additional frames using the appropriate scheme.

6. If the control panel is at the end of the X-Y bus, terminate the other X-Y connector with a coaxial 75Ω termination.

7. Plug a power cord into the DC power supply connector.

8. Connect the power cord to a power source.

---

**Ethernet Setup**

**Note:** The Ethernet default settings for Magellan Router Control Panel are as follows:
- IP: 192.168.100.250
- Subnet Mask: 255.255.255.0
- Gateway: 192.168.100.1

1. Prior to performing the Magellan Router Control Panel configuration, you must determine the following information:
   - The TCP/IP address for the panel
   - The routing system to connect to
   - The name and ID to assign to the panel

2. Obtain TCP/IP addresses for the installed panel. These addresses are a static IP address, a subnet mask, and an optional gateway IP.

   How you obtain TCP/IP addresses depends on the type of panel you have (pushbutton only/LCD only/pushbutton with OLED/LCD with OLED). Use one of the following processes to obtain the addresses.
   - For all panel types, attach the Magellan panel to a PC via a crossover cable, and then enter the default IP address into the Address field of your Internet browser. Note the addresses in the spaces provided below.
   - For panels with LCD buttons or OLED displays only, press the **SHIFT** button and then the **MENU** button on the front panel.

   The menu selection buttons appear across the front of the front panel.

   Press the **SETUP** button, and then note the addresses in the spaces provided below.

<table>
<thead>
<tr>
<th>Static IP address</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet mask</td>
<td></td>
</tr>
<tr>
<td>Gateway IP address</td>
<td></td>
</tr>
</tbody>
</table>

   - For all panel types, run a partial discovery in Navigator (see [CCS Navigator User Manual, Volume 1: Device Control](#)), and then note the addresses in the spaces provided above.
Enable scanning of MAC address and click Start to start the discovery process in Navigator. Once the panel is discovered, a popup window displays the details. You may need to change the IP address of the panel to the specified range for your network - you can change the IP address in the New section of the popup window.

### Supported Browsers

You can use Internet Explorer or Mozilla Firefox on Windows.

#### Setting Up Microsoft Internet Explorer

Web browsers such as Mozilla® Firefox® not require special setup procedures. If you use Microsoft Internet Explorer as your web browser, set the Internet options as follows:

1. Open Internet Explorer.
2. From the menu bar, select **Tools**, and then select **Internet Options**. The **Internet Options** window opens. If necessary, select the **General** tab.
3. Click the **Settings...** button in the **Browsing History** box (**Temporary Internet files** box in earlier versions of Internet Explorer). The Settings window opens.

![Figure 18: Settings Dialog Box](image)

**Note:** Earlier versions of the Internet Explorer Settings box may look different than the image shown in Settings Dialog Box.

4. Under **Check for Newer Versions of Stored Pages**, click the radio button for the **Every Time I Visit the Webpage** selection. (In earlier versions the radio button text may vary slightly.)
5. Click **OK** to accept the change and return to the Internet Options dialog box.
6. Click **OK** again to return to Internet Explorer.

---

**Starting Panel Configuration**

Actual panel configuration is performed via a web-based software configuration tool that is resident on the physical panel (see Software Configuration on page 42). In order to configure the panel, however, it must be associated with a routing server or router.

**Note:** Before you can start panel configuration, you need the TCP/IP address for that panel. See Ethernet Setup (on page 36) for information on acquiring TCP/IP addresses.

1. Open your computer’s web browser. If Internet Explorer is your web browser, check your Internet option setting as described in Setting Up Microsoft Internet Explorer (on page 37).
2. Enter the panel’s IP address into the **Address** field of the browser.

   The **Login to Magellan Panel** dialog box opens.

   **Note:** At this point you may be prompted to install Microsoft® Silverlight®. To install Silverlight follow the link provided or go to [http://www.microsoft.com](http://www.microsoft.com) and search for Silverlight.

3. Enter the login and password set up for your location. (The default login is **admin**; the default password is **harris**.) See Login Credentials (on page 38).

   The Panel Summary page opens. (See Summary Page (on page 42) for a detailed description).

**Note:** If you opt to remember login credentials (check remember username and password the first time you log in), the login dialog is not displayed on subsequent logins.

**Login Credentials**

The default login credentials are:

- **Username**: admin
- **Password**: harris

From version 3.3 onwards, the manufacturer default login credentials have been changed to:

- **Username**: Admin
- **Password**: <blank>

These new credentials only apply to new units purchased running 3.3 or higher by default, OR if you upgrade to version 3.3 or higher using UBoot.

Existing users will still have the old default login credentials (admin/harris) or their custom login credentials, even after upgrading to version 3.3, if they upgrade from the Web UI.
Adding Panels to a Database

Note: The information in this section is based on the assumption that you have a working knowledge of Navigator and have used its other capabilities. If not, please refer to the CCS Navigator User Guide and familiarize yourself with its functions before you continue the Add process.

Magellan Router Control Panels can be added to a routing system via Navigator. In order to monitor the panel, however, it must be associated with a routing system created in Navigator. Actual panel configuration is performed via a web-based software configuration tool that is resident on the physical panel.

Using a Navigator Database

The information below provides you the different methods by which you can add panels to a Navigator database. It does not go into detail about any of these methods or about other aspects of editing a panel. For more information on editing panels in Navigator, please refer to Volume 6 of the CCS Navigator User Guide. You can download a copy of the most current edition from our website.

To add a Magellan Router Control Panel via one of the options described in Adding Panels by Polling (on page 39), you must use Navigator v.4.6.1 or higher.

Linking to the Database

1. Make sure that Navigator v.4.6.1 is installed on your PC.
2. Connect power to the control panel power connector, and then power up the panel.
3. Start up Navigator on the PC. The main window opens.

Adding Panels by Polling

The Poll option is used to query the control system for any programmable devices that may be present in the system. Polling obtains information about the current configuration of each physical device, and compares it to the information found in the database to determine if the database information matches the actual configuration.

Adding Panels by Discovering

The Discovery option is a quick way to search the control system for any programmable devices that may be present in the system. Unlike the Polling option, the Discovery option does not obtain information about current configurations; however, it allows you to select discovered devices to add to the device list. You can then use the application software’s editing capabilities to configure the device.

Note: When using the Poll or Discover option, ensure that each panel has been assigned a unique device ID and IP address. This can avoid database or panel configuration errors caused by the device’s ID or IP conflict.
Adding Panels using the Create Command

An alternative to polling or discovering the system for devices is to create the device definitions via the Create function. (Select Create → Hardware Routing Panel and the type of panel; then, configure its ID and IP via Navigator properties.) The new device is assigned the next available ID, and the default source, destination, and function key mappings.

Offline Configuration Editor

Use offline configuration when

- You have a panel that is not installed in your routing setup
- You want to set up a configuration that may be imported into a panel at another time
- You do not have access to a panel

Installing the Offline Configuration Editor

1. Start a configuration session as outlined in Starting Panel Configuration (on page 38).
   The Panel Summary page opens. (See Summary Page (on page 42) for a detailed description.)
2. Select the Tools page. (See Tools Page (on page 57) for a detailed description.)
3. Click the Install Offline Configuration button.
   Click Install in the dialog box that is displayed.

![Security Warning](image)

Figure 19: Install Offline Configuration Dialog Box

4. Select a start menu shortcut and/or a desktop shortcut as preferred, and then click OK.
The offline configuration tool creates an icon named **Magellan RCP Config** for future offline configuration use.

5. The Magellan Panel Offline Options dialog box is displayed (See Using the Offline Configuration Editor (on page 202) for more information).
Software Configuration

Note: Before the control panel can operate as part of your routing system, you must unpack, install, and configure components. For information about downloading panels in Navigator, see the CCS Navigator User Manual, Volume 6: Routing Components.

Magellan Router Control Panels can be configured using the software configuration tool supplied with the panel.

Panels are configured via a web browser to a connected panel over TCP/IP. Once configured, the Magellan Router Control Panel retains its programming even if powered down. Some configuration functions for the -LCD and -OLED panels may also be performed directly at the front panel. The web configuration is optimized for use with screen resolutions of 1280×1024 pixels; however, larger resolutions will allow better visibility of panels with more buttons.

Configuration procedures can be performed offline (for later import) or online (for a panel that is already installed in a routing setup). Except as noted, configuration procedures are the same when performed offline or online.

Magellan Router Control Panels can be configured using the Web UI software configuration tool.

Summary Page

Note: This page is unavailable when creating panels offline.

Figure 20: Summary Page

The Summary page displays information and settings under the following categories:

- Physical Settings (on page 43)
- Panel Versions and Licenses (on page 43)
- Panel Options (on page 44)
- Current Configuration (on page 45)
- Alarm Definitions (on page 45)
Note: To the right of each text box is an information icon. Hover the mouse cursor above the information icon to display more details about the selection. Information Icon Details shows an example of the contents of the information icon for the Licensed Options field.

Physical Settings

Information on the Panel Type (for example, RCP-64 LCD), Panel Name, Panel ID, IP Address, Netmask, Gateway, MAC address, System Cache, and Flash used is displayed here.

To change the information displayed here, click the Edit button, make edits, and click Save. See Changing Panel Physical Settings (on page 175).

Use the Identify Panel button if you have two or more similar panels in your routing system and need to physically identify them. See Identifying a Panel (on page 193).

Panel Versions and Licenses

Information on the following is displayed here:

- **Software Version:** The version of software running on the panel. You can upgrade the panel firmware by following the instructions in the Upgrading Panel Firmware (on page 201) section.
- **Hardware Version:** Read only panel hardware version
- **Serial Number:** The serial number of the panel, read only.
- **Licensed Options:** The options currently licensed on the panel.
- **License Key:** The License key applied to the Panel. You can update a license key by following the instructions in the Setting the Panel License ID (on page 197) section. If you update your license, ensure you close and restart the browser.

Basic License

A basic Magellan Router Control Panel license enables control of Router devices. With a basic Magellan Router Control Panel license, when you create a new configuration, you see a single enabled tab Router, and grayed out tabs for Multiviewer and Processing. The Licensed Options field in the Panel Versions And Licenses section will show as blank in case of a basic license.

Processing/Multiviewer License

With a PROC+MV license, when you create a new configuration, you see three tabs - Router, Processing, Multiviewer. Contact Customer Service to request a PROC+MV license. The Processing and Multiviewer (PROC+MV) license add-on enables control of the following:
Panel Options

Information displayed here includes the following:

- **Screensaver Saver Enable**: Select Yes/No to enable/disable the Screensaver. See Setting Screensaver Options (on page 197)
- **Screensaver Saver Black Out**: Select Yes/No to enable/disable the Screensaver Blackout, which acts on an active screensaver and blacks out the OLED on activation. You can press a button or the scroll knob to activate the panel.
- **Wait Time (minutes)**: This is the time that the panel waits in case it does not receive a response from the primary configured server. Several connection attempts are made (at intervals defined by the cycle time setting) in the total wait. The default wait time is 5 minutes.
- **Cycle Time (seconds)**: This refers to the interval between successive reconnect attempts to the primary configured server. The default cycle time is 30 seconds.
- **Button Click Action**: Actions on the panel are executed either on the press of a button, or on release of a button. The default is to perform the action on release of a button. The following options let you control this setting:
  - **Button Release**: Actions will be executed on releasing a button
  - **Button Press**: Actions will be executed on pressing a button

  Note: If **Button Click Action** is set to **Button Release** and the source button is held for over 1.5 seconds, the switching command will not be sent, and this action will instead bring up the shortcut menu (if **Allow Hold Shortcut Menu** in the Options is enabled) or do nothing (if it is disabled).

  It is recommended to set **Button Click Action** to **Button Release**, it is recommended that you not hold down the button for longer than 1.5 seconds.

- **Enable Ganging**: Enable or disable linking of this panel with another panel (Ganging).
- **Save New Config to**: Defines where new configurations should be saved. Choose from local storage on the Panel or USB. See USB Notes (on page 45).
- **Auto Sync DB**: When you activate a Router configuration, the **Auto Sync DB** option (if set to **Yes**) synchronizes the panel with the configured Router. When set to **No**, the panel does not automatically synchronize the database with the configured Router - you always have the option to synchronize manually and on demand by clicking the **Sync Database** button.
**USB Notes**

- You can choose to save new configurations to USB from the Panel Options section in the Configurations tab. If you choose this option, and a USB is not plugged in, an error will be displayed on attempting to save new configurations.
- The USB status/availability is displayed in the Tools tab. If it shows as disabled, click the Toggle USB Port Function to enable it.
- Kingston and Sandisk are recommended USB brands.
- When doing a UBoot upgrade via USB, Sandisk is recommended.

**Current Configuration**

Information on the currently Active Configuration, the current Server IP, and the Connection Status is displayed here. You can click the Toggle Server button to switch between the Primary and Secondary servers configured.

An option to define fallback configurations for Ganged panels is also displayed. You can choose to fallback on the default configuration or you can choose any other configuration in the drop down list.

**Note:** You can set the Primary and Secondary server IP information in Configurations > Options > Communication Options.

**Alarm Definitions**

The Summary Page also includes Alarm definitions. You can set the following Alarm types here:

- **Secondary Server IP Active**: Triggered if the Secondary Server is active
- **Active Configuration Modified**: Triggered if the active configuration is modified
- **Active Configuration from USB**: Triggered if the current configuration is running off USB

These alarms are also exposed via the CCSP protocol to devices and applications that use CCSP such as Magellan CCS Navigator. See Magellan Panel Discovery via Magellan CCS Navigator (see "Magellan Router Control Panel Discovery via Magellan™ CCS Navigator" on page 72).
Operation Modes

Magellan Router Control Panel 3.0 and higher offers two operation modes. The default mode that a user sees on logging in depends on the type of logged in user.

Edit Mode

Edit mode enables addition/deletion/modification of configuration and other settings. The Edit Mode is displayed by default to users that log in as Administrator; users can switch to the Control Mode if required. Note that the Control Mode can be switched to, provided the panel is not being controlled by another Web UI in Control Mode.

Control Mode

Control Mode is a software representation of the hardware panel, and it enables users to control the hardware panel from the Web UI. Control Mode displays (in the Web UI) exactly the same information as the hardware panel; the Control Mode UI communicates with the physical panel, and emulates its interface accordingly. This Mode enables users to control Router/Processing/Multiviewer configurations from the Web UI, and perform source/destination switch-overs, lock/protect destinations, execute Salvos, and so on.

The Control Mode is displayed by default to users that log in as Operator. Operators cannot opt to switch to Edit Mode. Administrators can enter Control Mode by clicking the Enter Control Mode button at the top of the Summary page.
Once a user takes control of a panel (enters Control Mode), if another Operator or Administrator logs into the panel, they override the previous user.

For example, if User 1 (Operator) is connected to the Software Control Panel, and if User 2 (Operator) attempts to connect to the same Software Panel, User 2 will get a message indicating that the Software panel is currently being controlled by another IP Address, along with an option to enter Control Mode.

Once in Control Mode, the Panel is automatically locked.

The "Clear" button on the hardware panel is the only functional button that works on a hardware panel that is in Control Mode. Use this button to exit Control Mode on the panel.

On the Web UI, click the Exit Control Mode button, click Log out button, refresh the Web page, or close the browser to exit control mode.

On exiting Control Mode, both administrators and operators receive a popup message confirming mode exit. Click the Enter Control Mode button to re-enter the mode when required.
Note: In case of LCD/LCD-OLED panels (for example, a 48 LCD-OLED panel), in Control Mode, when you enter Breakaway mode (by pressing BRK), four buttons are auto assigned - UP, STORE, SEL, and ERASE. When creating a configuration, if you assign an Undo button to any of these positions, it will not work.

Control Mode Display

The following are some examples of how the Control Mode emulates the hardware panel.

- In case of a panel with 1 OLED and 1 knob, the Control Mode UI is displayed as follows:
• In case of a panel with 2 OLEDs and 2 knobs, the Control Mode UI is displayed as follows:

![Control Mode UI with 2 OLEDs and 2 knobs](image1)

• In case of a panel with no OLEDs or knob, the Control Mode UI is displayed as follows:

![Control Mode UI with no OLEDs or knob](image2)

• In case of a 48 or 96 pushbutton panel, the Control Mode UI is displayed as follows:

![Control Mode UI with 48 or 96 pushbuttons](image3)

Note: Because 48PB and 96PB panels have 24 buttons per row, for convenience, the Web UI splits the display. The **Split the view** button breaks up the display, and the **Full View** button displays the original.
Control Mode Notes

• **Supported Configurations**: Router/Processing/Multiviewer configurations are supported in this mode. Control Mode is only supported if the active configuration is not a gang configuration.

• **OLED Display**: The software panel has a display area to the left of the function buttons area to show the contents of the OLED. The Web UI displays the exact same information (button, knob, OLED as the hardware panel).

• **Multiple Select with Shift**: Use the Shift button to select multiple destinations just as with the hardware panel; you can also multiple select Salvos and Crosspoints.

• **Menu function button**: You can access Menu mode via the Software Control Panel (note that Config and Setup menus are not accessible).

• **Configuration Home**: Once you enter Control Mode, both the hardware panel and Web UI display the configuration home (even though it’s disabled from the panel). Once you exit Control mode from the Web UI, the hardware panel displays the Configuration home.

Example of how to use Control Mode

1. Create a new configuration from the Web UI
2. Add a **Router Configuration** in the **Router** tab by clicking the **Add Router Configuration to this Panel Configuration**. Follow the wizard

3. Ensure you provide the correct **Router IP Address** in the **Panel Options** section of the wizard

4. Define the buttons in your configuration

5. **Save** and **Activate** the configuration on the Panel

6. Enter **Control Mode** by clicking the button at the top

7. Perform some functions - for example:
   - Select a Destination and switch a Source to it.
   - Lock a Destination; hold down the Destination to check the lock owner and then unlock it.

8. Click the Exit Control Mode at the top to exit Control Mode.
Sticky Mode

Sticky Mode emulates (in the Control Mode UI) functionality that occurs on pressing or release of a button on the panel.

If Button Click Action is set to Button Press (in the Summary page, Panel Options), actions are executed on pressing of a button (instead of on releasing).

Figure 22: Activating Sticky Mode

Figure 23: Deactivating Sticky Mode

Sticky Mode is activated by right clicking the Shift button (in the Function Buttons) in the Control Mode UI and selecting Sticky Mode. Similarly, once activated it can be deactivated by deselecting.

When to use Sticky Mode

When Button Click Action is set to Button Release, if you hold down (long hold) a destination button on the panel, the panel will go to OPTIONS mode:

When Button Click Action is set to Button Press, in order to enter OPTIONS mode, you need to hold down (long hold) the SHIFT button on the panel, and then press the destination button.

In the soft Control Mode, since you cannot press 2 buttons at same time, Sticky Mode helps emulate this behavior - when you enable Sticky Mode for the SHIFT key, you can click the SHIFT button to emulate holding down (long hold) the SHIFT button on the panel.

Emulating the Knob

The knob (and its functionality) on the physical panel can also be emulated in the Web UI, via the Control Mode. You can press the knob or turn the knob.

You can turn the knob to scroll through options or click the knob.
To turn the knob, click the small hollow circle (within the larger circle), hold down the left mouse button and drag the mouse. Once you click in the small hole, a rotate direction arrow is displayed to the top of the larger circle. By dragging the mouse, you can, for instance, scroll through sources, destinations, or levels. Click in the area outside the small hollow circle to emulate a knob press.

**Emulating the Alarm LEDs**

The Control Mode also emulates the Alarm LEDs on the panel, displaying status corresponding to Connected, Enabled, Alarm 1, and Alarm 2 LEDs.
Configurations Page

The Configurations page is a tabbed dialog that includes all functions necessary for configuring a panel.

Table 6: Configuration Page Selections and Functions

<table>
<thead>
<tr>
<th>Key</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Page Tabs</td>
<td>Tabs for Summary, Configurations, Support, and Tools Pages.</td>
</tr>
<tr>
<td>2</td>
<td>Panel Configurations</td>
<td>Navigation panel listing all created configurations</td>
</tr>
<tr>
<td>3</td>
<td>Current Configuration</td>
<td>Navigation trees for configuration defined on panel buttons</td>
</tr>
<tr>
<td>4</td>
<td>Ganged Panels</td>
<td>Expandable only in case of a Ganged Configuration. Lists the Master Panels and defined slaves.</td>
</tr>
<tr>
<td>5</td>
<td>Configuration function buttons</td>
<td>Enables creation, duplication, or deletion of configurations. Creating a New Panel Configuration (on page 62) Deleting a Panel Configuration (on page 68) Duplicating an Existing Panel Configuration (on page 68)</td>
</tr>
<tr>
<td>6</td>
<td>Configuration Activation</td>
<td>Button to make a selected configuration active.</td>
</tr>
<tr>
<td>7</td>
<td>Configuration Contents</td>
<td>Icons to indicate the configuration sub types contained (one or all of Routers, Multiviewers, Processing)</td>
</tr>
<tr>
<td>8</td>
<td>Configuration Functions</td>
<td>Buttons to save, load, import, export configurations See Icon Toolbar Selections and Functions for details</td>
</tr>
<tr>
<td>9</td>
<td>Configuration Tabs</td>
<td>Tabs for Router, Processing, and Multiviewer configuration.</td>
</tr>
<tr>
<td>10</td>
<td>Sub Tabs</td>
<td>Sub tabs for each main Configuration tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Router</strong>: Panel Buttons, Access Lists, Local Aliases, TRAX, Options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Processing</strong>: Panel Buttons, Favorites, Options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Multiviewer</strong>: Panel Buttons, Options</td>
</tr>
</tbody>
</table>
### Table 7: Icon Toolbar Selections and Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Save.png" alt="Save" /></td>
<td>Saves the selected panel configuration</td>
</tr>
<tr>
<td>![Save All](Save All.png)</td>
<td>Saves all listed panel configurations (Not available when editing configurations offline)</td>
</tr>
<tr>
<td><img src="Reload.png" alt="Reload" /></td>
<td>Reloads the selected configuration (Not available when editing configurations offline)</td>
</tr>
<tr>
<td><img src="Export.png" alt="Export" /></td>
<td>Exports selected panel configuration to a file in XML format (Not available when editing configurations offline)</td>
</tr>
<tr>
<td>![Export All](Export All.png)</td>
<td>Exports all listed panel configurations to files in XML format (Not available when editing configurations offline)</td>
</tr>
<tr>
<td><img src="Import.png" alt="Import" /></td>
<td>Imports a selected panel configuration from a selected XML file (Not available when editing configurations offline)</td>
</tr>
<tr>
<td>![Generate Button Labels](Generate Button Labels.png)</td>
<td>Creates a PDF or Microsoft Word file of the panel button actual names; this file can be sent to a printer to print out button labels</td>
</tr>
<tr>
<td><img src="Activate.png" alt="Activate" /></td>
<td>Makes selected configuration the currently active one (Not available when editing configurations offline)</td>
</tr>
<tr>
<td>![Edit Other Panel...](Edit Other Panel.png)</td>
<td>Allows selection of a different configuration for editing offline (Appears when editing offline only)</td>
</tr>
</tbody>
</table>
Support Page

**Note:** This page is unavailable when creating panels offline.

![Support Page](image)

**Figure 24: Support Page**

The Support page displays tools and links for the unlikely event that you must contact Imagine Communications Customer Service. You can do the following from this page:

**Table 8: Support Page Options**

<table>
<thead>
<tr>
<th>Key</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>View Panel Logs</td>
<td>Click to view a log of the panel in txt format</td>
</tr>
<tr>
<td>2.</td>
<td>Clear Panel Logs</td>
<td>Click to clear all logs.</td>
</tr>
<tr>
<td>3.</td>
<td>Reset Panel Communications</td>
<td>See Restoring Panel Defaults (on page 196)</td>
</tr>
<tr>
<td>4.</td>
<td>Reset Panel Configurations</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Revert to Previous Firmware</td>
<td>Click to revert to the last known firmware version</td>
</tr>
<tr>
<td>7.</td>
<td>Reboot Panel</td>
<td>See Restarting a Panel (on page 196)</td>
</tr>
<tr>
<td>8.</td>
<td>Helpful Links</td>
<td>The following links are listed:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Accessing the Imagine Communications Service Web Portal (on page 163)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Accessing the Imagine Communication Website (see &quot;Accessing the Imagine Communications Website&quot; on page 163)</td>
</tr>
</tbody>
</table>
Tools Page

**Note:** This page is unavailable when creating panels offline.

<table>
<thead>
<tr>
<th>Key</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toggle USB Port</td>
<td>See Enabling or Disabling USB Port Functions (on page 189)</td>
</tr>
<tr>
<td>2</td>
<td>Copy Panel Configuration</td>
<td>See Copying a Panel Configuration to Other Control Panels (on page 189)</td>
</tr>
</tbody>
</table>

**Figure 25: Tools Page**

The **Tools** page contains special functions that allows a user to do advanced administration for the panel. You can do the following from this page:

**Table 9: Tools Page Options**

<table>
<thead>
<tr>
<th>Key</th>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toggle USB Port</td>
<td>See Enabling or Disabling USB Port Functions (on page 189)</td>
</tr>
<tr>
<td>2</td>
<td>Copy Panel Configuration</td>
<td>See Copying a Panel Configuration to Other Control Panels (on page 189)</td>
</tr>
</tbody>
</table>
Users

The Magellan Router Control Panel software interface provides two default users: Administrator and Operator. Users can be modified by going to the Tools tab and then clicking the User Access button. This displays a dialog box with the names of both users in the column on the left. Click on a username to have its details populated on the right. Also see Enabling User Access (on page 189).

Administrator

The user name of the Administrator user can be customized. However, the type will always show as Administrator. To change the Administrator user name, select the currently defined Administrator user in the column on the right, enter a new user name in the text box, enter a new password and confirm password. Click OK to save.

The Edit Mode (on page 46) is displayed by default to users that log in as Administrator.
Operator

The user name of the Operator user can be customized. However, the type will always show as Operator. To change the Operator user name, select the currently defined Operator user in the column on the right, enter a new user name in the text box, enter a new password and confirm password. Click OK to save.

The Control Mode (on page 46) is displayed by default to users that log in as Operator.

Offline Configuration

Use offline configuration when

- You have a panel that is not installed in your routing setup
- You want to set up a configuration for import into a Magellan Router Control Panel later
- You do not have access to a Magellan Router Control Panel

To start a configuration session:

1. Click on the Magellan RCP Config icon installed in your startup menu or on your desktop. (This icon was created when you first installed the Offline Configuration Editor. See Using the Offline Configuration Editor (on page 202) for more information).

2. The Configurations Page (on page 54) opens. Make one of the following choices:
   i. To create a new panel configuration:
      - Click the New... button, and then see Creating a New Panel Configuration (on page 62) for instructions on how to create a new panel configuration.
   i. To duplicate an existing panel configuration:
      - Click the Duplicate... button, and then see Duplicating an Existing Panel Configuration (on page 68) for the instructions on how to duplicate an existing panel configuration.
On-Line Configuration

Use On-Line configuration when you have a panel that is accessible via Ethernet to your current computer.

**Note:** Before you can configure a panel on-line, you need the TCP/IP address for that panel. See Ethernet Setup (on page 36) for information on acquiring TCP/IP addresses.

1. To start a configuration session, follow the steps outlined in Starting Panel Configuration (on page 38).
   The Panel Summary page opens. (See Summary Page (on page 42) for a detailed description.)
2. Select the Configurations page. (See Configurations Page (on page 54) for a detailed description.)
3. Make one of the following choices:
   - **To create a new panel configuration**
     - Click the **New...** button, and then see Creating a New Panel Configuration (on page 62) for the instructions on how to create a new panel configuration.
   - **To duplicate an existing panel configuration**
     - Click the **Duplicate...** button, and then see Duplicating an Existing Panel Configuration (on page 68) for the instructions on how to duplicate an existing panel configuration.
   - **To delete an existing panel configuration**
     - Click the **Delete...** button, and then see Deleting a Panel Configuration (on page 68) for the instructions on how to delete an existing panel configuration.
   - **To edit an existing panel configuration**
     - Click one of the panel configurations listed on the left side of the Configurations page. Common Configuration Tasks contains topics related to panel editing.
Panel Configuration

Devices You Can Control

You can configure the following device types for control through Magellan Router Control Panel.

Table 10: Devices you can configure for control

| Processing Devices | 1. Follow the steps in Creating a New Panel Configuration (on page 62)  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Selenio 6800+™ frames and modules</td>
<td>2. Go to the Processing tab in your configuration</td>
</tr>
<tr>
<td>NEO Frames and modules</td>
<td>3. Follow the steps in Processing Configuration Overview</td>
</tr>
<tr>
<td>Selenio X-50/75/85 frames/modules</td>
<td></td>
</tr>
<tr>
<td>Selenio™ MCP frames/modules</td>
<td></td>
</tr>
<tr>
<td>Platinum™ Routers</td>
<td></td>
</tr>
<tr>
<td>Platinum™ IP3 Routers</td>
<td></td>
</tr>
<tr>
<td>Multiviewers</td>
<td></td>
</tr>
<tr>
<td>1. Follow the steps in Creating a New Panel Configuration (on page 62)</td>
<td></td>
</tr>
<tr>
<td>2. Go to the Processing tab in your configuration</td>
<td></td>
</tr>
<tr>
<td>Follow the steps in Processing Configuration Overview</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> From Magellan 2.5 onwards, Multiviewer devices can be discovered and mapped in Processing configurations. The standalone Multiviewer tab has been maintained for backward compatibility.</td>
<td></td>
</tr>
</tbody>
</table>

| Multiviewer Devices | 1. Follow the steps in Creating a New Panel Configuration (on page 62)  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Platinum IP</td>
<td>2. Go to the Processing tab in your configuration</td>
</tr>
<tr>
<td>Platinum SX Hybrid</td>
<td></td>
</tr>
<tr>
<td>Platinum SX Pro</td>
<td></td>
</tr>
<tr>
<td>Selenio 6800+ Multiviewer/Platinum Predator II</td>
<td></td>
</tr>
</tbody>
</table>

| Router Devices |  |
Platinum/Platinum IP3 Routers
- Platinum Frame Synchronizer Modules and Platinum MADI
- Selenio MCP from within a router configuration

1. Follow the steps in Creating a New Panel Configuration (on page 62)
2. Go to the Router tab in your configuration
3. Follow the steps in Configuration Navigation (on page 63)

Specific instructions for Platinum MADI or Platinum Framesync modules. Configure through Navigator, then see:
- Platinum MADI (PT-MADI4X-OBG) in a Router Configuration (on page 104)
- Platinum MADI (PT-MADI4X-OBG) in a Router Configuration (on page 104)

Optionally control Selenio MCP Modules from within your Router configuration
- Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration (on page 103)

Other Magellan RCP Devices

You can also discover another Magellan panel via the current panel’s web UI. Follow the same process as a Processing device. See Discovery - Selenio 6800+, NEO, Selenio X50/75/85/100, Selenio MCP, Platinum, Platinum IP3, Multiviewers (on page 82)

Magellan Panels are also discoverable by applications such as CCS Navigator via CCSP. See Magellan Panel Discovery via Magellan CCS Navigator59 (see "Magellan Router Control Panel Discovery via Magellan™ CCS Navigator" on page 72)

Creating a New Panel Configuration

1. Access the Configurations Page (on page 54).
2. In the Configuration Navigation (on page 63) on the left, click New under Panel Configurations.
   - To create a General Configuration (on page 65), provide a Name and click OK.
   - To create a Panel Gang Configuration (on page 66), click Panel Gang and then click OK.

When using this option, the current Panel is displayed as Master (with a green M icon) in the Ganged Panels section. You can optionally right click the Master panel and add a Slave or Slave Trax panel by providing its IP Address. You can also do this later (see Types of Slave Panels (on page 67)).
Configuration Navigation

The left pane navigation is divided into 3 sections: Panel Configurations, Current Configuration, and Ganged panels. The Panel Configurations section displays a list of created configurations and tools to help create and manage configurations.

- Click New to create a new configuration
- Select a configuration and click Activate to make active.
- Select a configuration and click Delete to remove.
- Select a configuration and click Duplicate to make a copy.

Icons to the right of the configuration name indicate the subtypes (Router, Proc, Multiviewer) contained in a given configuration. See Configuration Icons.
The **Current Configuration** section is relevant in case of Processing configurations, where it displays a tree view of configuration defined on panel buttons.

- The **Ganged Panels** section is only displayed for a Panel Gang configuration. It displays the current panel (master) and any panels that have been slaved. You can right click in this section to add, delete, or change the IP for a slave panel.

### Table 11: Configuration Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![M]</td>
<td>Panel Gang Configuration and this Panel is a Master</td>
</tr>
<tr>
<td>![S]</td>
<td>Panel Gang Configuration and this Panel is a Slave panel which has been connected with the Master Web UI.</td>
</tr>
<tr>
<td>![S]</td>
<td>Slave panel as seen on the Slave Web UI.</td>
</tr>
<tr>
<td>![T]</td>
<td>Panel Gang Configuration and this Panel is a Trax Slave on the Slave Web UI.</td>
</tr>
<tr>
<td>![T]</td>
<td>Slave Panel has not connected with the Master Web UI.</td>
</tr>
<tr>
<td>![R]</td>
<td>Contains Router configuration</td>
</tr>
<tr>
<td>![P]</td>
<td>Contains Processing configuration</td>
</tr>
<tr>
<td>![Mv]</td>
<td>Contains Multiviewer configuration</td>
</tr>
<tr>
<td>![C]</td>
<td>Currently active configuration</td>
</tr>
</tbody>
</table>
### General Configuration

Your new configuration contains three tabs to help define configurations for the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
</table>
| Router  | • Click this option to define a Router configuration.  
         | • Follow the steps in Creating a Router Configuration. |
| Processing | • Click this option to define a configuration to control 6800+, Neo, X 50/75/85,  
            | Selenio, Platinum modules and frames, Platinum IP3 Modules and frames,  
            | and Multiviewer devices.  
            | • Follow the steps in Processing Configuration Overview. |
| Multiviewer | • Click this option to define a Multiviewer configuration.  
            | • Follow the steps in Multiviewer Configuration (on page 155). |

**Note:**
The tabs you see in a new configuration are dependent on your licensing.  
With a basic Magellan Router Control Panel license, you will see one tab for Router.  
With a PROC/MV license, you will see three tabs for Router, Processing, and Multiviewer.  
For more details on licensing, see Panel Versions and Licenses (*on page 43)*.

You can move between these 3 tabs as you define your configuration. Once you create configurations and move across tabs, you will be prompted to save changes as you move to ensure that your settings and definitions are not lost.

![Device specific configuration tabs in a new configuration](image)

**Figure 28: Device specific configuration tabs in a new configuration**

**WARNING**
Parallel access to the same panel is not recommended. Additionally, attempting to save the active configuration when a discovery or preset save is in progress will result in discovery or preset save failure.
Panel Gang Configuration

A Panel Gang configuration connects two or more panels in a master slave configuration. You can create a Panel Gang configuration by selecting Panel Gang when creating a new configuration.

When you create a Panel Gang configuration, in the Ganged Panels section, the current panel shows as Master (with a green M icon); you can add Slave Panels at the time of creating the Panel Gang configuration, or at a later time by right clicking in the Ganged Panels section.

If a panel gang configuration's Connection to Router (Options tab > Communications Options > Connection to Router) is set to Coax, the master panel should be connected to the router using XY, and other slave panels should be cascaded with the master panel via XY. All panels should be connected to the network via Ethernet.

Master Panels

- A single master panel can have multiple slaves (up to 8 slaves configured).
- An Identify option can be manually defined on the Master panel to enable identification of all slave panels. All slave panels blink when this option is used. The option is a toggle switch and is present on the Summary page.
- Gang configurations can only be created and edited on master panels
- With both Router and TRAX configurations defined in a panel gang configuration, TRAX functionality is available.
- Router Gang configurations support Button per Source and Category modes.
- In Gang configurations, all (master) panels support Button per Source mode. Only LCD (master) panels support Category mode.
- Breakaways are only supported on Master panels with OLED

**Slave Panels**

- A panel can only be slave to a single master panel.
- An **Identify** option on Slave panels enables identification of the Master panel. The Master panel blinks when this option is used. The option is a toggle switch and is present on the Summary page.
- Slave panels are displayed in the Ganged Panels section.
- Once ganged, slave panels can only be deleted from the master panel.
- Only Router configuration can be created on standard slaves. To do this, click the slave in the master’s Ganged Panels list, then follow the normal procedure to define Router configuration.
- Processing configuration can be created on a TRAX slave. To do this, click the TRAX slave in the master’s Ganged Panels list, then follow the normal procedure to define Processing configuration.
- On a Slave panel, while in Panel Gang Mode, PARAM mode can be accessed by holding down source/destination buttons. Applicable to non-PB panels. If a slave is PB-only, but the master is LCD or OLED, the master’s OLED or LCD becomes available or entering PARAM mode on the PB-only panel.

**Types of Slave Panels**

**Slave**

- A standard Slave panel can be of any type.
- Once added from the master, it is displayed in the Master panel’s Ganged Panels section, with a green **S** icon to indicate its status.
- Only Router configuration can be created on a standard Slave Panel.

**Trax Slave**

- A TRAX Slave panel must be LCD/OLED.
- TRAX Slave Panels have a blue **T** icon in addition to the green **S** icon.
- Once added from the master, it is displayed in the Master panel’s Ganged Panels section, with **S** and **T** icons to indicate its status.
- Processing configuration can be created on a TRAX slave panel.

**Adding a Slave Panel**

To add a Slave Panel:

1. Go to the **Ganged Panels** section of the Configuration navigation.
2. Right click and select **Add Slave Panel**.
3. Enter the IP Address of the panel to add as slave.
4. The Slave Panel will then be displayed with a green S icon to indicate its status.

![Ganged Panels]

**Notes on Panel Gang Configurations**

- All ganged panels need to run the same firmware version.
- In an active gang configuration, function buttons on the slave panel are disabled. You cannot use Shift+Menu on the slave panel to view information such as the IP. To do this, the slave panel must first be released from the master panel.
- In a panel gang configuration, when selecting a SRC or DST, the function of Shift + Param and Holding button to get Param/Lock/Protect/Lock Owner is not supported.
- Breakaways are only supported on Master panels with OLED
- The PROC+MV license supports ganging 2 panels together.
- Panel Gang configurations are supported in the Offline configuration tool. Users need to correctly specify slave panel IP and type, since the offline tool cannot check the panel information provided. Information will be validated once the configuration is imported into the online environment.

**Deleting a Panel Configuration**

1. Under the Panel Configurations list, highlight the name of the configuration to be deleted.
2. Click **Delete** on the **Configurations** tab display.
   - A warning message opens.
3. Click **Yes** to continue.
   - The configuration is deleted from the Panel Configurations list.

**Duplicating an Existing Panel Configuration**

**Note:** This function is different from the Copying function. The Duplicating function copies one configuration to another configuration, whereas the Copying function copies a configuration to another panel. See Copying a Panel Configuration to Other Control Panels (on page 177) for more information about the Copying function.

1. Access the **Configurations** page.
   - Existing panel configurations are listed to the left of the display. (If none exist, you must import a configuration or terminate this process.)
2. Under the Panel Configurations list, highlight the name of the configuration to be duplicated.
3. Click **Duplicate** on the **Configurations** tab display.
   - The **Add A New Panel Configuration** dialog box opens.
4. Enter a new configuration name in the **Configuration Name** text box, and then click **OK**.

The new configuration is placed in the Panel Configurations list.

---

**Importing a Configuration into an Existing Configuration**

You can import a configuration into a blank configuration tab (see Import Router Configuration, Import Processing Configuration, Import Multiviewer Configuration)

You can also import a configuration into an existing configuration by clicking the **Import Router**, **Import Processing**, or **Import Multiviewer** buttons at the top of the Router, Processing, and Multiviewer tabs.

When importing into a tab (Router/Processing/Multiviewer) that has a current configuration, the Import overwrites the current configuration, but a message is displayed before to confirm. Cancel to maintain your original configuration.

---

**Function Buttons**

**Configuration Home Buttons**

You can define buttons mapped to the Router, Processing, and Multiviewer home from within a Router Configuration. Function buttons pre-mapped to **Router/Processing/Multiviewer** home enable this. To define Configuration Home buttons:

1. In a **Router** Configuration, go to the **Panel Buttons** tab.
2. Select a button the panel representation
3. Select **Button Type** as **Function** and **Function Type** as **RouterHome/ProcHome/MViewerHome**.
4. Save the Configuration.

**Note:** In case of **Processing** and **Multiviewer** configurations, **function buttons must be defined in the Function button area**. If a function button such as **ProcHome** is defined in the LCD button area and you click it to switch to the Processing configuration, this button will be overridden by either a **Frame/Slot/Menu/Parameter** button or an empty button.
Once defined, these Home buttons are a convenient way to go to the root of the individual configurations.

**Note:** For Router/Processing/Multiviewer home buttons, your configuration should have all three configuration types enabled. If you have a Router only configuration, use the home button on the panel to go to the Router home.

**Undoing a Take**

**UNDO** (Take) can be assigned to a button in the function cluster. It undoes the last action and reverts to the previous status, regardless of whether the previous action was successful or not. For example, if the action prior to the last (successful) TAKE was a Failed TAKE, if you hit UNDO, it will undo the last (successful) TAKE, and it will revert to the previous (unsuccessful) TAKE.

**Undo functionality will not work if you do not use TAKE to switch.**

Note that only the last TAKE can be undone, not any takes prior to that. Any destinations involved in the TAKE being undone will revert to the last valid status, prior to that TAKE.

When an UNDO button is defined in the function cluster, on doing a TAKE, the UNDO button becomes active and blinks. The UNDO button, even if configured, will not be active unless a TAKE is done. The
active UNDO times out after a default of 30 seconds, so it does not remain active indefinitely. Navigation, for example to another destination, or to a configuration, will disable an active undo.
Unity

Unity is a new function button used to recall factory default values for parameters on a layer. It applies to Processing configurations. By default, Unity is defined on the second position on the first function button.

To trigger unity, press shift and then press Unity. When Unity is invoked in any layer of a Processing configuration, parameters in that layer and in subsequent layers are all set to factory default.

Note: Not all parameters on all devices will have factory defaults when queried; there could be parameter dependencies when batch setting parameter values on certain platforms, such as 6800, since these platforms do not support opaque presets.

Magellan Router Control Panel Discovery via Magellan™ CCS Navigator

The Magellan Router Control Panel exposes some of its information to other devices and servers via the CCSP Protocol. For example, you can use the Magellan CCS Navigator application to discover a Magellan Router Control Panel device using its IP Address, and certain panel options and settings are then retrieved.
Process to Discover a Magellan Router Control Panel in Magellan CCS Navigator

1. Launch the Magellan CCS Navigator application.
2. Ensure you are in Build Mode (File > Operational Mode > Build)
3. Click Tools > Discovery and then click the Options button
4. Click the Add button and provide the IP address to the Magellan Router Control Panel. In the Select Products for Discovery section, place a check beside the first option.

5. Click OK and then OK again. Click the Start button to start the Discovery.
6. Once Discovery is complete, click the Save button.
7. Select the discovered Magellan panel and click Tools > Parameters

Details will then be displayed in a window. Details are displayed in two tabs:

- Parameters: Magellan Control Panel Parameters in CCS Navigator (see "Magellan Router Control Panel Parameters in CCS Navigator" on page 74)
• Alarms: Magellan Control Panel Alarms in CCS Navigator (see "Magellan Router Control Panel Alarms in CCS Navigator" on page 75)

Magellan Router Control Panel Parameters in CCS Navigator

The Magellan Router Control Panel CCSP parameters are divided into 4 sections:

Physical Settings

- Panel Type (RO)
- Panel Name (RW)
- Panel ID (RW)
- IP Address (RW)
Panel Configuration

- Netmask (RW)
- Gateway (RW)
- MAC (RO)
- Alarm1 Notification Type (RW)
- Alarm1 Notification Status (RW)
- Alarm2 Notification Type (RW)
- Alarm2 Notification Status (RW)

Panel Versions and Licenses

- Software Version (RO)
- Hardware Version (RO)
- Serial Number (RO)
- Licensed Options (RO)
- Licensed Key (RO)

Panel Options

- Screen Saver Enable (RW) (parameter hidden on non LED panels)
- Wait Time (RW) (parameter hidden on non LED panels)
- Cycle Time (RW) (parameter hidden on non LED panels)
- Enable Ganging (RW)
- Save New Config to (RW) (parameter hidden on PB-only panels)
- Auto Sync DB (RW)
- Sync Database (RW)

Current Configuration

- Active Configuration (RO)
- Current Server IP (RO)
- Connection Status (RO)
- Toggle Server (RW)
- Fallback Config For Gang (RW)
- Other Configuration (RW)

Magellan Router Control Panel Alarms in CCS Navigator

The following alarms are exposed via CCSP (in the Alarms tab in CCS Navigator):

- **Secondary Server IP**: Active when the secondary server IP is in use
- **Active Configuration Modified**: Active when the active configuration has been modified at the panel
• Active Configuration from USB

![Magellan panel configuration](image)

Alarm settings will be reset to default if the panel is downgraded to a version lower than 3.3.

**Process to Discover another Magellan Router Control Panel**

You can also discover one Magellan Router Control Panel from the Web UI of another, the discovery process is similar to any Processing device. See Discovery - Selenio 6800+, NEO, Selenio X50/75/85/100, Selenio MCP, Platinum, Platinum IP3, Multiviewers (on page 82). Once discovered, all parameters of the discovered panel can be controlled by the main panel.

**Clean and Quiet Switching**

Clean and Quiet switching refers to how video/audio content is switched, from one source to another. Clean refers to non-disruptive, glitch-free transition of Video content when switching from one source to another (at the same data- and frame-rate). Quiet refers to audible artefact (pops, clicks) free transition of embedded Audio content when switching from one source another source (at the same data- and frame-rate).

Switching between sources can be triggered by hardware or software driven events. For example, a TAKE command from the Magellan Router Control Panel can trigger a switch.

Clean and Quiet switching is currently supported for the following devices:

- Platinum™ VX Router (See Configuring Clean and Quiet Switching for a Platinum™ VX Router (on page 150))
- Selenio™ Clean and Quiet (CQS) Module (See Controlling a Selenio™ Clean and Quiet (CQS) Module (on page 93))
Processing Configuration

The **Processing** tab enables you to discover and map elements (frames, modules, parameters, etc.) from Selenio 6800+, NEO, Selenio X50/75/85/100, Platinum, Platinum IP3 frames/modules, and Multiviewers.

**Note:** PB-OLED panels support only 2 pages of parameters. Processing Configurations are not supported by PB only panels.

**Note:** From Magellan 2.5 onwards, Multiviewer devices can be discovered and mapped in a Processing configuration. The standalone Multiviewer tab has been maintained for backward compatibility.

Creating a Processing Configuration

1. Follow the initial steps in Creating a New Panel Configuration (on page 62).
2. Then go to the **Processing** tab. You have 2 options here:
   - **Add Processor Configuration to this Panel Configuration**
     Select this option to create a new Processing configuration
   - **Add Processor Configuration to this Panel Configuration**
     Select this option to import a configuration from the panel itself (or from a file)

When you click the **Import Processing** button, only those configurations that contain a **Processing** configuration will be displayed for import, and other types (for example, a Multiviewer *only* configuration) will be filtered out.

When importing into a **Processing** tab that has no current configuration, the new configuration is imported in, and a status message displayed on successful import. Also see Importing a Configuration into an Existing Configuration (on page 69).
Tabs in a Processing Configuration

Once a Processing Configuration has been enabled, three sub tabs are visible.

- Favorites Tab (on page 78)
- Panel Buttons Tab (on page 80)
- Options Tab (on page 81)

Favorites Tab

The Favorites tab displays an interface to help discover frames/modules from a variety of devices. You can discover a frame, see modules in that frame, and drill down to menus/parameters in modules. You can currently discover and control frames/modules in:

<table>
<thead>
<tr>
<th>Processing</th>
<th>Routers</th>
<th>Multiviewers</th>
</tr>
</thead>
<tbody>
<tr>
<td>6800+</td>
<td>Platinum</td>
<td>Platinum SX Hybrid / IP</td>
</tr>
<tr>
<td>NEO</td>
<td>Platinum IP3</td>
<td>Platinum SX Pro 16</td>
</tr>
<tr>
<td>X50/75/85</td>
<td></td>
<td>Platinum SX Pro 32/64</td>
</tr>
<tr>
<td>Selenio</td>
<td></td>
<td>Platinum Predator II / Selenio 6800+ Multiviewer</td>
</tr>
</tbody>
</table>

Figure 31: Favorites Tab
Device Discovery

Click the Database Management button to get the interface to discover devices. This provides an interface (available in Processing Configurations) to discover devices that are then centrally accessible across all Processing configurations on a panel. This eliminates the need to re-discover the same device multiple times, particularly if it needs to be accessed in different configurations.

![Database Management Interface](image)

**Figure 32: Device Discovered via the Database Management Dialog**

Discovery Interface

The interface of the Favorites tab is divided into 4 columns:

- **Favorite IPs**: This is a list of already discovered devices, or devices you enter for discovery. To discover a device, Click the Add IP button and enter the IP address of the device to discover, then click Discover.
- **Discovered IP/Frame**: Displays discovered devices/frames, prefixed by type, suffixed by IP Address.
- **Device/Subdevice**: Displays devices/modules contained in the discovered device
- **Menu/Parameter**: Displays menus/parameters for modules

See Device Discovery and Mapping (on page 82).

Once a device has been discovered, ensure it is selected (Select Item with children (on page 83) includes the child tree) and that the Append checked item to Configuration (on page 83) is checked, and move to the Panel Buttons Tab (on page 80) from where the device can be navigated and its elements mapped to buttons.

Exporting Discovered Device Configurations

Discovered Devices can be exported to other panels (using the Export option) and imported using the Import option in the Database Management Discovery UI.

Follow this process to discover a device via the Database Management UI:

1. Create a new Processing configuration in the Web UI.
2. Go to the Favorites tab and click the Database Management option at the top
3. Click the **Add IP** button and enter the IP address of the device to discover.
4. Click the **Discover** button to initiate the discovery process. Once discovered, the discovered device is saved to One Database.
5. Create another processing configuration, go to the **Favorites** tab. The device previously discovered via the (Database Management option) will be available in the **Discovered IP/Frame** column of the **Favorites** tab.

![Figure 33: Device previously discovered via Database Management, available by default in new configurations](image)

**Panel Buttons Tab**

The **Panel Buttons** Tab enables mapping of buttons to discovered devices or elements from those devices. The **Panel Buttons** tab interface is divided as follows:

- Buttons available for mapping are displayed in the panel representation on the right.
- Discovered devices, sub-devices, menus, and parameters are displayed in the **Selected Favorites** section below - you can navigate, select an element, and double click to map it to a button (ensuring that you first select a button).
- The **Current Configuration** navigation pane on the left displays a tree view of discovered devices.

You can map a group, frame, device (module), menu, or parameter to a button.

- **Frame**: To map a frame, select a button, then double click a frame from the Discovered IP/Frame column. When correctly mapped, the device type and IP address will be displayed on the button. For example, 6800+ 172.45.64.4.
- **Device/Subdevice**: To map a device/subdevice, select a button, then double click any of the elements in the Device/Subdevice column.
- **Menu**: To map a menu, select a button, select the relevant frame in the first column, and the module in the second column to see corresponding menu options in the third column. Double click the menu option to map to the selected button.
- **Param:** To map a parameter, select a button, select the relevant frame in the first column, and the relevant module in the second column to see the corresponding available parameters in the third column. Double click the parameter to map to the selected button. Also see Ganging Parameters (on page 90).

**Options Tab**

The **Options** tab contains some option controls specific to the Processing tab.

**Add Device From Panel**

The **Add Device From Panel** option controls whether users can add processing devices directly from the Magellan hardware panel. For information on how this can be done, see Adding a Device (on page 204).

**Note:** The "Add Device From Panel" option is not available in case of Panel Gang configurations. This option is only available on LCD and LCD-OLED panels.

**Knob Press Action**

In general, the knob on the physical control panel functions as a selection control.

The **Pressing Action of Knob** option specifically controls what happens on pressing of the physical knob from within Processing configurations and TRAX configurations. The options are:

- **Knob Press Exit:** Selecting this option makes the knob function as a cancel or exit control, taking you to the previous menu.
- **Knob Press Select:** Selecting this option makes the knob function as a selection, taking you to the sub level menu.
Device Discovery and Mapping

- Discovery - Selenio 6800+, NEO, Selenio X50/75/85/100, Selenio MCP, Platinum, Platinum IP3, Multiviewers (on page 82)
- Navigation of Discovered Devices (on page 84)
- Mapping Buttons to Frame/Module Elements (on page 87)
- Mapping Buttons to Multiviewer Elements (on page 90)

**Note:** Magellan Router Control Panel version 3.3 and higher supports controlling Selenio X100 devices.

Discovery - Selenio 6800+, NEO, Selenio X50/75/85/100, Selenio MCP, Platinum, Platinum IP3, Multiviewers

**Step 1 - Provide IP Address**

- In a Processing Configuration, go to the **Favorites** tab, and click **Database Management**.

- In the first column, click the **Add IP** button and enter the IP Address of the device to discover. Click **OK**. Click **Discover**.

**Step 2 - View and Select Frames/Devices**

- Once discovered, the device is displayed in the second column **Discovered IP/Frame**, prefixed by the device type (IP3, Selenio, 6800+, X75, etc) and followed by the IP address.

- You can select the checkbox against an IP and click the **Delete** button to remove it.

**Step 3 - View and Select Modules**
Modules contained in the discovered device are displayed here.

- Select a device in the **Discovered IP/Frame** column to have its elements (list of modules) populated in the **Device/Subdevice** column.
- Select the checkbox against any of the modules in this column, to have its menus and parameters populated in column 4 **Menu/Parameter**.

**Step 4 - View and Select Menus/Parameters**

- A list of menu groups and parameters for the selected module are displayed in this column.
- Click the arrow beside the options to expand and drill down to individual parameters.

---

**Append checked item to Configuration**

- **Append checked item to Configuration**

Selecting **Append checked item to Configuration** option makes the newly discovered device available in the **Panel Buttons** tab, both in the **Current Configuration** section on the left (which shows a tree view of discovered devices and from the **Selected Favorites** section below the panel representation (from where an element can be selected and mapped to a button).

By default, the **Append checked item to Configuration** option (to the top right of the page) is not selected. If unchecked, the newly discovered device will not be appended to the current configuration, and its options will not be available for selection and mapping to buttons in the Configuration Editor workspace.

**Select Item with children**

Check the **Select Item with children** checkbox to automatically select all child items when you click on an option.
Navigation of Discovered Devices

The Navigation pane on the left is divided into three sections:

- **Panel Configurations**: Displays a list of configurations with controls to create and manage them.
- **Current Configuration**: Displays the hierarchy of the current configuration, right from the root level of the discovered devices.
- **Ganged Panels**: This section is only expandable in case of a Panel Gang Configuration (on page 66), where the master panel is displayed along with any defined slaves.

**Up and Down Buttons**

Up and Down buttons help you move through the navigation. Up drills higher up in the navigation, and Down helps you drill down.

For example, if the Selenio MCP Controller menus are currently displayed:

- Clicking Up once takes you to the higher level module view in Selenio (displaying the controller and other modules). Clicking Up again displays the Selenio frame and other currently discovered devices.
- Clicking Down once drills down to the menu options for the selected category. Clicking Down again drills down further (if lower level options are available).

Figure 34: Up and Down buttons

**Control Buttons**

Control buttons are available above the panel representation as well as on right clicking any of the buttons. You can select one or more buttons and right click to see the button functions menu.
The following functions can be applied to one or more buttons (Shift+Select or Control+Select to select multiple buttons)

- **Copy**: To make a copy of a button, select a button and select Copy.
- **Paste**: After copying a button, go to a blank button and select Paste.
- **Cut**: You can Cut and Paste mapped buttons to different locations. You can move to a button that is blank or already mapped (the old mapping will be replaced by the new button).
- **Map From**: Use to replace a previous assignment with a new one. Only works for buttons of type Frame or Device. Select a button, select Map from, then make changes from the access list to remap. You can also use Remap when you need to assign the same frame/device configuration to multiple buttons. Configure one and remap to other buttons as required.
- **Assign Group**: Use to add a group button. Frames/Devices/Menus/Parameters can be added under Groups.
- **Assign Menu**: Use to add a menu button. Menus/Parameters can be added under a Menu.
- **Empty**: To remove a button assignment, select the button and then click Empty.
- **Layer Up**: Select a button and select Layer Up to move it up a layer. Note that if you are already on the topmost layer, this option will be grayed out.
- **Layer Down**: Select a button and select Layer Down to down it up a layer.
- **Properties**: When you right click a button assigned to a frame/device and select Properties, you can change the Name/IP/Slot of the frame/device.

On non-frame/device buttons, you can just edit the button label when you select Properties.

- **Drag and Drop**: You can also drag and drop buttons as required, with the result that the button is moved to the location you drag it to. An outline of the button will be displayed in the space you drag it to.
Mapping Buttons to Frame/Module Elements

Once a frame or module has been discovered though the Favorites tab, switch to the Panel Buttons tab.

Click the panel of buttons in the panel representation to have it enlarged and displayed below. Click a button to map it to an available or discovered element.

Show Parameter Value

The Show Parameter Value option applies to Processing configurations, and can be set either locally or globally to control whether parameters mapped to buttons in the GUI are displayed on the physical panel buttons. When set globally, it affects all parameter buttons in Processing configurations, and when set locally, it affects specific parameter buttons.
Setting Globally
You can set **Show Parameter Value** globally in the **Processing Configuration > Options** tab.

Note that the global setting is applied by default to any newly created parameter buttons.

Setting Locally
You can set **Show Parameter Value** locally in the **Processing Configuration > Panel Buttons** tab.

To set locally:
1. First map a parameter to a button or select a button that has a parameter mapped to it
2. The **Button Appearance** section expands to display an option - **Show Parameter Value**
3. Select this check box to have the Parameter Value show for that specific button

Once you select the checkbox, you will be need to save the Configuration. If you do not save, the local setting will not apply and the global setting will be used instead.

Note that the Show Parameter Value section shows in the Button Appearance section only when you select a button that has a parameter mapped. For all other button types, this section only displays the default LCD Text Layout and LCD Buttons Font Size section.

**Notes**

- Table parameters are not supported, and their values will not be displayed on panel buttons
- Multi selection of parameters (and attempting to set the Show Parameter Value on multiple buttons in one go) is not supported

**LCD Text Layout Settings**

The Show Parameter Value option is affected by the Text Layout settings in the **Options Tab > Appearance Options**. For instance, if Show Parameter Value is enabled locally, and LCD Text Layout is set to "1 Row of Text"

At the local level Show Parameter Value will be unchecked and grayed out

At the global level, it will be set to No and grayed out as well
Mapping Buttons to Multiviewer Elements

Once you discover a Multiviewer device through the Favorites tab, a button is automatically mapped to the discovered devices in the Panel Buttons tab.

![Image of button mapping](image)

**Figure 38: Buttons mapped to an Platinum SX Hybrid Device**

Additionally, you can drill down in the Selected Favorites section and map to elements.

Ganging Parameters

Ganging parameters refers to assigning multiple parameters to a single button. Invoking that button launches all the parameters together. In a Processing configuration, if you have already mapped an option to a button and attempt to map a second option to the same button, a message is displayed to confirm whether both parameters should be mapped to the same button (ganged) or if the second parameter should replace the first one.
On the panel, you can view parameters that have been ganged (assigned) on a button. Press and hold down the button with the ganged parameters to see the individual parameters that have been assigned - these will be displayed on the buttons as well on the OLED.

In the Web UI, you can view all the parameters assigned to (ganged onto) a button by hovering over the button.

![Parameter List for Gang](image)

**Figure 39: Viewing Parameters ganged onto a button**

Note: If you change the IP address(es) of parameters ganged on a button, only the first parameter will reflect the change (provided the device that contains the parameters is online).

To delete one or more parameters that have been ganged on a button, double click the button with ganged parameters, and then click the X against the parameters to delete.

![Parameter List for Gang](image)

**Figure 40: Deleting Ganged Parameters**

**Notes**

- **Number of Parameters**: You can map as many parameters as required to a single button. When that button is pushed on the panel, all the parameters get invoked.

- **Button Label**: The button label displays the first parameter assigned to the button. Buttons that contain ganged parameters have their label (parameter name) prefixed with an asterisk (*) to indicate it contains several parameters.

- **Multi Frame Support**: From version 3.5 onwards, parameters from different frames can be ganged together, in addition to parameters from the same frame.

- **Parameter Type**: Only parameters of the same type can be ganged together. If you attempt to gang a parameter of a different type from the first parameter, it will be ignored.

- **Deleting Parameters**: Deletion of a ganged parameter results in deletion of all parameters associated with that button.

- **Shift+Parm Function**: Usage of the function Shift+Param when selecting Sources/Destinations to get Parm/Lock/Protect/Lock Owner is not supported in ganged configurations.

- **Auto Trax** (See Auto TRAX SRC (on page 147) and Auto TRAX DST (on page 149)) is not supported in ganged configurations.
Deleting a Processing Configuration

Click **Processing Configuration** (to the right of the page) to delete a configuration.

**Note:** Discovered IPs/Frames can only be deleted from Favorites after all the Frame/Devices/Menus/Parameters related to that IP have been deleted from panel buttons. The list of Favorites will not be loaded if the Frame/Device/Menu/Parameter on the panel button is not discovered using the Web UI. If you do not see it, rediscover to get the full parameter path.

Creating a Processing Configuration on PB-OLED Panels

Follow these steps to create a processing configuration on PB-OLED panels.

1. Create a new panel configuration. Follow the steps in Creating a New Panel Configuration (on page 62)
2. Go to the Processing tab and click the Create Processing configuration button
3. Discover the Frame/IP in the Favorites tab and then switch to the Panel Buttons tab
4. Select the programmable push button block, then select a push button. You can assign/define favorite parameters to the push buttons.
5. Panel labels can be created.

PB-OLED Panels - Notes

- A maximum of 2 pages can be created on a PB-OLED panel
- Only parameters can be defined on push buttons
- Parameter gang is supported on PB-OLED panels.
Controlling a Selenio™ Clean and Quiet (CQS) Module

Do the following in the Magellan Router Control Panel Web UI:

1. Create a **Processing Configuration**
2. Go to the **Favorites** tab and click the **Database Management** button
3. Do the following in the Database Management dialog:
   a. Click the **Add IP** button and enter the IP address of the Selenio device that contains the Selenio CQS module you want to control.
   b. Click **OK** and then click **Discover**. Once discovered, the Selenio frame will be displayed in the **Discovered IP/Frame** column; select it to have the contents displayed in the **Device/Subdevice** column.
   c. In the **Device/Subdevice** column, select the CQS Module to see its menus and parameters displayed in the **Menu/Parameter** column.
4. Click **Close**. In the **Favorites** tab, select the device and select the **Select item with children** option.
5. Go to the **Panel Buttons** tab.
6. Select a button and (from the Selected Favorites section below) select a parameter to assign (by navigating through the menus and parameters).

7. For the Selenio CQS Module, ensure you map at least the following parameters under Control > Custom Switch Control
   - Mode of Operation, Take Mode, Dst(1-4) Current Src, Dst(1-4) Preset Sel, Take

8. Map as many other parameters as required.

9. Go to the Options tab and set Show Parameter Value to Yes
   (Ensure that LCD Text Layout is set to higher than 1 Row of Text)

10. Save and Activate the configuration.

11. Go to the physical panel. You will see mapped parameters along with values displayed

12. As a control example: select a Destination button, you will see buttons with Source options, select one of them to change the Source, exit the current mode to see the change.

**Note:** Instead of manually mapping parameters, you can do this entire process using a predefined Selenio CQS Template (XML file). Contact Customer Support or visit the Customer Portal to download this template.

Once you have it, in your Processing Configuration, go to the Panel Buttons tab, right click a button, select Import, and select the Selenio CQS template XML file. Once imported, you will see a menu called SelCQSTemp. Right click it, select Properties, and enter the IP Address and Slot of the Selenio CQS module/device.
Configuration Templates

From Magellan Router Control Panel 3.0 onwards, in Processing configurations, you can create templates with parameters and options from discovered devices, and these templates can be exported for use with other Processing configurations.

For example, in case of a Platinum SX Pro Multiviewer, you could create a template with say 3 displays, and options like PIP Source, PIP full Screen, and Active Preset. And this can be exported for further use.

Steps to create a Configuration Template

Create a Processing Configuration in the Web UI

1. Go to the Favorites tab and click the Database Management button
2. Click the Add IP button and enter the IP address of the device to discover
3. Switch to the Panel Buttons tab
4. Define the configuration by mapping parameters and options to buttons on one or more layers
5. Right click the top level button and select Export. Save as <filename>.xml

This configuration can now be re-imported and used as required.

Presets

A total of 4 presets can be saved directly on the panel. To see presets on the panel:

1. Ensure a processing configuration is active, then press Shift + Menu on the panel
2. Press the Preset option button. You will see 3 options:
   - Load - Press to load defined presets. Depending on the number of presets mapped, you will see PRESET1 to PRESET4 buttons.
   - Save - Use to save a preset
   - Delete - Use to delete a preset

Note: In case of 2 RU panels (OLED and LCD), the bottom four function buttons are reserved for presets (1-4); hold down the button to load a saved preset

How to Save (Map) a Preset

On the panel, go to the option you want to map to a preset. For example, press PROC on the panel, then select an option (button) to map to a preset.

1. Press Shift + Menu on the panel, then press Preset, then Save.
2. Select an empty preset button, denoted by PRESET(1-4) [empty]
3. You can also select an already mapped preset (without the empty on the label). Note that this will overwrite the previously defined preset.
**Note:** If your preset has many parameters, it could take a while to load. When loading a preset, parameters that have been accessed before will display the previous value. Parameters that have not been accessed before will be display as "loading" until the load completes.
The **Router** tab enables you to discover and map elements from Routers. You can also map Selenio
presets and Multiviewer controls to buttons in a Router configuration.

The **Router** tab contains the following sub tabs:

- **Panel Buttons** (See Panel Operation Modes (see "Router Configuration - Panel Operation Modes" on page 112))
- **Access Lists** (See Changing Access Lists (Router) (on page 166))
- **Local Aliases** (See Setting Up Local Aliases (on page 198))
- **TRAX** (See TRAX Functionality (on page 144))
- **Options** (Changing Logical Control Options (on page 172), Changing Communication Options (on page 170), Changing Appearance Options (on page 166), Trax Options
- Also see: Dynamic Crosspoints (on page 140)

### Create New Router Configuration

1. Follow the initial steps in Creating a New Panel Configuration (on page 62).
2. Then go to the **Router** tab. You have 2 options here:
   - Create New Router Configuration (on page 97)
   - Import Router Configuration

3. Click **Add router configuration to this Panel Configuration** and follow the steps in the **New Configuration Wizard** displayed.
   a. **Router Configuration Base** - choose one of the following setup options and click **Next**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Logicals on an Existing Configuration</td>
<td>Uses an existing configuration. Copies the logical database of the selected configuration in the configuration list.</td>
</tr>
<tr>
<td>Start from a Blank Configuration</td>
<td>Develops a configuration setup with a default logical database</td>
</tr>
</tbody>
</table>
### Option | Function
--- | ---
Start from an Existing Logical Configuration File |Copies a logical database from a configuration file in *txt format that is saved on the configuration PC. Navigate to the location of the desired configuration file, select it, and then click OK.

Create a Selenio preset control without router configuration | Creates a Selenio preset control without configuring a router. Click **Finish** directly if you select this option.
Also see Selenio Preset Mode Panel (on page 119).

---

b. The **Panel Options** dialog box is displayed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Enter the <strong>IP address</strong> of the server device to control</td>
<td></td>
</tr>
<tr>
<td>• Select the type of <strong>Name to Use</strong> from the drop-down list. (See Control Option Selections for descriptions)</td>
<td></td>
</tr>
<tr>
<td>• Click <strong>Allow New Logical Items</strong> to automatically add new logicals to a panel configuration</td>
<td></td>
</tr>
<tr>
<td>• Click <strong>Next</strong></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 41: New configuration wizard - Panel Options dialog box](image)

---

c. The **Configuration Type** dialog box is displayed. Select one of the configuration type setup options: blank, default, or custom.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Factory Default Configuration</strong></td>
<td>Creates a blank configuration with factory-default assignments.</td>
</tr>
<tr>
<td>• <strong>Default Configuration</strong></td>
<td>Creates a configuration with default assignments based on a given panel type. Select the base for the default layout: (Default layout types depend on panel type, and could include the following)</td>
</tr>
<tr>
<td>• Single bus panel</td>
<td></td>
</tr>
<tr>
<td>• Multibus panel</td>
<td></td>
</tr>
<tr>
<td>• Grouping single bus panel</td>
<td></td>
</tr>
<tr>
<td>• Grouping panel</td>
<td></td>
</tr>
<tr>
<td>• Category panel</td>
<td></td>
</tr>
<tr>
<td>• <strong>Custom Configuration</strong></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 42: New Configuration wizard - Configuration Type dialog box](image)
Option | Function
--- | ---
A list of customization choices is displayed under Configuration Type at the left side of the dialog box. Select one, two, three, or all four customization options

Custom Option | Function
--- | ---

Mode Selection | Allows access to sources and destinations with a button push, a defined grouping structure, or by categories and indexes defined in a database

Accessibility Mode | Sets up single or multiple destination access mode

Destination Options | Allows selection of the number and type of favorite destinations for a panel

Source Options | Allows selection of the number and type of favorite sources for a panel

d. Click **Finish**. The new panel is placed in the **Panel Configurations** list.

To review the panel, click the panel name.

- If the configuration is acceptable, save it.
- If any changes are necessary, make the changes, and then save the changed configuration.

**Note:** The Common Configuration Tasks section contains instructions for the types of changes you can make to a configuration.

---

### Import Router Configuration

1. Follow the initial steps in **Creating a New Panel Configuration** (on page 62).
2. Then go to the **Router** tab. You have 2 options here:
   - Create New Router Configuration (on page 97)
   - Import Router Configuration

3. Click **Import Router Configuration to this Panel Configuration** to import a configuration from the panel itself, or from a file.
When you click the **Import Router** button, only those configurations that contain a **Router** configuration will be displayed for import, and other types (for example, a Multiviewer *only* configuration) will be filtered out.

When importing into a Router tab that has no current configuration, the new configuration is imported in, and a status message displayed on successful import. Also see Importing a Configuration into an Existing Configuration (on page 69).

By default, configurations on the panel are expanded and displayed. All current Router/Processing/Multiviewer configurations (except ganged configurations) will be displayed for selection.

**Note:**
- Only non ganged configurations will be loaded from file
- The panel type of the selection configuration should match the current panel type.

### Tabs in a Router Configuration

The following sub tabs are available in a Router configuration:

- **Panel Buttons:** You can map elements and functions to buttons in this tab. See Editing Button Types (on page 181).
- **Access Lists:** See Changing Access Lists (see "Changing Access Lists (Router)" on page 166)
- **CQ DST:** See Clean and Quiet Switching (on page 76)
- **Local Aliases:** See Setting Up Local Aliases (on page 198)
- **TRAX:** See TRAX Functionality (on page 144).
- **Options**: Option controls specific to the Router tab are displayed here

Support for 64 Levels

Magellan Router Control Panel 3.6 onwards supports 64 levels. When configuring, you can see all the levels (based on what's present in the Names.txt file).

![Levels in the Access Lists tab](image)

**Figure 43: Levels in the Access Lists tab**
This functionality is dependent on the Protocol defined in the **Preferred Communication Protocol** in the **Communication Options** in the **Options** tab.

- When set to LRC Mode, 64 levels are supported.
- When set to XY Mode, only 16 levels are supported for switching (even though the panel and the Web UI show all defined levels)
Other Devices in a Router Configuration

- Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration (on page 103)
- Platinum MADI (PT-MADI4X-OBG) in a Router Configuration (on page 104)
- Platinum Frame Synchronizer (PT-FSDMX-IBG) in a Router Configuration (on page 111)

Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration

You can map buttons to Selenio MCP presets from within a Router configuration.

**Note:** A Selenio MCP preset is a snapshot of Selenio MCP (1/3) parameters. You can create Device presets applicable for specific modules within the Selenio MCP frame, or System presets that contain parameters for all modules in the Selenio MCP frame.

1. In a new (see Creating a New Panel Configuration (on page 62)) or existing Router configuration, go to the Panel Buttons tab. On the panel visual representation, click on the part of the panel to modify.

2. Select a button in the Button View section (to select multiple buttons, hold the left mouse button down and drag over the buttons to select) to map Selenio Presets to.

3. In the Button Type list, select Selenio Preset. The Type Properties section is displayed.

4. Provide the device details:
   - The Selenio MCP Device IP
   - The Slot Number (you can opt to control modules in slots 0-14).
   - The Name
   - The Maximum number of presets to display on buttons
Note: You can also select Selenio Preset Mode as the Panel Operation Mode. This applies the Selenio preset template onto all buttons in your configuration. You can change the type at any time from the Button Type list.

Figure 45: Mapping Selenio presets in a router configuration

Controlling a Selenio (MCP) Device

You can now invoke and control a Selenio (MCP) device by doing the following:

1. Press the defined Selenio Preset button on the panel.
2. On successfully connecting to a Selenio MCP frame and module, available presets for that module will be retrieved, mapped, and listed on the Magellan Router Control Panel buttons.
3. Click on the desired presets to load them.

Note: Any errors such as incorrect Server IP, incorrect or empty slot, or no defined presets, result in appropriate errors displayed.

Platinum MADI (PT-MADI4X-OBG) in a Router Configuration

You can use Magellan Router Control Panel to control the 4 output formats on the Platinum Multichannel Audio Digital Interface (PT-MADI4C-OBG and PT-MADI4O-OBG) Output card.

Configuring the Platinum MADI output module for control through Magellan Router Control Panel requires the use of Navigator and the built in Device Type Wizard to define the MADI device type.

Follow these steps to configure Platinum MADI for control through Magellan Router Control Panel.
Create a Routing System with the Router and Magellan Router Control Panel

1. Start Navigator. Ensure you are in Build mode.
2. If starting from scratch, create a new routing system by right clicking the Routing folder and selecting Create > Routing System.
3. Provide a name for the Routing System. If starting from a blank configuration, select the Perform System Poll checkbox and enter the IP address of the Platinum Router in the Connection text box.
   Note: If your Magellan Router Control Panel device is already connected to the router, it will be discovered and listed under Hardware Control Panels.
4. Expand Control Views and double click the new configuration.

5. A Configuration window for the selected routing group will open up.

Run the Device Type Wizard

1. Click the Wizard icon in the toolbar at the top of the Configuration window.
2. The **Device Type Wizard** opens up. Select **Create New Custom Device Type**. Provide a name and click Next.

3. Click the **Add Connection Type from Template** button. An **Add Connection Types** drop down is displayed.

4. Select **Multiplex Mono Audio** or **Multiplex Stereo Audio** and click OK. Click **Next**.

5. The **Level Selection** dialog is displayed.
You can select the Starting level and additionally, set **Audio Options**. Click **Next**.

6. Define the Audio levels and click **Next**.
7. Finally, you define any specific input levels and click Finish.

Add Logical Destinations
1. Go the Destinations tab.
2. Highlight the entire row where you want to add destinations, and then right-click.
3. Select the Insert Destinations > Insert from Device Type option
4. Select the (MADI) device type defined in Step 2 of Running the Device Type Wizard (see "Run the Device Type Wizard" on page 105) and click Next.

5. The Basic Options dialog is displayed. Provide the following information and click Next.

- In the Name Options text box, enter a prefix that identifies the device.
- Select the initial index number from the Starting Index Number spin box.
- If desired, in the Name Suffix text box, enter a suffix that identifies the device more specifically.
- In the Description text box, add a description of the device and/or device family. This information appears in a device’s Sources or Destination tab Description column.
- If more than one item should be inserted, select the total number from the Quantity to Insert spin box.
6. The **Advanced Options** dialog box is displayed. Here, you can assign certain advanced options for your sources and destinations. It is especially useful for setting up mono switching or stereo pair switching so you can address them on our control devices.

- Select an initial video level number from the **Starting Level Index Number** spin box within the Video Location box.
- Select an initial audio level number from the **Starting Level Index Number** spin box within the Audio Location box.
- Enable (retain check mark) or disable (remove check mark) the Enable check box for each connection type selection.
- If you want to create mono sources, select the **Create Logical Sources for Audio Breakaway Switching** check box. (This only applies to inserting device types with audio on the Sources tab.) A Mono source allows you to do special audio swaps from a control panel.

7. Click **Finish** when your selections are complete.

8. Click the **Publish Logical Names to Devices** icon on the top toolbar.

9. Select the Router and the Magellan Router Control Panel device to publish to and click the **Start Transfer** button.

---

**Access MADI parameters on the Magellan Router Control Panel**

Once you have successfully published your configuration to the Magellan Router Control Panel, you can access and view or edit the MADI Output format parameter on the panel.

1. On the Magellan Router Control Panel, select the Destination configured for MADI. Refer the row you added your destination to in **Adding Logical Destinations** (see "Add Logical Destinations" on page 108).

2. Press Shift + Parm

3. The four parameters will be displayed:
   - MADI Output Format 1
   - MADI Output Format 2
   - MADI Output Format 3
   - MADI Output Format 4
4. Click on any of the parameters to see the current setting. The possible options are:
   - TDM 1 - 56 (56 Channels)
   - TDM 33 - 88 (56 Channels)
   - TDM 65 - 120 (56 Channels)
   - TDM 1 - 64 (64 Channels)
   - TDM 33 - 96 (64 Channels)
   - TDM 65 - 128 (64 Channels)

5. If you make any changes to this parameter on the panel, the change will reflect on the router.

**Platinum Frame Synchronizer (PT-FSDMX-IBG) in a Router Configuration**

To control the Platinum Frame Synchronizer, follow the same steps as Platinum MADI (PT-MADI4X-OBG) in a Router Configuration (on page 104).

- **Create Routing System**
  To discover your Platinum Frame Synchronizer card, follow the steps as outlined in the Creating a Routing System with the Router and Magellan Panel (see "Create a Routing System with the Router and Magellan Router Control Panel" on page 105) section.

- **Device Type Wizard**
  Run the Device type Wizard as described in Running the Device Type Wizard (see "Run the Device Type Wizard" on page 105) and use the **HD Embedded** custom template for the Platinum Frame Synchronizer card.

- **Add Sources**
  Add your sources (follow the steps as outlined in Adding Logical Destinations (see "Add Logical Destinations" on page 108), but ensure you are in the **Sources** tab to add your sources).

- **Access Parameters**
  Once you have successfully published your configuration to the Magellan Router Control Panel, select the source button configured for PT Frame Sync. The parameters will then be displayed.
Router Configuration - Panel Operation Modes

For Router control, Magellan Router Control Panels can be set up in specific operation modes:

- Button Per Source (BPS) Mode (on page 112)
- Category/Index Mode (on page 114)
- Group Mode (on page 116)
- Selenio Preset Mode Panel (on page 119)

Also see:
- Panel Functions (see "Router Configuration - Panel Functions" on page 124)
- Detailed settings for Operation Mode Panels (on page 131)

Table 14: Operation Modes available for each panel type (* = Default)

<table>
<thead>
<tr>
<th>Panel Type</th>
<th>Button Per Source</th>
<th>Grouping</th>
<th>Category/Index</th>
<th>Selenio Preset</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCP-16PB</td>
<td>•*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCP-48PB</td>
<td>•*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCP-96PB</td>
<td>•*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCP-32PB-OLED</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-64PB-OLED</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-16LCD</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-32LCD</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-64LCD</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-24LCD-OLED</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RCP-48LCD-OLED</td>
<td>•</td>
<td>•*</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

**Button Per Source (BPS) Mode**

**Use Case:** A user wants to configure a panel where individual sources and/or destinations are assigned to individual buttons.

- Pushbutton only Panels are configured out of the factory in this mode.
- Panels with an OLED display window and/or LCD buttons have a template loaded in memory that can be recalled to allow operation in this mode; or, users can create new templates.
- The panels’ web configuration tool allows the user to adjust the number of source/destination buttons, as well as limit access to sources and destinations, if desired.
• If the database is large, panels with LCD buttons can page through the entire logical configuration to access more sources/destinations than can be displayed on available buttons.

**Working with Button Per Source mode**

In **Button Per Source** mode, a user can assign individual sources and/or destinations to individual buttons. All **Magellan Router Control Panels** can operate in Button Per Source mode.

**To setup button per source mode**

1. Ensure that the appropriate logical database is configured to allow grouping (see **Volume 6: Routing Components** of the **CCS Navigator User Guide**).
2. Ensure that the panel is configured for button per source mode.

Group Operation: Favorite Destinations (1) and Groups (2) shows an example of a Magellan Router Control Panel in **Button Per Source** mode. The favorite destination panel buttons (1) are shown and the source group buttons (2) are highlighted. The mode, selected destination, and selected source are displayed on the OLED.

![Figure 46: Group Operation: Favorite Destinations (1) and Groups (2)](image)

3. You can operate in source mode or destination mode.
   - **To operate in source mode**
     1. Press **SRC** to put the panel into Source mode.
     2. Select the desired source.
     3. The crosspoint executes.
   - **To operate in destination mode**
     4. Press **DEST** to put the panel into Destination mode.
     5. Select the desired destination.
     6. The crosspoint executes.

**Button Per Source Operation Mode Panel**

**Note:** Supported panels for Button Per Source mode: All Magellan Router Control Panels.

Select **Button Per Source** operation mode to assign individual sources and/or destinations to individual buttons.

To build a panel for Button Per Source operation mode, follow these steps:

1. Access the **Configurations** page. Select the **Panel Buttons** tab.
2. On the Panel Configuration list, there is a default **Button Per Source** configuration.
To use this template as the base configuration, duplicate the default configuration (see Duplicating an Existing Panel Configuration (on page 68)).

Alternatively, create a new configuration as described in Creating a New Panel Configuration (on page 62), and select Button Per Source as the panel operation mode.

3. See Detailed settings for Operation Mode Panels (on page 131) for how to modify panel buttons.

**Category/Index Mode**

**Use Case:** A user has a large database and wants to access sources/destinations in a traditional Category/Index operation. In this mode, buttons are assigned source/destination categories, and a numeric keypad is used to select a specific index.

- Panels with OLED display windows and pushbuttons are shipped out of the factory in this mode.
- Panels with an OLED display window and/or LCD buttons have a template that can be activated to use this mode. The user can also create custom templates.
- The panels’ web configuration tool allows the user to select which categories to use, where to map them on the buttons, and restrict specific sources/destinations within categories for selection.
- For panels with LCD buttons, in systems with large numbers of categories and indexes, the user can page up/down to access additional categories that can be displayed on the first page.

**Working with Categories**

With category indexing, both a category (for example, VTR, CAMERA, MONITOR, and so forth) and an index (for example, 20, 2, 36, and so forth) are needed to identify a device.

Category + index selection is a two-step, multikey operation that allows access to an unlimited number of sources and destinations. This method allows many sources to be accessed from a single panel without the need for hundreds of selection buttons. A broadcast center, for example, could contain twenty monitors, each of which could be accessed using the one button labeled “MONITOR” followed by the appropriate index number (20). Similarly, each of twenty cameras could be selected using only one button labeled “CAMERA” followed by the appropriate index number.

**Note:** To enable category-index operations, the logical database must be configured to allow categories (see Volume 6: Routing Components of the CCS Navigator User Guide) and the panel must be configured for category mode.

**To operate in category mode**

1. Make sure that the appropriate logical database is configured to allow categories.
2. Make sure that the panel is configured for category mode.

**Note:** By default, the panel operates in Source → Category mode. Press DEST to operate in Destination → Category mode.
The favorite source panel buttons (1) are shown and the category buttons (2) are highlighted. (If your panel includes an OLED, the mode, selected destination, and selected source are displayed.)

Figure 47: Category Mode Operation: Favorite Sources (1) and Categories (2)

3. Press the appropriate category button (1) to select the category name.
   The numeric keypad (2) is highlighted. (If your panel includes an OLED, the selected category is displayed in the Pst field.)

Figure 48: Category Mode Operation: Selecting a Category (1)

4. Press the appropriate numeric keypad button to select the first index character.
   The Take button flashes. (If your panel includes an OLED, the selected category and index displayed in the Pst field.)

Figure 49: Category Mode Operation: Selecting an Index

5. Press Take to accept the selection.

Category Operation Mode Panel

Supported panels for Group Operation Mode: Magellan Router Control Panel pushbutton with OLED and LCD with OLED panels

Select Category Mode operation mode to assign source/destination categories and select a specific index. To build a panel for Category operation mode, follow these steps:

1. Access the Configurations page. Select the Panel Buttons tab.
2. Select Category Mode from the Panel Operation Mode drop-down list box.
   - To use this template as the base configuration, duplicate the default configuration (see Duplicating an Existing Panel Configuration (on page 68)).
Alternatively, create a new configuration as described in Creating a New Panel Configuration (on page 62), and select **Category Mode** as the panel operation mode.

3. See Detailed settings for Operation Mode Panels (on page 131) for how to modify panel buttons.

**Group Mode**

**Use Case:** A user has a large database and wants to access sources/destinations in a group mode operation. In this mode, some buttons are assigned source/destination categories, when the user selects a category, the buttons remap to show the individual sources/destinations associated with that group. In addition, this mode allows the user to create hierarchical views of his routing system by creating "groups," which can then be assigned specific sources/destinations and salvos, and can be stored in multiple different groups.

- Panels with an OLED display window and/or LCD buttons are configured out of the factory in this mode. The user can also create custom templates.
- The panels’ web configuration tool allows the user to select which categories to use; where to map them on the buttons; and restrict specific sources, destinations, and salvos within categories for selection. In addition, the tool will also allow the user to build custom hierarchies (or "groups"), which allow the user to assign specific sources, destinations, and salvos to multiple groups.
- For panels with LCD buttons, in systems with large amounts of categories and indexes, the user can page up/down to access additional categories that can be displayed on the first page.
- For panels with LCD buttons, status is displayed on the Destination status buttons.
- For panels with an OLED display window and LCD buttons, status is displayed on the Destination status buttons and the OLED display window.

**Note:** In Group Mode, sources/destinations are listed on pressing the Src and Dst buttons. To see only source button groups, press Shift+SRC on the panel (on the control bank on the left). To see only destination button groups, press DST (on the control bank on the left).

**Working with Grouping**

Grouping is a form of category indexing that allows multiple sources and/or destinations to be grouped together to act as categories and indexes. When grouping is enabled, a series of tabs open to allow you to select grouping sources, destinations, and options; and provide a preview of how the final grouping LCD display appears as a result of your choices.

**Note:** To enable grouping operations, the logical database must be configured to allow grouping and the panel must be configured for grouping mode.

**To setup group mode**

1. Make sure that the appropriate logical database is configured to allow grouping (see **Volume 6: Routing Components** of the **CCS Navigator User Guide**).
2. Make sure that the panel is configured for group mode (see Group Operation Mode Panel on page 117).

Group Operation: Favorite Destinations (1) and Groups (2) shows an example of a Magellan Router Control Panel in group mode. The favorite destination panel buttons (1) are shown and the source
group buttons (2) are highlighted. The mode, selected destination, and selected source are displayed on the OLED.

![Figure 50: Group Operation: Favorite Destinations (1) and Groups (2)](image)

3. You may operate in source group mode or destination group mode.

**To operate in source group mode**

1. Press SRC to put the panel into Source mode.
2. Press the appropriate group button.
   - The associated sources and source subgroups are highlighted. If necessary, continue to press the group button until the desired source is displayed.
3. Select the desired source.
4. If a take is required for switches (see Changing Logical Control Options (on page 172))
   - The Take button flashes.
   - Press Take to accept the selection.
5. If a take is not required, the crosspoint executes.

**To operate in destination group mode**

1. Press DEST to put the panel into Destination mode.
2. Press the appropriate group button.
   - The associated destinations and destination subgroups are highlighted. If necessary, continue to press the group button until the desired destination is displayed.
3. If a take is required for switches (see Changing Logical Control Options (on page 172))
   - The Take button flashes.
   - Press Take to accept the selection.
4. If a take is not required, the crosspoint executes.

**Group Operation Mode Panel**

Supported panels for Group Operation Mode: **Magellan Router Control Panel LCD and LCD with OLED panels**

Select **Group Mode** operation mode to assign source/destination groups as defined in Navigator Database Editor. Before building a panel in group operation mode, ensure:

- Navigator 4.6.1 or later is installed.
- Groups are created in Navigator’s DBEditor.
- The DBEditor logical database is published to PT-RES.
To build a panel for Group operation mode, follow these steps:

1. Access the Configurations page. Select the Panel Buttons tab.
2. Select Group Mode from the Panel Operation Mode drop-down list box.
   - To use this template as the base configuration, duplicate the default configuration (see Duplicating an Existing Panel Configuration (on page 68)).
   - Alternatively, create a new configuration as described in Creating a New Panel Configuration (on page 62), and select Group Mode as the panel operation mode.
3. See Detailed settings for Operation Mode Panels (on page 131) for how to modify panel buttons.

Multibus Mode

Use Case: A user has a large database and wants to access sources in a traditional Category/Index operation, but only wants to control a limited number of destinations. In this mode, some buttons are assigned source categories, and a numeric keypad is used to select a specific index. Some buttons are assigned to select specific destinations.

- Panels with an OLED display window and/or LCD buttons have a template that can be activated to use this mode. Users can also create custom templates to use.
- The panels’ web configuration tool allows the user to select which categories to use, where to map them on the buttons, and restrict specific sources within categories for selection. The configuration tool will also allow the user to configure buttons to control specific destinations.
- For panels with LCD buttons, in systems with large numbers of categories and indexes, users can page up/down to access additional categories that can be displayed on the first page.
- For panels with an OLED display window and traditional pushbuttons, the current status of a selected destination is displayed in the window.
- For panels with LCD buttons, status is displayed on the Destination buttons.
- For panels with an OLED display window and LCD buttons, status is displayed on the Destination buttons and the OLED display window.

Group Mode with Multibus

Use Case: A user has a large database and wants to access sources in a group mode operation, but only wants to control a limited number of destinations. In this mode, some buttons are assigned source categories. When the user selects a source category, the buttons remap to show the individual sources associated with that group. Some buttons are assigned to select specific destinations. In addition, this mode allows the user to create hierarchical views of his routing system by creating "groups," which can be assigned specific sources and salvos, and can be stored in multiple different groups.

- Panels with an OLED display window and/or LCD buttons are configured out of the factory in this mode. Users can also create custom templates.
- The panels’ web configuration tool allows the user to select which categories to use, where to map them on the buttons, and restrict specific sources within categories for selection. The configuration tool will also allow the user to configure buttons to control specific destinations. In addition, the tool will also allow the user to build custom hierarchies (or "groups"), which allow the user to assign specific sources, destinations, and salvos to multiple groups.
For panels with LCD buttons, in systems with large amounts of categories and indexes, the user can page up/down to access additional categories that can be displayed on the first page.

For panels with LCD buttons, status is displayed on the Destination buttons.

For panels with an OLED display window and LCD buttons, status is displayed both on the Destination buttons and the OLED display window.

### Selenio Preset Mode Panel

Pushbutton only panels are not supported for Selenio Preset Mode.

**To build a panel for Selenio Preset Mode, follow these steps:**

1. Access the **Configurations** page.
2. Select the **Panel Buttons** tab.
3. Select **Selenio Preset Mode** from the **Panel Operation Mode** drop-down list box.
4. On the panel visual representation, click on the part of the panel you want to modify. The selected part of the panel is displayed under the expanded button view.
5. To edit the button type, follow the steps described in Editing Button Types (on page 181) (To edit a Selenio Preset button).

While button colors are preprogrammed out of the factory, users have the ability to modify them based on an individual button or for button types. To change the color of an individual or particular set of buttons, follow the steps as described in Editing Button Colors (on page 180).

Also see Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration (on page 103).

### Panel Configuration with non-Ethernet Routers (XY Coax Connection)

Magellan Router Control Panels support Navigator V4.6.1 or higher. Router Mapper or Navigator V4.6.0 and lower do not recognize Magellan Router Control Panels.

Magellan Router Control Panels can obtain the logical database (names.txt) from the router sever when connected to the router server via Ethernet.

For router control via XY coax connection, follow these instructions to create the routing database and manually configure it through the Magellan Router Control Panel Web UI.
Exporting the Database from RouterMapper

1. Open or create a routing database, update the logical names, then save the database.

2. From the Preferences menu, ensure Zero based Export is selected.
3. From the **File** menu, export the logical database to the local PC and save it as **Names.txt**.

4. Select the routing levels accordingly.
Exporting the Database from Navigator

1. Open the logical database under Control Views.

2. Edit and save the logical data, then export the data to text file.

Configuring the Magellan Router Control Panel

1. Configure Magellan Router Control Panel from the existing text file

2. Set up the Magellan Router Control Panel IP, Gateway, and Device ID from the front panel, or use the Web UI configuration tool. The default IP address is 192.168.100.250.

3. Open Internet Explorer or other supported web browser, and enter the Magellan Router Control Panel IP address in the address line. First time access will prompt for download of SilverLight software. Follow the link and proceed to download and install.

4. At the Windows login prompt, enter user as admin, password as harris.
5. IP address, panel ID, and other network settings can be modified on the **Summary** tab.

6. Go to the **Configuration** tab and click **New** to create a new configuration.

7. Provide a name for the configuration, select **Start from an Existing Logical Configuration File**, and open the **Names.txt** file exported from Router Mapper/Navigator DBEditor. Click **Next**.

8. Remove the **Primary Server IP** address by setting it to **0.0.0.0** since the panel does not use Ethernet connection with routers. Click **Finish** when done.
9. Select the new configuration in the Navigation pane, then go to the 
**Options** tab, and in **Communication** options, set **Connection to Router** to **Coax**.

![Router Configuration](image)

Save the configuration, disconnect the Ethernet cable, and connect the XY cable between the panel and the router.

---

**Router Configuration - Panel Functions**

**Panel Modes**

**Parameter Mode**

1. **In Source** mode, select a category.

   All category buttons are cleared and replaced with sources for the CAM category selection. Note that the OLED display is updated to show the selected category in the last row.

2. Select a source. The selected source button is highlighted and the **Take** button begins to flash red.

3. Press **Parm** to set the panel in Parameter mode. All of the buttons are cleared.
   - The top row of buttons displays the channel/level status of the current destination.
   - The bottom row of buttons display the available channels/level inputs of the selected source.
If a Source is not selected, the Destination’s current source is used.

4. Select a channel/level input and/or output. For multiple selections, use the Shift button.

5. Press Take to confirm the selection(s).
   The panel’s OLED display shows the available parameters for the selected input/output. To view more available parameters, turn the scroll knob clockwise.

6. Press the scroll knob to edit the selected parameter. Note that there will be a grayscale background color for the line that has the selected parameter.

7. The OLED display is updated to show the selected parameter and its current value. Use the numeric keypads or the scroll knob to enter a new value.

8. Press Take to confirm the new value.
   The panel sends out a parameter set request with the new value, and then the OLED display returns back to the main parameter menu.

9. To exit out of Parameter mode, press Shift + Home.

Press and hold down the Home button to return to the home menu where you can switch between the different configuration types (RTR, PROC. MV).

**History Mode**

1. Press Shift, and then press Menu.
   The Shift button is extinguished.

2. Press History.
   A list of previously executed crosspoints are displayed.
   - If the crosspoint was a breakaway, the top row of each button is the Destination, the middle row is the channel/level and the bottom row is the channel/level input.
   - If the crosspoint was not a breakaway, the top row legend is the destination and the second row is the source.

3. Press the desired crosspoint to be recalled.
   The selected History button is highlighted and the Take button begins to flash.

4. Press Take to recall the selected switch.
   The Take button is extinguished. If the destination affected is the current destination, the OLED display is updated accordingly and the panel returns to the "home" state.

**Breakaway Mode**

In Breakaway mode, audio and video signals do not automatically follow one another; audio and video are switched in separate operations.

**To operate in breakaway mode**

1. At the "home" control panel display, select the desired destination.

2. Press BRK.
   The control panel buttons display the levels associated with the destination.

Tip: Use the PG UP and PG DN buttons to display other level selections.
1. Select one or more levels. (You can select more than one level if desired)
   The selected Level button is highlighted and the Take button flashes.
2. When all desired levels are selected, press Take.
   The "home" control panel display is displayed again.
3. Select the breakaway source.
   The control panel buttons display the destination, its status (by levels) and the selected source (by levels). In addition, the Store button is highlighted.
   If you want to make multiple selections for breakaway, press Store after each selection. This action saves the selections until you are ready to perform a Take.
4. When you are finished making selections for breakaway, Press Take to execute the breakaway(s).

To exit Breakaway mode press Shift, and then press Home.

**Source Mode**

To select Source mode, do one of the following:
- Press SRC (Sources) on the front of the control panel
- Press Shift, and then press Menu on the front of the control panel.
  The panel clears the current selections and displays the Mode selection buttons.
  Press SRC.
  The panel returns to its "home" state (in Source mode), and the Source button and OLED display show the source with current status.

**Assigning a Source to a Button**

1. Switch to Source mode.
   The SRC button is highlighted and the OLED display updates its mode to Source selection. The category buttons are cleared out and replaced with Source categories. (The last two LCD buttons are reserved for the Store and Erase operations.)
2. Select a category button.
   Use the Shift button and scroll knob to view more available SVR sources.
3. Select a source.
   The selected Source button is highlighted and the Take button flashes red.
4. Press Store.
   The Store button is highlighted and Take button is extinguished.
5. Press the desired Source button where you want new source assigned.
   The Store button is extinguished, the category and source buttons return to their "home" state (in Source mode), and the Source button and OLED display show the new source with current status.
Selecting Sources

1. Switch to Source mode, and then select a category.
   a. All category buttons are cleared and replaced with sources for the CAM category selection.
   a. The OLED display updated to show the selected category in the last row

2. Select a source.
   a. The selected source button is highlighted
   b. The Take button flashes red.

Note: If you selected a wrong source, press Clear to go back to the category selection. The Take button is extinguished, any selections are cleared, and the panel’s buttons revert back to category selections.

3. Press Take to execute the switch.
   ▪ The Take button is extinguished.
   ▪ The panel is cleared and returns to the "home" state.
   ▪ The source status is updated for the selected Destination button and OLED display.
Switching Favorite Sources

**Note:** Favorite sources are source buttons that exist on category and group mode panels. Their assignment can be changed from the front panel.

1. Select a Destination.
2. Select the favorite source desired.
   The selected FAV source is highlighted and the **Take** button begins to flash red.
3. Press **Take**.
   The **Take** and **Favorite** buttons are extinguished, the **Destination** button status is updated, and the OLED display shows the new status.

Destination Mode

To select Destination mode, do one of the following:

- Press **DEST** (Destinations) on the front of the control panel.
- Press **Shift**, and then press **Menu** on the front of the control panel.
  The panel clears the current selections and displays the Mode selection buttons.
- Press **DEST**.

Assigning a Destination to a Button

1. Switch to Destination mode.
   The **DEST** button is highlighted and the OLED display updates its mode to Destination selection. The category buttons are cleared out and replaced with Destination categories. (The last two LCD buttons are reserved for the **Store** and **Erase** operations.)
2. Select a category button.
   Use the **Shift** button and scroll knob to view more available SVR destinations.
3. Select a destination.
   The selected **Destination** button is highlighted and the **Take** button flashes red.
4. Press **Store**.
   The **Store** button is highlighted and the **Take** button is extinguished.
5. Press the desired destination button where you want new destination assigned.
   The **Store** button is extinguished, the category and destination buttons return to their "home" state (in Source mode), and the **Destination** button and OLED display show the new destination with current status.

Selecting Destinations

1. Switch to Source mode, and then select a category.
   a. All category buttons are cleared and replaced with sources for the CAM category selection.
   b. The OLED display updated to show the selected category in the last row
2. Select a destination.
   a. The selected destination button is highlighted
   b. The **Take** button flashes red.
Note: If you selected a wrong source, press Clear to go back to the category selection. The Take button is extinguished, any selections are cleared, and the panel’s buttons revert back to category selections.

3. Press Take to execute the switch.
   a. The Take button is extinguished.
   b. The panel is cleared and returns to the "home" state.
   c. The source status is updated for the selected Destination button and OLED display.

Changing Destinations

1. Switch to Destination mode.
   The DEST button is highlighted and the OLED display updates its mode to Destination selection. The category buttons are cleared out and replaced with Destination categories. (The last two LCD buttons are reserved for the STORE and ERASE operation.)

2. Select a category button.
   Use the Shift button and scroll knob to view more available SVR destinations.

3. Select a destination.
   The selected Destination button is highlighted and the Take button flashes red.

4. Press Take to confirm the selection.
   The panel’s LCD buttons are cleared and returned to the "home" state and the OLED display is updated with the new destination selection and status.

Selection from Favorite Destination

Note: Favorite destinations are destination buttons that exist on category and group mode panels. Their assignment can be changed from the front panel.

1. Switch to Source mode, and then select a destination.

   a. The Destination button is highlighted.
   a. The OLED display is updated to show the current selected Destination and its source status.

2. Press Shift to make multiple Destination selections.
a. The **Shift** button is highlighted.

3. Select another **Destination** button.
   a. Both the new **Destination** button and previously selected **Destination** button are highlighted.
   b. The OLED display changes to show there is a multiple destination selection.

4. Press **Shift** again to turn off the multiple destination selection.
   The **Shift** button is extinguished.

5. Select a different **Destination** button.
   a. The newly selected Destination is highlighted.
   b. The previously selected Destinations are extinguished
   c. The OLED display is updated to show the current selected Destination and its source status.

**Locking a Destination**

**Tip:** You cannot lock a destination that does not have an associated source.

1. Switch to Source Mode, and then select a destination.
   The **Destination** button is highlighted.

2. Press **Shift**.
   The **Shift** button is illuminated.

3. Press **Lock**.
The **Lock** button is illuminated. If the panel has an OLED display, a lock icon appears next to the Destination display name.

**Unlocking a Destination**

Press the locked **Destination** button.

1. **Press Lock**.
   The **Lock** button is extinguished. If the panel has an OLED display, the lock icon no longer appears next to the Destination display name.

**Detailed Settings for Operation Mode Panels**

Once you've selected a panel operation mode, you can fine tune settings as follows:

1. On the panel visual representation, click on the part of the panel you want to modify. The selected part of the panel is displayed under the expanded button view.
2. By default, the buttons in the panel representation are displayed using the **Button Type**, which shows the type of button assigned. For example, Dst, Src, etc.
3. You can also choose to view the selection by **Actual Name** which shows current assignments of the buttons based on the logical database.

![](image)

**View:** Button Type & Actual Name

**Note:** You can change from the default **Button Type** to **Actual Name**, or leave the default as is, regardless, the **View** mode is saved in the configuration, and that View will be used if you import that configuration.

New Configurations take the default view (Button Type or Actual Name) from the **View** setting in the Configuration they are created based on. For new configurations not based on an existing configurations (blank configuration), the **View** mode will be the same as the **Active** configuration.

To select a specific button for editing, click on the desired button. It highlights with a yellow border. To select multiple buttons, hold the left mouse button down and drag over the buttons you want to select. Alternatively, you can use standard Windows selection procedures to select multiple buttons.

4. Click the **Edit Button Type** ribbon under **Properties** to reveal available assignable button types.
   To edit the button type, follow the steps as described in Editing Button Types (on page 181).
5. While button colors are preprogrammed out of the factory, users have the ability to modify them based on an individual button or for button types. To change the color of an individual or particular set of buttons, follow the steps as described in Editing Button Colors (on page 180).
6. Select the **Options** tab.

7. Under **Control Options**, you can choose whether this panel configuration will receive and display automatic updates to the logical router table (see Changing Logical Control Options on page 172).
   - If you are using the **Set Dynamic** option for buttons, use the **Dynamic Logical Ordering** drop-down list box selections to set this ordering based alphabetically, or based on the logical order that the database was created in (default).
   - For panels that support viewing the logical database by different fields, use the **Name to Use** drop-down list box selections to select the primary view you want for this configuration.

8. Under **Communications Options**, you can set the primary and secondary server IPs, as well as the protocol used to communicate with the router (see Changing Communication Options on page 170).

   **Note:** **IMPORTANT**: Logical (default) is the recommended method. This is currently supported only in systems with Platinum routers as the server. You must be running PT-RES code version 4.0 or later. For other systems, please select XY as the communications protocol.

9. Once all changes are made, click **Save**. The configuration is saved to the panel.
   - To activate a configuration on the panel, see Activating a Configuration (on page 163).
   - To copy a configuration to another panel, see Copying a Panel Configuration to Other Control Panels (on page 177). You can send all configurations or specific configurations to a single panel, a selected group of panels, or to a range of panels based on their IP addresses.

### Enabling and Disabling Panels

The panel **Enable** button is used to enable and disable the panel. If the **Enable** button is lit the panel is enabled. If the **Enable** button is not lit the panel is disabled.

When enabled, the panel operates normally. The destination select, source select, and destination lock buttons all function as described.

When disabled, a panel does not allow changing crosspoints, or destination locking/unlocking.

- Pressing the **Lock** button has no effect.
- Pressing a source selection button does not cause a crosspoint switch, but provides a source poll

A panel Enable **button** is set up as a **Function** button. See page 61 for more information.
Page Up/Down In Status Display

1. Turn the scroll knob clockwise to view the status of more levels of destination VTR 1. The OLED display updates the status for the selected destination for LEVELS 1 and LEVEL 2.

2. Turn the scroll knob clockwise again to view other levels. The OLED display shows the selected destination’s status for LEVEL 3 and LEVEL 4.

3. Turn the scroll knob counter-clockwise. The OLED display reverts back to the default view with large text for status.

---

Router Configuration - Button Functions

Support for Copy/Cut/Paste/Drag and Drop Button Assignments

Magellan Router Control Panel version 3.5 onwards supports copying and pasting of assignments across router buttons, as well as dragging and dropping.

This can be done within a configuration (same page, or different pages) as well as between different configurations of the same panel type. You can simply drag and drop to move assignments, or select one or more buttons and copy/cut using the function buttons or right click menus.
Note: This functionality is limited to copy/paste functions within the same Web UI instance. In case of ganged panels, copying/cutting and pasting router buttons can only be done between configurations of the same panel type.

Follow these steps to copy and paste:

1. Select the button with the router assignment or Shift/Control select multiple buttons
2. Click the Copy button if you want to copy, or the Cut button to cut (you can also right click and select Copy/Cut from the Popup menu)
3. Navigate to the target button(s)
4. Click on the Paste button or right click and select Paste from the Popup menu.

Notes

- **Insufficient buttons for Paste Operation**: If there aren't enough buttons to complete the copy/paste operation (particularly in case of multiple copy/paste), a message will be displayed. If one or more target buttons are not empty, a message will prompt for confirmation to overwrite the target button's existing assignment or to abort the current cut/copy/paste operation.

- **Undo/Redo Operations**: Since cutting/copying/pasting buttons between configurations may affect multiple configurations, undo/redo operations are not supported when copying/pasting button assignments among configurations.

- **Copying/Pasting across Operation Modes**: You cannot cut/copy/paste buttons not applicable to the current Panel Operation Mode, for instance, copying and pasting Group/Category buttons to the target configuration in "Button Per Source" mode.
• **Dynamic Buttons**: In case of pasting dynamic buttons (Source/Destination/Salvo/Group/Category), the button labels help distinguish dynamic buttons from static ones.

![](image)

### Pin/Unpin Functionality

Pin/unpin functionality allows you to pin static buttons to a configuration page, that apply to all existing pages and newly created pages in that configuration. To pin a button:

1. Right click a button in the panel representation and select **Pin** from the dropdown menu.

![](image)

Once you do this, the same button will be pinned in the same location on all current pages as well as on new pages you create in this configuration.

2. To unpin, right click and select **Unpin**.

![](image)
Notes:

- **Multiple pages**: When pinning a button, if there are multiple pages, a message alerts that the operation will replace the assignment of the current button (in the same position) on all other pages in the current configuration.
- **Changes to pinned buttons**: Once a button has been pinned, any changes to that button will apply to (the pinned button in) all pages in that configuration.
- **Unpinning buttons**: Unpinning a button retains the pinned button assignment in other pages in the configuration.
- **Empty buttons**: Empty buttons cannot be pinned.
- **Dynamic buttons**: Dynamic buttons cannot be pinned.
- **Multi-select ping/unpin**: You can select multiple buttons when pinning/unpinning, but if any of the buttons contains a dynamic button, a message will be displayed to confirm that the dynamic button will not be pinned/unpinned.

### Scrolling Dynamic Sources/Destinations

This feature allows you to traverse all the sources/destinations via dynamic buttons. On any page, press the **DST** or **SRC** function button and use the **PG UP** (page up) and **PG DN** (page down) buttons to scroll through all the sources and destinations in the database, both static and dynamic.

For example, consider you have a 2 page configuration with static buttons as well as dynamic buttons for sources and destinations on each page.

On the first page, press the **DST** function button on the panel - which then turns *orange* to indicate the panel is in **DST** mode. Press **PG DN** - the static buttons will not change but other destinations will be traversed in the location of the dynamic destination buttons.

The same is the case with dynamic sources where you press the **SRC** function button on the panel which then turns *green* to indicate the panel is in **SRC** mode. And then **PG DN** to traverse sources in the locations of the dynamic source buttons (with the static source and destination buttons unchanged).

**Note**: This functionality is only supported with Button Per Source mode, on panels with LCD, and in non ganged configurations.

### Previous/Next Buttons

This functionality is only supported in Category Mode.

In a Router configuration, **Previous** and **Next** are new Function buttons that simplify selecting sources/destinations in Category mode.

You can assign Previous and Next to function buttons, and with a fixed Category or Category+indices, pressing Previous/Next will take you to the previous or next index source/destination in that Category.

The following are some examples of how to use this functionality.

**Using Previous/Next to select Sources**
1. Create a **Router** configuration, **Category** Mode

2. Assign **Previous/Next** to function buttons

3. **Save** and **Activate** the Configuration

4. Press a **Source Category** button on the panel

5. Once you press a Category button, you will see the **Previous** and **Next** button lit

6. Press the **Previous** or **Next** Function button to go through sources in that Category

7. Press the **TAKE** button to switch the Source
Using Previous/Next to select Destinations

1. Create a Router configuration, Category Mode
2. Assign Previous/Next to function buttons
3. Save and Activate the Configuration
4. On the panel, press the DST function button to enter DST Mode.
5. Press a Destination Category button on the panel
6. Use Previous/Next to select a Destination in that Category
7. Press the TAKE button to select a Destination

Action on pressing TAKE

- If the After Take Go To option is set to Router Home, on pressing TAKE, the panel goes to the Router home location, Preset will be empty, Previous/Next becomes inactive
- If the After Take Go To option is set to Source, on pressing TAKE, the panel stays in Source mode
- If the After Take Go To is set to Destination, on pressing TAKE, the panel goes to Destination mode

<table>
<thead>
<tr>
<th>After Take Go to</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router Home</td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td></td>
</tr>
</tbody>
</table>

Router Configuration - Other Functions

Process Templates in a Router Configuration

- Process templates are only supported on LCD and LCD-OLED panels
- The TRAX page is available even if the current configuration doesn’t contain a Processing configuration, however the Assign TRAX button will be disabled if there is no Processing configuration
- The IP/Slot can be changed in the Processing tab after template assignment

To create a process template:
1. In a **Processing** configuration, right click a button and select **Export**

2. Save the file. Note that the file is saved to your local PC and not the panel.

3. Go to the **Router** tab, and click the **TRAX** tab

4. Select a source/destination to apply the template to. For example, click a source and then click the **Assign Template with IP** button on the right.

5. A window is displayed prompting you to select a template file. Select the previously saved file.

6. Go back to the **Processing** tab. The new template is applied to first empty button.
Dynamic Crosspoints

Dynamic Crosspoint is a button type that can be used in Router configurations. Dynamic crosspoints can be configured via the Web UI and edited via the panel. If a crosspoint is changed on the panel, you may be prompted to save if required (not in all cases).

Dynamic crosspoints are supported on LCD, LCD-OLED, and PB-OLED panel types. PB only panels are currently not supported. Category, Group, and Button Per Source Panel Operation Modes are supported. Panel Gang Configurations are not supported.

Dynamic crosspoints can be multi-selected using Shift so they can be executed in parallel. Their execution, in general, follows the same system as TAKES.

- Defining Dynamic Crosspoints from the Web UI (LCD/PB-OLED Panels) (on page 140)
- Dynamic Crosspoints - LCD Panels
- Dynamic Crosspoints - PB-OLED Panels (on page 143)

Defining Dynamic Crosspoints from the Web UI (LCD/PB-OLED Panels)

The process to define dynamic crosspoints from the Web UI is the same, regardless of the panel type (LCD or PB-OLED).

Select a button in the panel section and click Dynamic Crosspoint in the Button Type list to assign it. Select the source and destination from the Source and Destination lists or choose to leave one or both as unassigned.

There are two check boxes to the right of the Source/Destination selection. Empty SRC is checked by default and Empty Both is unchecked by default.
<table>
<thead>
<tr>
<th>Empty SRC</th>
<th>Empty Both</th>
<th>Result on executing crosspoint</th>
<th>Button Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unchecked</td>
<td>Unchecked</td>
<td>Destination and Source maintained</td>
<td>Original button colors are maintained</td>
</tr>
<tr>
<td>Checked</td>
<td>Unchecked</td>
<td>Source cleared</td>
<td>Button color changes to secondary button color (as defined via the Web UI)</td>
</tr>
<tr>
<td>Checked</td>
<td>Checked</td>
<td>Destination and Source cleared</td>
<td>Button color changes to secondary button color (as defined via the Web UI)</td>
</tr>
</tbody>
</table>

**Dynamic Crosspoints - LCD Panels**

On an LCD panel, buttons configured as dynamic crosspoint show a maximum of 2 lines of text, depending on whether source, destination, both, or neither have been defined.

**Table 16: Dynamic Crosspoint button displays**

<table>
<thead>
<tr>
<th>SRC/DST definition in button</th>
<th>Display on button on the panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button has both source and destination undefined</td>
<td>Shows on the panel as <strong>Unassigned</strong></td>
</tr>
<tr>
<td>Button has either source or destination defined</td>
<td>Panel displays the defined element: either <strong>DstX</strong> or <strong>SrcX</strong></td>
</tr>
<tr>
<td>Button has both source and destination defined</td>
<td>Panel displays <strong>DstX</strong> with <strong>SrcX</strong> below it (Default button color is green)</td>
</tr>
</tbody>
</table>
**Button Colors on the Panel**

For visual distinction, the default color of a dynamic crosspoint is different than a regular crosspoint.

- An **armed dynamic crosspoint button** (one that has both source and destination defined) is **light blue** and has both its source and destination displayed on it.
- A **disarmed dynamic crosspoint button** (one that has source and destination undefined or only one of source or destination defined) is **purple** in color, and either has Unassigned on it or the name of the selected source/destination.

**Note:** When a Dynamic crosspoint button is active in breakaway mode, the button color will be consistent with an active breakaway mode crosspoint button.

**Executing Dynamic Crosspoints from an LCD Panel**

1. Ensure the configuration with the dynamic crosspoints defined is active
2. Press the dynamic crosspoint button on the control button
   a. If the button has both source and destination already defined, TAKE will blink
   b. If the button does not have source and destination defined, you can select one or both, as required. If a destination has been assigned, source selection will be active. If a source has been assigned, destination selection will be active.

**Note:** When the button is selected, pressing the **DST** function key empties the destination and source assignments and enter the Destination Entry mode. Pressing the **SRC** function key empties the source assignment and enters into the Source Entry mode.

3. Click **Take** to execute the dynamic crosspoint.

Click the **Clear** button on the panel to go back.

**Note:** On LCD panels, when setting the Source/Destination for a dynamic crosspoint, Source/Destination selection is dependent on the configuration mode. For example, if the configuration is Category mode, Src and Dst selection for a dynamic crosspoint will be according to Category/Index. If the configuration is Group mode, Src and Dst selection for a dynamic crosspoint will according to Group.

Ensure the configuration with the dynamic crosspoints defined is active
1. Depending on whether you want to directly execute a crosspoint or if you want to select the Src and Dst:
   a. Click the Dynamic Crosspoint button on the panel to execute directly
   a. Hold down the button to select Source/Destination

2. If you choose to hold the button, it loads a page with Set Src and Set Dst buttons that can be selected by clicking on the, as well as Clear Src and Clear All buttons.

1. Click the Set Src button to see and select from a list of all available sources or click the Set Dest button to see and select from a list of all available destinations.

2. Click Take to execute the dynamic crosspoint.

Click the Clear button on the panel to go back.

**Note:** On LCD panels, when setting the Source/Destination for a dynamic crosspoint, Source/Destination selection is dependent on the configuration mode.

For example, if the configuration is Category mode, Src and Dst selection for a dynamic crosspoint will be according to Category/Index. If the configuration is Group mode, Src and Dst selection for a dynamic crosspoint will according to Group.

**Dynamic Crosspoints - PB-OLED Panels**

On a PB-OLED panel, all of the dynamic crosspoint information will be reflected in the OLED. The label for dynamic crosspoints on the panel is **DXPT**.

**Executing Dynamic Crosspoints from a PB-OLED Panel**

The execution of a dynamic crosspoint from a PB-OLED panel is similar to an LCD panel, except that you use the knob on the panel to go to the desired configuration. The mode of Set Dst or Set Src will be displayed on the OLED, you can select further options (source/destination selection) or do a TAKE. Category mode is supported for selecting a Dst/Src for a dynamic crosspoint on a PB-OLED panel. You need to manually define button colors and secondary colors for dynamic crosspoint buttons on PB-OLED panels.

Ensure the configuration with the dynamic crosspoints defined is active

1. Use the knob on the panel to go to the desired configuration. Depending on whether you want to directly execute a crosspoint or if you want to select the Src and Dst:
   a. Click the Dynamic Crosspoint button on the panel to execute directly
   a. Hold down the button to select Source/Destination
2. If you choose to hold the button, sources and destinations will be displayed on the OLED and can be selected.

**IMPORTANT:** Category Mode is not supported if you opt to select Sources/Destinations on a PB-OLED panel.

**TRAX Functionality**

TRAX functionality provides a means to directly launch a Processing (see Processing Configuration Overview) parameter. TRAX creates direct links or jumps to pre-assigned processing device controls. A device control window can be automatically opened when a specific source is routed to a specific destination.

TRAX is configured from the **Router** tab in a configuration, but needs a **Proc** configuration - an available/discovered device such as a 6800+ frame or module - in the **Proc** tab.

**Note:** PB-only panels do not support the TRAX feature.

**Configuring TRAX**

1. In your configuration, go to the **Processing** tab. Discover a device by doing the following:
   - Go to the **Favorites** tab. Click **Database Management**.
   - In the first column **IP Address**, click the **Add IP** button and enter the device IP.
   - Select the checkbox against the IP and click the **Discover** button. Click **Close** when done.
   - Ensure **Append checked item to Configuration** is selected and go to the **Panel buttons** tab. The **Current Configuration** in the left pane displays the navigation for the discovered device.

2. Go to the **Router** tab and click the **TRAX** menu - located between the **Local Aliases** and **Options** menu items.

3. Separate tabs will be displayed for **Sources** and **Destinations**. Click Sources or Destinations to expand the tab. From the Name column, click to select a Source or Destination. For example, Src 1.

4. In the left pane, in the **Current Configuration** pane, drill down to the element (frame, module, menu or parameter) to map.
5. Select the element and then click the **Apply** button in **Assign Trax** section in the Sources/Destinations tab.

6. The selected path will then get mapped and the TRAX Assignment column reflects the mapping against the selected Source or Destination. For example:

   **Name:** Src 1  
   **TRAX Assignment:** Root/Frame/Frame Type

   ![Figure 52: TRAX Assignment](image)

7. Save the Configuration.

   You can filter sources/destinations displayed through the filter text box at the top.  
   To remove an assignment, select it and then click the **Remove Selected** button under **Remove Trax.**  
   Click the **Remove All** button to clear all TRAX assignments.

   Once TRAX is defined, you can invoke it from the Magellan panel by activating that configuration, going to the Router tab, and clicking the button for the Source or Destination that TRAX was enabled and defined for.

### Invoking TRAX from the Panel

You can press Shift+Parm or hold down the SRC/DST button to trigger the TRAX.

In the Router configuration, hold down the Source or Destination button (depending on what TRAX was set up for), then select PARM > TRAX. You can also select and hold down a Source or Destination button, then select Shift and PARM on the panel to get the TRAX.

**Note:** Ensure the processing configuration is complete before adding TRAX. If any changes are made to the processing configuration after configuring TRAX, remove the TRAX and redefine.
Device Name

When you access a parameter in processing/TRAX, panels with OLED show the Custom Name of the device on the OLED screen.

The Custom Name of a device can be set through Magellan CCS Navigator. After discovering the device, right click it and select Configure. You can set the Custom Name in the Device tab of the Configuration dialog.

Note: The Custom Name only shows for parameters in processing/TRAX, and not for Frame/Device/Menu in Processing/TRAX.

TRAX Options

TRAX Options are displayed in the Options tab for a Router configuration. You can choose for TRAX to function manually, or in an Auto mode. Different configurations can have different TRAX defaults set up.

First, set up the mode. TRAX functions in:

- Manual Mode
- Auto Mode (Sources)
- Auto Mode (Destinations)
**Manual Mode**

If you select **Manual**, TRAX will rely on manual definitions and functions in a standard manner. See TRAX Functionality (on page 144).

**Auto TRAX SRC**

Selecting the **Auto TRAX SRC** option enables you to track specified destinations (When Source (SRC) TRAX is not assigned, the panel jumps back to the Processing root page.) and allows you to define matching criteria (**Auto TRAX DST** (on page 149)).

- When Source (SRC) TRAX is assigned, it auto jumps to the SRC TRAX top page.
- When Source (SRC) TRAX is not assigned, the panel jumps back to the Processing root page.

**DESTINATIONS IN AUTO TRAX SRC**

Click the **Select Destination** button for a list of destinations. Select a specific destination to track or scroll to the bottom of the list and select **Any Destination**.
MATCHING LEVELS IN AUTO TRAX SRC

Click the Matching Levels button to set the matching criteria for crosspoint status.

You can choose one of the following:

- **Source change must match all destination levels configured** - Auto TRAX will be triggered only if all levels of the selected destination have been changed to one Source.

- **Source change must match the levels specified** - Auto TRAX will be triggered only if all specified levels of the selected destination have been changed to one Source. If you choose this option, select the desired levels.

- Source change must match on the lowest destination level configured

- Source change must match on the highest destination level configured
**Auto TRAX DST**

Selecting the **Auto TRAX DST** option enables you to track specified sources and allow you to define matching criteria.

### SOURCES IN AUTO TRAX DST

Click the **Select Source** button for a list of sources.
Select a specific destination to track or scroll to the bottom of the list and select **Any Source**.

![Select Source](image)

### MATCHING LEVELS IN AUTO TRAX DST

Click the **Matching Levels** button to set the matching criteria for crosspoint status.

You can choose one of the following:

- Source change must match all destination levels configured
- Source change must match the levels specified
  - If you choose this option, select the desired levels
- Source change must match on the lowest destination level configured
- Source change must match on the highest destination level configured

![Matching Levels](image)
Routers in Tieline Mode - Handling ThreadFull messages

When two or more routers are configured with Tielines, the router sends out a ThreadFull message for TAKEs with source and destination in different routers.

A new ThreadFull function button can be added to your Magellan Router Control Panel configuration via the Web UI. When the Magellan Router Control Panel receives a ThreadFull message, the ThreadFull function key blinks 10 seconds. Note that only the current panel blinks. Other panels connected to the router also receive ThreadFull messages that are ignored.

During the 10 seconds, press any key to clear ThreadFull function key blinking. ThreadFull message will be displayed on the OLED for panels with OLED.

The Panel will timeout after 5 seconds when taking a switch, in which case the panel will not receive a "ThreadFull" message.

Configuring Clean and Quiet Switching for a Platinum™ VX Router

Configuring Clean and Quiet (CQS) for the Platinum VX router in the Magellan Router Control Panel UI involves specifying unique Clean/Quiet (CQ) pairs (with unique Programs and Destinations), mapping those to static Destination buttons, and then performing the switching.

Create a New Router Configuration

1. Go to the CQ DST sub tab
2. Add a **Clean/Quiet** pair by clicking the **Add Pair** button and adding Destinations in the **PGM** (Program) and **PVW** (Preview) dropdown lists.

3. Repeat to add as many CQ pairs as required.

**Notes while creating CQ Pairs**

- Ensure that CQ pairs are unique and **Program/Preview (PGM/PVM)** lists are unique too.
- You can remove a pair at any time by clicking the index of the pair and then clicking the **Remove Pair** button.
- Any conflicts will be indicated by the relevant item turning red. For example, if you use **DS 2** in two different pairs, it is no longer unique and will turn red.
- You will only be able to save when your configuration is free from conflicts.
Add Program Destinations to Static buttons

Next, you need to map the Program Destinations to static buttons. To do this:

1. Go to the Panel Buttons tab
2. Click an empty button
3. Set the Button Type to Destination and select the appropriate (Program) Destination
4. Note that the button icon will change to indicate that it is a Program Destination.

Add Preview Destinations to Static Buttons

You can also assign Preview Destinations to static buttons. This is completely optional and not required.

Save Configuration

Click Save to save the configuration and then click Activate.

Routing

To Route Sources to Preview Destinations

The process to route a Source to a Preview Destination is similar to routing to a normal destination.

1. On the panel, press the Preview Destination
2. Then press a Source.
3. The Take button will flash and on pressing TAKE (depending on the pane's Require TAKE for Switches setting in the Options page), the route will occur.

To Route Sources to Program Destinations
1. On the panel, press the Program Destination
2. Then press a Source.
3. The panel routes the Source to the Preview Destination associated with the Program Destination
4. The Take button will flash (regardless of the pane's Require TAKE for Switches setting in the Options page)
5. On pressing TAKE, the source (same the the current status of the Preview Destination) is routed to the Program destination

**Special Cases**

- After switching the Program (PGM) Destination, if you push another Source button instead of pressing TAKE, CQS activates and the panel sends a routing command to route the newly selected source to the PVM (Preview Destination) associated with selected PGM (Program Destination)
- If a Program Destination is selected with Required Take for Switch set to No, after a source is selected, the preset on the OLED or Status button will be the selected source (rather than empty).
- If a Chop button is selected, selecting a source will invoke the Chop procedure rather than switching the Program Destination.
- Clean and Quiet switching is not supported in multibus mode. If you multi select Program destinations and select a source, the destinations will switch to the source as usual.

If you select the source in **Category** mode, you need to press **TAKE** twice to finish the CQS procedure, by following these steps:

1. Push the Program Destination button
2. Select the **Source** in **Category** mode, **TAKE** will flash
3. After pressing **TAKE**, the panel sends a routing command to route the selected source to the PVM (Preview Destination) associated with selected PGM (Program Destination)
4. The **TAKE** key continues flashing
5. After pressing **TAKE** again, the panel sends a routing command to route the source.

---

**Report Levels**

A new Report Level feature allows you to define specific levels to status on, which is useful when switching across multi-level sources/destinations that don't necessarily have matching levels. This allows you to status on different levels for different destinations.

This feature also ensures when switching across multi-level sources/destinations, correct and updated status is displayed on panel buttons, considering the panel displays status of the lowest level by default.

Consider the following example (this example refers to functionality in Magellan Router Control Panel versions prior to 3.6):

- You have 2 sources
- Source 1 has an index associated on level 2
- Source 2 has index associated on levels 1 and 2
- Destination 1 has index associated on levels 1 and 2
- You switch Source 2 (2 levels) to Destination 1 (2 levels)
  - The panel correctly displays Dst 1 and Src 2 on the button
- Next you switch Source 1 (1 level) to Destination 1 (2 levels)
  - The panel still displays Dst 1 and Src 2.
  - This is because the default behavior of the panel is to display status of the lowest level.

The Report Level feature addresses this problem by allowing to define specific levels to status on.

**Defining Report Levels**
To configure/define levels to report, the **Router Configuration > Access Lists** tab displays a new column **BRK Report Level**. Depending on the Levels in your configuration, levels are available in the BRK Report Level drop down list. The levels in the drop down list are based on the Destination levels defined.

- You can individually click to define the level to report against each of the destinations
- You can also click the **All to Same Level** button to set all destinations to the same level

- You will be prompted to select the Report Level and all destinations will then be set to that report level
Use the Assign, Unassign, Assign All, Unassign All buttons to select/deselect/select all/deselect all.

Once configured, when the panel displays status on the LCD or OLED, the report level information is retrieved and displayed on the panel.

If user defined LEVEL buttons are created and activated, the lowest level of the active LEVEL button is used (instead of the Report Level) and statused.

Note that BRK Report Level is only supported in breakaway mode.
Multiviewer Configuration

**Note:** From Magellan 2.5 onwards, Multiviewer devices can also be discovered and mapped in a Processing configuration. The standalone Multiviewer tab has been maintained for backward compatibility.

The Multiviewer tab enables you to discover Multiviewer devices and map elements.

- Creating a Multiviewer Configuration (on page 156)
- Multiviewer Discovery (on page 157)
- Mapping buttons to Multiviewer Elements (on page 157)
- Invoking the Multiviewer (on page 159)

Also see:
Multiviewer Configuration for Pushbutton (PB) Only Panels (on page 160)

---

Creating a Multiviewer Configuration

1. Follow the initial steps in Creating a New Panel Configuration (on page 62).
2. Then go to the Multiviewer tab. You have 2 options here:
   - Create New Multiviewer Configuration
   - Import Multiviewer Configuration

---

Create New Multiviewer Configuration

Click the Add Multiviewer Configuration to this Panel Configuration button in the Processing tab.
Import Multiviewer Configuration

Click the **Import Multiviewer Configuration to this Panel Configuration** button in the Processing tab to import a configuration from the panel itself, or from a file.

When you click the **Import Multiviewer** button, only those configurations that contain a Processing configuration will be displayed for import, and other types (for example, a Processing *only* configuration) will be filtered out.

When importing into a **Multiviewer** tab that has no current configuration, the new configuration is imported in, and a status message displayed on successful import. Also see Importing a Configuration into an Existing Configuration (on page 69).

Multiviewer Discovery

In an **Multiviewer** configuration type, the **Panel Buttons** tab displays an interface to help discover Multiviewer devices and map elements.

1. In your configuration, go to the **Multiviewer** tab and then click **Panel Buttons**.
2. Select the type of Multiviewer device to discover under **Multiviewer Device Mode**.
   - Platinum SX Hybrid/ IP (See Mapping Platinum SX Hybrid/IP (on page 158))
   - Platinum SX Pro 16 (See Mapping Platinum SX Pro (on page 157))
   - Platinum SX Pro 32/64 (See Mapping Platinum SX Pro (on page 157))
   - Selenio 6800+ Multiviewer/Platinum Predator II (See Mapping Selenio 6800+/Platinum Predator II (on page 159))

3. Enter the **IP address** of the Multiviewer Device. Click the **Find** button

On selecting the Multiviewer Type and providing a valid IP address, a multiviewer template is loaded, consisting of buttons for display devices or PIPs. If you do not provide an IP address, the template is not loaded. If you provide an incorrect or offline IP address or if there is a mismatch between the device type selected and the actual IP address provided, a warning message is displayed.

Mapping buttons to Multiviewer Elements

Mapping Platinum SX Pro

Once you discover a Platinum SX Pro device, the Button View displays six buttons for six display devices:

- Display 1
- Display 2
- Display 3
- Display 4
• Display 5
• Display 6

Figure 53: Platinum SX Pro configuration

Click any of the displays on the panel to see the following options
• **Recall Layout**: Select to change the active layout for this display
• **FullScreen Recall**: Select a PIP to put into full screen mode for this display
• **Stereo Pair**: Select the audio pair to output on the audio output monitor
• **PIP Source**: Select the Platinum source and level to route to the selected PIP
• **Timer Control**: Select to control the selected Timer

**Mapping Platinum SX Hybrid/IP**

Once you discover a Platinum SX Hybrid or IP device, the Button View displays four buttons for four display devices:
• Display 1
• Display 2
• Display 3
Display 4

Figure 54: Platinum SX Hybrid configuration

Mapping Selenio 6800+/Platinum Predator II

Once you discover a Selenio 6800+ device, the Button View displays buttons mapped to PIPs on the device.

Invoking the Multiviewer

You can now invoke the Multiviewer by doing the following:

1. Press the defined Multiviewer button on the panel.
2. You will see buttons mapped to the available options. For instance:
   - If you configured a Platinum SX Pro device, you will see 6 buttons for Display 1 to 6.
   - If you configured a Platinum SX IP device, you will see 4 buttons for System 1-4.
3. Press the desired button to drill down to lower level options.
Multiviewer Configuration for Pushbutton (PB) Only Panels

Creating a Multiviewer Configuration on PB Only Panels

1. Create a new panel configuration. Follow the steps in Creating a New Panel Configuration (on page 62)
2. Go to the Multiviewer tab and click the Create Multiviewer configuration button
3. Select the Multiviewer device type, input the IP address and click Find.
4. Select the programmable push button block and select a push button; you can then define the following button types:
   - ActiveLayout
   - FullScreen
   - Page
   - Function
   - Empty

The naming convention followed on the button label is:
D+display#-AL-selected Layout" or "D+display#-FS- selected PIP

PB Only Panels - Notes

- A maximum of 2 pages can be created on a PB panel
- There are 5 options for the function button type
  - RouterHome
  - ProcHome
  - MV Home
  - Enable
  - Empty
- Processing configurations are not supported by PB only panels. MV only and Router only configurations can be created
- Attempting to re-select or re-find the MV device type will result in all currently defined active layouts/full screen/page/functions being removed
# Common Configuration Tasks

Common configuration tasks include the following and may be performed when first setting up a panel or when defining or editing configurations.

## Common Panel Configuration Tasks

<table>
<thead>
<tr>
<th>PANEL SPECIFIC TASKS</th>
<th>CONFIGURATION TASKS</th>
<th>BUTTON/APPEARANCE OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Finding Panel-Specific Information (on page 192)</td>
<td>• Activating a Configuration (on page 163)</td>
<td>• Changing Appearance Options (on page 166)</td>
</tr>
<tr>
<td>• Changing Panel Physical Settings (on page 175)</td>
<td>• Saving a Configuration (on page 196)</td>
<td>• Changing Button Properties (on page 167)</td>
</tr>
<tr>
<td>• Identifying a Panel (on page 193)</td>
<td>• Batch Exporting and Importing Configurations (on page 164)</td>
<td>• Changing Button Text Appearance (on page 167)</td>
</tr>
<tr>
<td>• Restarting a Panel (on page 196)</td>
<td>• Copying a Panel Configuration to Other Control Panels (on page 177)</td>
<td>• Changing OLED Text Appearance (on page 174)</td>
</tr>
<tr>
<td>• Restoring Panel Defaults (on page 196)</td>
<td>• Deleting a Panel Configuration (on page 180)</td>
<td>• Fonts based on Configuration (on page 191)</td>
</tr>
<tr>
<td>• Selecting Panel Operation Modes (on page 196)</td>
<td>• Duplicating a Panel Configuration (on page 180)</td>
<td>• When all changes have been made, save the configuration.</td>
</tr>
<tr>
<td>• Setting the Panel License ID (on page 197)</td>
<td>• Exporting Configurations (on page 190)</td>
<td>Changing Panel Brightness</td>
</tr>
<tr>
<td>• Setting Screensaver Options (on page 197)</td>
<td>• Importing Configurations (on page 193)</td>
<td>• Adjusting Default Button Colors (on page 164)</td>
</tr>
<tr>
<td>• Upgrading Multiple Panels (on page 201)</td>
<td>• Reloading Configurations (on page 195)</td>
<td>• Editing Button Colors (on page 180)</td>
</tr>
<tr>
<td>• Upgrading Panel Firmware (on page 201)</td>
<td>• Using the Offline Configuration Editor (on page 202)</td>
<td>• Editing Button Types (on page 181)</td>
</tr>
<tr>
<td></td>
<td>• Creating Custom Pages (on page 178)</td>
<td>• Generating Button Labels (on page 192)</td>
</tr>
</tbody>
</table>

## ROUTER CONFIG TASKS

<table>
<thead>
<tr>
<th>COMMUNICATION/SUPPORT OPTIONS</th>
</tr>
</thead>
</table>

© 2015 Imagine Communications Corp. Proprietary and Confidential. Version 3.6 | Page 161
### PANEL SPECIFIC TASKS

- Changing Access Lists (Router) (on page 166)
- Changing Source Assignments (on page 176)
- Changing Destination Assignments (on page 170)
- Changing Salvo Assignments (on page 175)
- Changing Level Assignments (on page 172)
- Changing Category Assignments (on page 169)
- Changing Index Assignments (on page 171)
- Setting Up Local Aliases (on page 198)
- Removing Local Aliases (on page 195)
- Removing Local Aliases (on page 195)
- Primary and Secondary Server IPs (on page 194)
- Synchronizing Database structure from another Router (on page 200)
- Show/Hide Status on Destination buttons (on page 198)

### CONFIGURATION TASKS

- Changing Communication Options (on page 170)
- Changing Logical Control Options (on page 172)
- Enabling or Disabling USB Port Functions (on page 189)
- Installing and Removing Fonts (on page 194)
- Enabling User Access (on page 189)
- Accessing Error Logs (on page 162)
- Accessing the Imagine Communication Website (see "Accessing the Imagine Communications Website" on page 163)
- Accessing the Imagine Communications Service Web Portal (on page 163)
- Generating Service Reports (on page 193)
- Defining Alarm Conditions (on page 180)

### BUTTON/APPEARANCE OPTIONS

- Changing Communication Options (on page 170)
- Changing Logical Control Options (on page 172)
- Enabling or Disabling USB Port Functions (on page 189)
- Installing and Removing Fonts (on page 194)
- Enabling User Access (on page 189)
- Accessing Error Logs (on page 162)

---

### Accessing Error Logs

1. Access the **Support** page.
2. Click the **View Panel Logs** button.
Accessing the Imagine Communications Website

1. Access the Support page.
2. Click the Imagine Communications Homepage hyperlink.

Accessing the Imagine Communications Service Web Portal

1. Access the Support page.
2. Click the Imagine Communications Support Page hyperlink.

Activating a Configuration

1. Access the Configurations page.
   In the Regular tab, Panel Configurations list, the currently active configuration has a star icon displayed to the right of the name.
2. Select the configuration to make active.
3. Click the Activate button.

On clicking the Activate button, a message box displays the activation status until the selected configuration is loaded and active.

Note: OLED panels also show the configuration activation status message on the OLED itself.
LCD Panels without OLED

In case of panels without OLED, the first LCD button displays the configuration activation status message. For example, when loading a configuration, you will see a the "Loading..." message on the first button of an LCD panel without OLED.

---

Adjusting Default Button Colors

**Note:** See Editing Button Colors (on page 180) for more information on changing an individual button’s color.

1. Access the Configurations page
2. Go to any of the Configuration tabs (Router, Processing, or Multiviewer) and select the Options tab.
3. In the Appearance Options section, click the Adjust Default Colors icon. A list showing the default button colors for different elements is displayed.
   For example, in a Processing configuration, you will see the Frame default color.
   And in a Router configuration, you will see the Source/Destination default color.
4. Click the drop-down arrow to the right of the button type you want to change and choose the color swatch. The complete button color selection list is displayed. (The factory default option appears as a blank selection.)
5. The button color changes for all buttons assigned with that particular button type.
   **Note:** Modifying an individual button or set of buttons overrides the default settings.
6. When all changes have been made, save the configuration.

---

Batch Exporting and Importing Configurations

You can import individual configurations into the Configurations tab using the Import or Export functionality. See Importing Configurations (on page 193) and Exporting Configurations (on page 190)

The Batch Import/Export functionality enables you to batch export configurations from a panel and batch import them to another panel.

The interface to import/export configurations requires you to input the IP Address(es) of the source or destination panel(s) depending on whether you’re exporting or importing configurations. This functionality does not require you to work off the Web UI of the specific panel you want to export from or import to. You can use the Web UI on any panel and do the following:

1. Discover the Source panel(s) to export from
   - Export selected configuration(s) from the source panel to file (XML)
2. Discover the Destination panel(s) to import to
   - Import the exported configuration(s) XML file
The only requirement is that the panels you are exporting to/importing from should both be running firmware version 3.5 or higher, and both panels should be of the same type.

**Batch Exporting Configurations**

Go to the **Tools** tab and click the **Batch Export** button

1. Input the **IP address** of the panel to export configurations from and click the **Discover** button.
2. Once discovered, the following information is populated:
   - Panel IP: The IP Address of the Panel
   - Panel Type: The Type of Panel
   - **Configuration Name**: A list of configurations from the panel

3. Select Configurations to export from the list displayed on the right and then click the **Create Export File** option under the **Export File** column.

4. Click **OK** on the popup message box, and either accept the default, or enter a filename and choose a location to save the XML file.

   Each configuration is saved as an XML file in the following format:
   `<Panel IP Address> <Panel Type>.xml`
   For example, **192.168.25.245 RCP-32PB-OLED.xml**

5. Click the **Export** button. The selected configurations are then saved to that file and can be imported on another panel.
Note that you can discover several panels in the same Export Batch Configurations UI. Configurations to export and an XML file to export to must be selected per panel. Errors, if any, are indicated in the **Ready** Column.

**Batch Importing Configurations**

Go to the **Tools** tab and click the **Batch Import** button

1. Input the **IP address** of the panel to import configurations from and click the **Discover** button.
2. Once discovered, double click the **Select Import File** option under the **Import File** column
3. Browse to the location of the exported XML file and click to select it
4. Click the **Import** button. The selected configurations are then imported to that panel.

**Changing Access Lists (Router)**

1. Access the **Configurations** page.
2. In the **Router** configuration tab, select the **Access Lists** tab.
3. Select one of the ribbons displayed to change the current assignments for sources, destinations, salvos, levels, categories, or indexes, and make changes as described in the appropriate sections:
   - Changing Source Assignments (on page 176)
   - Changing Destination Assignments (on page 170)
   - Changing Salvo Assignments (on page 175)
   - Changing Level Assignments (on page 172)
   - Changing Category Assignments (on page 169)
   - Changing Index Assignments (on page 171)

**Changing Appearance Options**

1. Access the **Configurations** page.
2. Go to any of the Configuration tabs (Router, Processing, or Multiviewer) and select the **Options** tab. Appearance options are listed on the bottom right of the tab.
3. Select one of the choices displayed to change the current assignments for font types and sizes, panel brightness, and default button colors, and make changes as described in the appropriate sections:
   - Changing Button Text Appearance (on page 167)
   - Changing OLED Text Appearance (on page 174)
   - When all changes have been made, save the configuration.
   - Adjusting Default Button Colors (on page 164)

---

### Changing Button Properties

**Note:** For information on how to change the default button color scheme for source, destination, salvo, group, or category buttons, see Adjusting Default Button Colors (on page 164).

*For information on how to change an LCD button’s text font type and size, see Changing Button Text Appearance (on page 167).*

1. Access the Configurations page.
2. Select the Panel Buttons tab.
   - At the top of the tab is a picture of the type of panel to which this configuration is assigned. Notice that a yellow box surrounds the programmable keys on the front panel. There is an expanded view of those buttons under the Button View section in the middle of the page. You cannot select individual buttons within the yellow box, but you can select individual buttons in the expanded view. You may switch between the operation keys and the programmable keys on the panel picture.
   - When the **Button Type** radio button is selected, names on the buttons change to indicate what type of buttons they are.
   - When the **Actual Name** radio button is selected, names on the buttons change to indicate close approximations of the actual panel button assigned names.
3. After selecting the button or buttons you wish to edit, you can change the properties of that selected button as described in the following sections:
   - Editing Button Colors (on page 180)
   - Editing Button Types (on page 181)

---

### Changing Button Text Appearance

The text layout on buttons can be set "globally" as well as "locally" for specific buttons. You can control the number of rows of text to display on the button, as well the front size.

**Global Button Text Settings**

The global setting is defined in the Configurations tab > Options > Appearance Options > LCD Text Layout
**Note:** All newly created buttons use the Global settings (defined in the Options tab). Changing the global setting will not affect or override any locally defined settings.

1. Access the Configurations page. Go to the Router/Processing+/Multiviewer tabs.
2. Select the Options sub tab.
3. Click the arrow to the right of the LCD Buttons Font drop-down list box.
   A list of the currently available font types is displayed.
4. Scroll through the list, and then select the desired display font.
   The selected font name is displayed in the list box.

5. In the number spin box, enter the point size to be used for the display font (72 points equals 1 inch).
6. In the LCD Text Layout drop-down box, select the desired number of text rows to be displayed. Keep in mind that using fewer lines of text allows using a larger font size. You can select from 1 Row of Text up to 4 Rows to Text.

7. When all changes have been made, save the configuration.
Local Button Text Settings

There may be instances where you need to customize the text settings on a per button basis. For example, if you choose to set the layout to just 1 line of text, it’s possible that some buttons won’t display text completely. To address this, you also have the option of setting the text layout on a specific button.

Local settings can be defined for buttons in **Router** and **Processing** configurations, in the **Panel Buttons** tab. You can define buttons settings locally by clicking a button and then making changes in the **Button Appearance** section on the right.

**Note:** Local button settings (defined in the Button Appearance section) override global settings. But changes to the global setting will not affect already defined local settings. For example, if you set **LCD Buttons Font** to **12** in the **Options** tab, then set a specific button’s font to **16** in the Button Appearance tab, and then go back and change the global setting to font size **14**, the button with the locally defined font size **16** will retain its font size.

Changing Category Assignments

1. Access the **Configurations** page.
2. Select the **Access Lists** tab.
3. Select the **Categories** ribbon.
   
   A list of currently assigned categories opens.

   At the top of the assigned categories list is a filter box. The filter allows you to narrow the list of assigned categories to a defined criterion (for example, different criteria could be entries that start with "S," "SD," or "SU"). If desired, enter a filtering criterion in the filter box.
Categories are sorted in Logical order (the order in which the categories were first assigned in the Navigator Database Editor). If desired, click the Sort:<order type> button to select a different sort method.

4. Select or clear the appropriate check boxes to select/deselect the assigned categories; or, highlight the category name, and then click the Assign or Unassign button as appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed destinations.)

5. When all changes have been made, save the configuration.

---

### Changing Communication Options

1. Access the Configurations page.
2. Select the Options tab. Communication Options are listed at the top right side.
3. Select the Connection to Router as Ethernet or Coax.
4. To change the primary server IP address, enter the appropriate IP address in the Primary Server IP text box.
5. To change the secondary server IP address, enter the appropriate IP address in the Secondary Server IP text box.

*Note:* The primary and secondary server IP that is set here is used when you switch between servers using the Toggle Server button in the Current Configuration section of the Summary tab.

6. To change the communication protocol method for connecting to the primary and/or secondary server, click the arrow on the drop-down Preferred Comm Protocol list box
   - Select LRC to enable Logical Router Protocol
   - Select XY to enable X-Y protocol

*Note:* If select Connection to Router as Coax and Comm Protocol as XY, provide the IP Address of the XY Server device in the XY Server IP text box.

7. When all changes have been made, save the configuration.

---

### Changing Destination Assignments

1. Access the Configurations page.
2. Select the Access Lists tab.
3. Select the Destinations ribbon.
   
   A list of currently assigned destinations opens.
   
   At the top of the assigned destinations list is a filter box. The filter allows you to narrow the list of available destinations to a defined criterion (for example, different criteria could be entries that start with "S," "SD," or "SU"). If desired, enter a filtering criterion in the filter box.
   
   Destinations are sorted in Logical order (the order in which the destinations were first assigned). If desired, click the Sort:<order type> button to select a different sort method.

4. Click/unclick the appropriate check boxes to select/deselect the assigned destinations for panel availability; or, highlight the destination name, and then click the Assign or Unassign button as
appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed destinations.)

5. When all changes have been made, save the configuration.

**Note:** From version 3.5 onwards, the Destinations Access List page displays a column for each level and shows level indices for each destination.

---

### Changing Index Assignments

1. Access the **Configurations** page.
2. Select the **Access Lists** tab.
3. Select the **Indices** ribbon.

   A list of currently assigned indices opens.

   At the top of the assigned indices list is a filter box. The filter allows you to narrow the list of assigned indices to a defined criterion (for example, different criteria could be entries that start with "A," "1," or "99"). If desired, enter a filtering criterion in the filter box.

   Indices are sorted in Logical order (the order in which the levels were first assigned). If desired, click the **Sort:**<order type> button to select a different sort method.
4. Click/unclick the appropriate check boxes to select/deselect the assigned indices; or, highlight the index name, and then click the Assign or Unassign button as appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed levels.)

5. When all changes have been made, save the configuration.

---

**Changing Level Assignments**

1. Access the Configurations page.
2. Select the Access Lists tab.
3. Select the Levels ribbon.
   A list of currently assigned levels opens.
   At the top of the assigned levels list is a filter box. The filter allows you to narrow the list of assigned levels to a defined criterion (for example, different criteria could be entries that start with "A," "AS," or "G"). If desired, enter a filtering criterion in the filter box
   Levels are sorted in Logical order (the order in which the levels were first assigned). If desired, click the Sort:<order type> button to select a different sort method.
4. Click/unclick the appropriate check boxes to select/deselect the assigned levels; or, highlight the level name, and then click the Assign or Unassign button as appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed levels.)
5. When all changes have been made, save the configuration.

---

**Changing Logical Control Options**

The control options section refers to the relationship between the router configuration logical settings made via Navigator Database Editor and the active panel configuration.

1. Access the Configurations page.
2. Select the Options tab. Control options are listed on the left side of the tab.

**Table 17: Control Option Selections**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign &lt;Control&gt; where &lt;Control&gt; options are Sources, Destinations, Groups, Salvos, Categories, Indices, Levels</td>
<td>Set to Yes or No to enable or disable the capability to make a newly added Database Editor item accessible on the panel.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name To Use</td>
<td>Selection of the appropriate field to display logical names from Database Editor (see Logical Name Locations in Database Editor for the location of logical names on a Database Editor tab)</td>
</tr>
<tr>
<td></td>
<td>• Name: the status name in the Database Editor</td>
</tr>
<tr>
<td></td>
<td>• Alias Name: an alias that was created either globally in the Database Editor, or a local alias created specifically for that panel</td>
</tr>
<tr>
<td></td>
<td>• Long Name: taken from the long name field in the Database Editor; unicode names are assigned with this field</td>
</tr>
<tr>
<td>Hierarchy Levels</td>
<td>Enables the hierarchy levels (<a href="#">Full Hierarchy, Lowest Level of Hierarchy, Two Levels, Three Levels</a>) to show when a breakaway operation is performed</td>
</tr>
<tr>
<td>Dynamic Logical Ordering</td>
<td>Enables the order in which dynamic buttons are filled</td>
</tr>
<tr>
<td></td>
<td>• Logical: the order in which the data were first assigned</td>
</tr>
<tr>
<td></td>
<td>• Alphabetical: Data name A to Z order</td>
</tr>
<tr>
<td>Require Take for Switches</td>
<td>Enables the requirement that a user must press the Take button to perform logical switches (button per switch and grouping modes only)</td>
</tr>
<tr>
<td>Show Destination Status</td>
<td>See Show/Hide Status on Destination buttons (on page 198)</td>
</tr>
<tr>
<td>Allow Panel Parametric Control</td>
<td>Allows parametric control</td>
</tr>
<tr>
<td>Allow History Mode</td>
<td>Allows users to recall previously executed crosspoint takes from panel’s switch log.</td>
</tr>
<tr>
<td>Allow Hold Shortcut Menu</td>
<td>Enables the use of this mode in the selected configuration</td>
</tr>
</tbody>
</table>

**Figure 55: Logical Name Locations in Database Editor**

3. Select the desired control options as shown in each drop-down list box.
4. When all changes have been made, save the configuration.
Changing OLED Text Appearance

Figure 56: Panel Window Type Locations

1. Access the Configurations page.
2. Select the Options tab.
3. Click the arrow to the right of the Panel Window Large Font drop-down list box.
   A list of the currently available font types is displayed.
4. Scroll through the list, and then select the desired display font.
   The selected font name is displayed in the list box.
   If the desired font is not displayed in the list box, you may add it to the fonts list. See Installing and Removing Fonts (on page 194).
5. In the number spin box, enter the point size to be used for the display font (72 points equals 1 inch).
6. Click the arrow to the right of the Panel Window Small Font drop-down list box.
   A list of the currently available font types is displayed.
7. Scroll through the list, and then select the desired display font.
   The selected font name is displayed in the list box.
8. In the number spin box, enter the point size to be used for the display font (72 points equals 1 inch).
9. When all changes have been made, save the configuration.

Changing Panel Brightness

10. Access the Configurations page.
11. Select the Options tab.
12. Move Panel Brightness slider control left or right until you reach the desired brightness level.
13. When all changes have been made, save the configuration.

Changing Panel Options

You can make the following changes from here:

- **Screen Save Enable**- Select Yes/No to enable/disable the screensaver.
- **Wait Time (minutes)**- Define the screen saver activation time period in minutes.
- **Cycle Time (seconds)**- Define the screen saver cycle time in seconds
• Allow to be ganged - Define if this panel can be part of a ganged configuration.
• **New config save to** - Define whether to save new configurations to the panel or to USB.

**Note:** You can increase the available flash on the Panel by inserting a USB into the panel and opting to save new configurations to USB.

---

## Changing Panel Physical Settings

1. Access the **Summary** page.
2. The user-configurable selections are available; non-configurable selections are grayed out. Click the **Edit** button to enable options, and click **Save** when finished.
3. The following is displayed here:
   - **Panel Type** - The current Panel Type is displayed. Cannot be changed. You can click the Identify button to make the physical panel blink for easy visual identification.
   - **Panel Name** - The current Panel Name is displayed. Enter a new name to change the existing panel name.
   - **Panel ID** - Enter a new ID to change the existing panel ID.
   - **IP Address** - The IP Address can be changed as required.
   - **Netmask** - The Netmask can be changed as required.
   - **Gateway** - The Gateway can be changed as required.
   - **MAC** - The MAC Address is displayed but cannot be changed.
   - **System Cache** - The current system cache utilization is displayed and can be changed by clicking the **Increase Cache** button. You will then get a popup message indicating the requested cache size. Click **Yes** to accept or **No** to cancel.
   - **Flash Used** - This shows the percentage of flash used on the panel.

The changes are saved and displayed on-screen. Click **Cancel Settings** to discard changes without saving them.

**Note:** It is recommended you close and reopen the browser after updating the cache.

---

## Changing Salvo Assignments

1. Access the **Configurations** page.
2. Select the **Access Lists** tab.
3. Select the **Salvos** ribbon.
   A list of currently assigned salvos opens.
   At the top of the assigned salvos list is a filter box. The filter allows you to narrow the list of assigned salvos to a defined criterion (for example, different criteria could be entries that start with "A," "AS," or "G"). If desired, enter a filtering criterion in the filter box.
   Salvos are sorted in Logical order (the order in which the salvos were first assigned). If desired, click the **Sort:<order type>** button to select a different sort method.
4. Click/unclick the appropriate check boxes to select/deselect the assigned salvos; or, highlight the salvos name, and then click the Assign or Unassign button as appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed salvos.)

5. When all changes have been made, save the configuration.

---

**Changing Source Assignments**

1. Access the Configurations page.
2. Select the Access Lists tab.
3. Select the Sources ribbon.
   
   A list of currently assigned sources opens.

   At the top of the assigned sources list is a filter box. The filter allows you to narrow the list of assigned sources to a defined criterion (for example, different criteria could be entries that start with "S," "SD," or "SU"). If desired, enter a filtering criterion in the filter box.

   Sources are sorted in Logical order (the order in which the destinations were first assigned). If desired, click the Sort:<order type> button to select a different sort method.

4. Click/unclick the appropriate check boxes to select/deselect the assigned sources; or, highlight the source name, and then click the Assign or Unassign button as appropriate. (Click the Assign All or Unassign All button to select/deselect all of the listed sources.)

5. When all changes have been made, save the configuration.
Note: From version 3.5 onwards, the Sources Access List page displays a column for each level and shows level indices for each source.

Copying a Panel Configuration to Other Control Panels

Note: Currently a configuration can only be copied to a panel of the same type. Before copying the configuration, a check is run internally to ensure the source panel connection type matches the destination panel(s), for example, COAX to COAX. In case of any mismatches, appropriate messages are displayed so corrective action can be taken.

Tip: This function is different from the Duplicating function. The Copying function copies a configuration to another panel, whereas the Duplicating function copies one configuration to another configuration.

1. Access the Tools page.
2. Click the Copy Panel Configuration button.
The **Copy Local Configuration to Remote Panels** dialog box opens.

![Copy Local Configuration to Remote Panels Dialog Box](image)

Figure 57: Copy Local Configuration to Remote Panels Dialog Box

A list of the configurations assigned to the source panel are listed in the Local Configurations box.

3. Click the appropriate check box to select the configurations you want to copy; or, highlight the configuration name, and then click the **Assign** button. (Click the **Assign All** button to select all of the listed configurations.)

4. In the IP Address box to the right of the dialog box, enter the target panel’s IP address (a warning message prompts you to make sure to enter the address properly), and then click the **Add** button. To add a range of similar IP addresses, click the **Add Range** check box, and then insert the ending number of the IP address range. The target IP address(es) are listed in the Target Panel IPs box. All list entries are automatically selected, but you can assign and/or unassign the entries as desired.

5. Click **Start Copy**.

   A progress box opens, and displays information about the status of the copy process. (Copies are made to target panels in parallel, so the process is relatively quick.)

6. When the process is complete, click **Close** to terminate the process, or click **Return to Selections** to copy other configurations.

---

**Creating Custom Pages**

You can now create customized pages or views with different combinations of options and buttons.

While **Page up** and **Page down** buttons on the panel are intended to enable you to scroll between multiple destinations or sources (more than can fit in a single view), the **Custom pages** functionality is to enable you to create different sub divided configuration sets on different pages, but all within a single
configuration. By sub-dividing your configuration, you can group like or related buttons and functions together on a page.

The first (default) set of buttons is Page 1. Any additional pages you add are numbered incrementally (page2, page3, etc.), and each have their own set of buttons.

To navigate and quickly access your configurations, you can define Page function buttons and map them to specific pages so you can click the Page button on the panel to go to a specific configuration set (page). See To edit a Page button.

While you can create multiple pages with button sets, the Generate Button Labels option (in the Configuration tab) supports up to 4 pages of button labels.

Follow these steps to create a Custom page:

1. Go the Configurations page, Panel Buttons tab
2. Create or use a pre-existing panel operation mode
3. To add additional pages, click the Page button (with a green + icon overlayed), and click again to add as many pages as required.
4. Once you add at least one page, a second Page button (with a red - icon overlayed) is displayed to the right of the page numbers. Use this to delete a specific page.
5. Click the forward arrow in the page navigation section to go to or move between the newly created pages.
6. A set of blank buttons are displayed on each page. You can configure these as required by clicking a button and then defining the function type and type properties.
Defining Alarm Conditions

1. Access the Configurations page.
2. Select the Panel Buttons tab.
3. Select the bank of alarms on the panel picture.
   The Alarm Definitions selections are displayed in the Button View section of the tab.
4. For each alarm LED, select the Notification Type from the drop-down list box.
   (List types and definitions for each Notification Type are shown in the list box.)
5. For each alarm LED, select the Notification Style from the drop-down list box.
   - When On is selected, whenever the set alarm condition is encountered, the alarm LED displays in a steady state.
   - When Blink is selected, whenever the set alarm condition is encountered, the alarm LED blinks on and off.

Deleting a Panel Configuration

See Deleting a Panel Configuration (on page 68).

Duplicating a Panel Configuration

See Duplicating an Existing Panel Configuration (on page 68).

Editing Button Colors

Note: Modifying or editing button colors overrides the default color settings.
Tip: In addition to changing individual button colors, you may change the default color scheme for source, destination, salvo, group, and category buttons. See Adjusting Default Button Colors (on page 164) for more information.

1. Access the Configurations page.
2. Select the Panel Buttons tab.
3. Select the bank of buttons (operation or programmable) on the panel picture that contains the button type for which you want to change the color scheme.
   An expanded view of the bank of buttons is displayed in the Button View section of the tab.
4. In the Button View, select the button (use standard Windows selection techniques [hold down the <Shift> or <Ctrl> keys] to select multiple buttons, or drag using the mouse).
5. Under the Button Appearance box, click the drop-down arrow to display the complete button color selection list, and then choose the desired swatch.
The button color changes on both the expanded button view and the panel picture.

6. When all changes have been made, save the configuration.

---

### Editing Button Types

1. Access the **Configurations** page.
2. Select the **Panel Buttons** tab.
   
   You can define the following types of buttons:
   - Source
   - Group
   - Salvo
   - Function
   - Crosspoint
   - Level
   - Configuration
   - Page
   - Selenio Preset
   - Status
   - Chop
   - Empty

3. Select the bank of buttons (operation or programmable) on the panel picture that contains the buttons for which you want to change the type.

   An expanded view of the bank of buttons is displayed in the **Button View** section of the tab. Select the **Actual Name** radio button for ease of use.

4. In the **Button View**, select the button (use standard Windows selection techniques [hold down the `<Shift>` or `<Ctrl>` keys] to select multiple buttons, or drag using the mouse).

---

**To edit a Source button**

**Note**: At the top of the sources assignment list is a filter box. The filter allows you to narrow the list of assigned sources to a defined criterion (for example, different criteria could be entries that start with "H," "HD," or "SD"). If desired, enter a filtering criterion in the filter box. Sources are sorted in Logical order (the order in which the destinations were first assigned). If desired, click the **Sort**:<order type> button to select a different sort method.

1. Click **Source** in the Button Type list.
   
   The Sources Assignment box opens.

2. Make one of the following choices as desired:
   - To assign a source to an individual button, click a button in the Button View section, and then click the appropriate source selection to be assigned to that button.
To assign a series of sources to a series of buttons, click a series of buttons in the Button View section, select the first source, and then click **Fill Series** to assign all of the available source buttons with successive sources that start with the source selected.

To have the panel automatically assign the next available source or sources, click a button or a series of buttons in the Button View section, and then click **Set Dynamic**.

**Note:** To use Paging you must set sources to dynamic assignments.

3. If desired, check the **Status Only** and/or **Joystick Override** check boxes:
   - Click the **Status Only** option to create a monitoring button that is intended to display, but not control, the status of a router. If Status Only is checked, the button lights when the source is active, but the router is not affected if you press the button.
   - Check the **Joystick Override** option to make temporary changes. While you hold down the button, the source is switched. When you release the button, the router switches back to the previous source.

4. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Destination button**

**Note:** At the top of the destinations assignment list is a filter box. The filter allows you to narrow the list of assigned destinations to a defined criterion. If desired, enter a filtering criterion in the filter box. Destinations are sorted in Logical order (the order in which the destinations were first assigned). If desired, click the **Sort:<order type>** button to select a different sort method.

1. Click **Destination** in the Button Type list.
   The Destinations Assignment box opens.
2. Click the appropriate destination selection to be assigned to the selected button.
3. Make one of the following choices:
   - Click **Fill Series** to assign all of the available destination buttons with successive destinations that start with the destination assigned
   - Click **Set Dynamic** to assign the destination to the selected button only
4. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Salvo button**

**Note:** At the top of the salvo assignment list is a filter box. The filter allows you to narrow the list of assigned salvo to a defined criterion. If desired, enter a filtering criterion in the filter box. Salvos are sorted in Logical order (the order in which the salvos were first assigned). If desired, click the **Sort:<order type>** button to select a different sort method.

1. Click **Salvo** in the Button Type list.
   The Salvos Assignment box opens.
2. Click the appropriate salvo selection to be assigned to the selected button.
3. Make one of the following choices:
Click Fill Series to assign all of the available salvo buttons with successive salvos that start with the salvo assigned in step.

Click Set Dynamic to assign the salvo to the selected button only.

4. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

To edit a Function button

1. Click Function in the Button Type list. The Button Function Assignment box opens.

2. Select the Primary or Secondary radio button as desired. (You do not need to set a secondary function, but you must set a primary function.)
   - The primary button assignment is enabled when a button is pressed.
   - The secondary button assignment is enabled when a button is pressed in conjunction with the Shift button.

Select the appropriate function from the list. See Function Button Types and Descriptions for the function types and descriptions.

Table 18: Function Button Types and Descriptions

<table>
<thead>
<tr>
<th>Function Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Sets button as an additional source select button</td>
</tr>
<tr>
<td>Destination</td>
<td>Sets button as additional destination select button</td>
</tr>
<tr>
<td>Take</td>
<td>Executes any preset crosspoint assignments</td>
</tr>
<tr>
<td>History</td>
<td>Allows user to recall previously executed crosspoint takes from panel's switch log</td>
</tr>
<tr>
<td>Lock</td>
<td>Prevents all users from changing the destination</td>
</tr>
<tr>
<td>Protect</td>
<td>Prevents all users from changing the destination except the user who initiated the Protect</td>
</tr>
<tr>
<td>Shift</td>
<td>Requires you to press the &lt;Shift&gt; key to fire a salvo (to prevent inadvertent execution of salvos)</td>
</tr>
<tr>
<td>Clear</td>
<td>Allows you to clear any presets from a panel window (display)</td>
</tr>
<tr>
<td>Home</td>
<td>When in menu mode, returns to the top level menu</td>
</tr>
<tr>
<td>Breakaway</td>
<td>Functions as a breakaway button</td>
</tr>
<tr>
<td>Follow</td>
<td>Functions as a follow button</td>
</tr>
<tr>
<td>Back</td>
<td>When in menu mode, decrements menu levels by one</td>
</tr>
<tr>
<td>Up</td>
<td>Increments set-up button pages by one</td>
</tr>
<tr>
<td>Down</td>
<td>Decrements set-up button pages by one</td>
</tr>
<tr>
<td>Parameter</td>
<td>Allows selection of individual parameters affecting inputs and outputs</td>
</tr>
<tr>
<td>Function Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Preset</td>
<td>Queues crosspoints until an action (such as take) is implemented</td>
</tr>
<tr>
<td>Menu</td>
<td>Enables to access to certain operations without requiring to assign them to a button</td>
</tr>
<tr>
<td>Enable</td>
<td>When enabled, causes the panel to function normally; when disabled, source polls are performed, but no crosspoint changes are made</td>
</tr>
<tr>
<td>Empty</td>
<td>No function assigned</td>
</tr>
<tr>
<td>RouterHome</td>
<td>Button mapped to the Router home from within a Router Configuration. See Configuration Home Buttons (on page 69).</td>
</tr>
<tr>
<td>ProcHome</td>
<td>Button mapped to the Processing home from within a Router Configuration. See Configuration Home Buttons (on page 69).</td>
</tr>
<tr>
<td>MViewerHome</td>
<td>Button mapped to the Multiviewer home from within a Router Configuration. See Configuration Home Buttons (on page 69).</td>
</tr>
<tr>
<td>Identify</td>
<td>Used to identify a Panel. See Identifying a Panel (on page 193).</td>
</tr>
<tr>
<td>Unity</td>
<td>Function button used to recall factory default values for parameters on a layer. Applies to Processing configurations. See Unity (on page 72)</td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Fine/Coarse</td>
<td>A toggle Function key that can be used to set current parameter value adjustment as Fine or Coarse. This function key can be used by the INT parameter type. Fine/Coarse only shows when the parameter type is integer; for other parameter types (such as Enum), Fine/Coarse status will not show. The default setting is Fine, toggle to change setting. OLED panels show (Fine) or (Coarse) on the OLED to indicate the current parameter status. LCD only panels display parameter Fine/Coarse settings on a read-only button on the panel.</td>
</tr>
<tr>
<td>ThreadFull</td>
<td>Function button to handle threadfull messages. See Routers in Tieline Mode - Handling ThreadFull messages (on page 150)</td>
</tr>
<tr>
<td>Previous</td>
<td>Works in a Category configuration to take you to the Previous index source/destination. See Previous/Next Buttons (on page 136)</td>
</tr>
<tr>
<td>Function Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Next</td>
<td>Works in a Category configuration to take you to the Next index source/destination. See Previous/Next Buttons (on page 136)</td>
</tr>
</tbody>
</table>

3. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Crosspoint button**

*Note:* At the top of the sources and destinations assignment lists is a filter box. The filter allows you to narrow the list of assignments to a defined criterion. If desired, enter a filtering criterion in the filter box. Assignments are sorted in Logical order (the order in which they were first assigned). If desired, click the Sort:<order type> button to select a different sort method.

1. Click **Crosspoint** in the Button Type list.
   The Sources and Destinations Assignments boxes open.
2. From the **Source** Assignments box, click the appropriate crosspoint source to be assigned to the selected button.
3. From the **Destination** Assignments box, click the appropriate crosspoint destination to be assigned to the selected button.
4. If desired, check the **Status Only** and/or **Joystick Override** check boxes:
   - Click the **Status Only** option to create a monitoring panel that is intended to display, but not control, the status of a router. If Status Only is checked, the button lights when the crosspoint is active, but the router is not affected if you press the button.
   - Check the **Joystick Override** option to make temporary changes. While you hold down the button, the crosspoint is switched. When you release the button, the router switches back to the previous crosspoint.
5. When all changes have been made, save the configuration.

The new assignments are displayed on the button front.

**To edit a Level button**

1. Click **Level** in the Button Type list.
   The Levels Assignment box opens.
2. Click the Follow button to select all of the levels in the list; otherwise, click the check box next to the desired level to assign it to the selected button.
3. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Page button**

1. Click **Page** in the Button Type list.
   The Page Assignment box opens and a list of defined page numbers are displayed.
2. Click the **Page Number** to go to on pressing the button
3. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Status button**

1. Click **Status** in the Button Type list.
   
   The Status Button Type Properties box opens.
2. Select **Source** or **Destination**, as desired.
3. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Group button**

**Note:** For this function to operate, Groups must be set up in Navigator first.

Group buttons are filled dynamically. There are no properties to set.

**To edit a Category button**

**Note:** For this function to operate, Categories must be set up in Navigator first.

1. Click **Category** in the Button Type list.
   
   The Category and Index Type Properties box opens.
2. From the Category Type Property box, click the appropriate category selection to be assigned to the selected button. Select Dynamic to fill from the available unassigned categories set up in Navigator.
3. From the Index Type Property box, click the appropriate index number to be assigned to the selected button. Select Dynamic to fill from the available unassigned indexes set up in Navigator.
4. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

**To edit a Configuration button**

1. Click **Configuration** in the Button Type list.
   
   The Configuration Button Type Properties box opens.
2. Enter the desired information in the **Button Label** text box.
3. Select the desired configuration from the **Configuration** drop-down list box.
4. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.
To edit a Selenio Preset button

1. Click Selenio Preset in the Button Type list. The Type Properties box opens.
2. Enter the IP Address of the Selenio Frame in the Device IP text box.
3. Enter the slot of the module to control in the Selenio Frame in the Slot text box.
4. Enter a name for the Preset in the Name text box.
5. Enter the maximum number of presets to display on the buttons in the Maximum text box.
6. When all changes have been made, save the configuration.

The new assignment is displayed on the button front.

To edit a Chop button

Chop mode enables you to switch a single destination between 2 sources. You can define multiple chop buttons in the same page.
Note: Chop with multiple destinations is limited by the number of destinations and levels. A maximum of 8 destinations are supported with a single level. If there are 2 levels, 4 destinations are supported. If there are 4 levels, 2 destinations are supported.

1. Click Chop in the Button Type list.
2. The Chop Type Properties box opens.
3. Select the Predefined Chop Rate as Fast, Medium, Slow, or Custom.
4. Define the Chop Rate in frames
5. Enter the Chop Name.
6. Select the levels to chop.
7. When all changes have been made, Save the configuration.
8. The new assignment is displayed on the button front.

Also see Invoking a Chop (on page 210).

To change a button to Empty (no function)

Click Empty in the Button Type list.
All assignment information is stripped from the button.
Enabling User Access

1. At the **Tools** page, click the **User Access** button. The **Edit User** dialog box opens.

2. In the **User Name** box, enter a new user name. The user name can have between 1 and 40 alphanumeric characters. This user name is displayed on the Advanced Routing Control Panel display whenever the user accesses the software configuration tool.

3. In the **Password** box, enter a password for the new user. The password can have between 1 and 40 alphanumeric characters.

4. In the **Confirm Password** box, re-enter the password you entered in the Password box.

5. Click **OK** to save the changes.

Enabling or Disabling USB Port Functions

At the **Tools** page, click the **Toggle USB Port Function** to enable or disable the panel’s USB port.

*Note:* Pushbutton panels do not have a USB port installed.

Enhanced Salvos

Enhanced Salvo functionality enables you to execute Salvos even if Sources and Destinations are locked or protected.

Internally, enhanced salvos are treated differently than the standard salvos. Enhanced salvos are parsed separately, using the XY protocol.

1. Create and define enhanced Salvos in Navigator
   - Right click the Salvos folder and select Create > Routing Salvo
   - Click the New button to define the Salvo. Enter a Name for the Salvo.
   - Click in the grid on the right to map the crosspoints.
   - Click Save All and then click Publish to Devices.
   
   For more details, refer the *Navigator User guide*.

2. On the Magellan Router Control Panel, perform a DB synchronization. See Synchronizing Database structure from another Router (on page 200).

3. In your Configuration, create a **Salvo** button, and select the newly created Salvo.

4. You can choose to lock or protect destinations after executing the salvo by selecting the appropriate checkbox *(lock the destinations after executing the salvo or protect the destinations after executing the salvo)* as an output option.
5. Save the Configuration.

Exporting Configurations

1. Access the Configurations page.
2. Click the Export icon.
   The Save As dialog box opens.
3. Navigate to the location where you want to save the configuration file, and then enter a name for the file in the File name text box.
   An XML file is generated.
   The XML file’s export configuration name is the same as the original panel configuration name. This configuration name does not change even if you save the export file under a different file name. When an exported configuration is imported, the software looks at the export configuration name, not at the file name. If the existing and the imported files have the same configuration name, the imported file’s configuration elements will overwrite the existing file’s configuration elements.
In the example shown, one XML file is named ExportConfig.xml and the other is named TestConfig.xml. The contents of both files, however, show that the EXPORTCFG Name is TestConfig. This is because the TestConfig configuration setup was exported to two separate XML files. If TestConfig resides in the Panel Configurations list and ExportConfig is imported, the parameters in ExportConfig will overwrite the parameters in TestConfig.

![Figure 58: Different XML Files with Same Configuration Name](image)

4. Click **OK** to close the process box and return to the Configurations page.

---

**Fonts based on Configuration**

From Magellan Router Control Panel software version 3.0 onwards, you can customize the font per configuration type. Within a single configuration, you can set a separate font/font sizes for Router/Processing/Multiviewer sub configurations. This enables customizing the visual display for a configuration, for example, if you want a bigger font size for better display on the panel, or a different font type.

To change the font or font size:

1. In the active configuration, go to any of the configuration specific tabs (Router/Processing/Multiviewer)
2. Go to the **Options** tab within that configuration
3. In the **Appearance Options** section, make edits to the font as required
4. **Save** the configuration
Finding Panel-Specific Information

- The following information is located on the Summary page, in the Physical Settings column:
  - Panel Type
  - Panel Name
  - Panel ID
  - IP Address
  - Netmask
  - Gateway
  - MAC Address
  - System Cache

- The following information is located on the Summary page, in the Panel Versions and Licenses column:
  - Software Version
  - Hardware Version
  - Serial Number
  - Licensed Options
  - License Key

- The following information is located on the Summary page, in the Current Configuration column:
  - Active Configuration
  - Current Server IP
  - Connection Status

Generating Button Labels

1. Access the Configurations page.
2. Click the Generate Button Labels icon.
   The Save As dialog box opens.
3. Navigate to the location where you want to save the button label file, and then enter a name for the file in the File name text box.
4. From the Save as type drop-down list box, select the file format in which to save the button label file. You may save the file in an Adobe® PDF1 or a Microsoft® Word format.
   A PDF file or an editable Word file with the panel button actual names is generated. This file can be opened with Adobe Reader so that you can print out button labels.

Note: You cannot assign a different font for hard-copy button labels. If you wish to customize panel labels, use a different program to generate the labels.

Note: While you can create multiple pages with button sets, the Generate Button Labels option supports up to 4 pages of button labels.
Generating Service Reports

1. Access the Support page.
2. Click the Generate Service Report button.
   The Save As dialog box opens.
3. Navigate to the location where you want to save the service report file, and then enter a name for the file in the File name text box.

A ZIP file containing the necessary XML and text files is created. These files are used by Imagine Communications support personnel when troubleshooting customer issues.

Identifying a Panel

Note: Use this command if you need to physically identify a panel (for example, if you have more than one of the same type panel installed in your routing system).

1. Access the Summary page.
2. Click the Identify Panel button.
   The physical panel buttons light up and flash simultaneously.
3. Once identified, either click Stop Panel Identify or press a button on the panel to exit the mode.

Importing Configurations

1. Access the Configurations page.
2. Click the Import icon.
   The Open dialog box opens.
3. Navigate to the location where the import configuration file is located.
4. Highlight the import configuration file (when selected, the filename is displayed in the File name text box), and then click the Open button.
   A message box opens.

   Note: If currently selected configurations conflict with the configuration being imported, the imported configuration will overwrite the existing configurations. If you do not want to overwrite existing configurations, click the No button in the message box.

5. Click Yes to continue.
6. Click OK to close the process box and return to the Configurations page.
Installing and Removing Fonts

You may install additional TrueType (TTF) fonts that can be displayed on LCD panel buttons and/or OLED displays. Please keep in mind that license restrictions may prohibit you from using certain specialized fonts. If you use specialized fonts at your facility, check the Font License Agreement for any restrictions.

To install a font

1. Access the Tools page.
2. Click the Font Management button. A list of installed fonts opens.
3. Click the Add button, and then navigate to the location of the desired font.
   Note: Fonts cannot be installed directly from the Windows > Fonts subdirectory.
4. Select the desired font file, and then click Open. The new font is installed at the bottom of the Fonts list.
5. Click Close.
6. Reboot the panel for fonts to take effect.
7. If desired, access the Options tab on the Configurations page.
   ▪ Click the LCD Buttons Font drop down list box, and then select the newly installed font. Access the Panel Buttons tab. The new font is displayed on the programmable panel button fronts.
   ▪ Click the Panel Window Large Font drop down list box, and then select the newly installed font. Access the Panel Buttons tab. The new font is displayed at the bottom of the OLED display.
   ▪ Click the Panel Window Small Font drop down list box, and then select the newly installed font. Access the Panel Buttons tab. The new font is displayed at the top of the OLED display.

To remove an installed font

1. Access the Tools page.
2. Click the Font Management button. A list of installed fonts opens.
3. Highlight the font to be removed, and then click the Remove button.
4. Click the Close button to return to the Tools page.

Primary and Secondary Server IPs

1. Access the Configurations page.
2. Go to the Options tab, Communications Options.
3. Set the Primary Server IP and the Secondary Server IP.
4. You can toggle between the defined primary and secondary servers by going to the Summary page, Current Configuration section, and clicking the Toggle Server button.
The following logic is implemented in case of primary and secondary servers:

- The switch from primary to secondary occurs in the event that the primary server fails.
- If the primary server fails or becomes unavailable, a second attempt is made to reconnect to the primary server before attempting a connection to a secondary server.
- When the (configured) secondary server is switched to, even if the primary server becomes available again, the secondary server stays active and the old primary server then serves as the secondary (backup) server.
- You can use the Toggle functionality at any time to switch manually between the primary and secondary server.

**Reloading Configurations**

1. Access the **Configurations** page.
2. Click the **Reload** icon.

The original configuration settings are restored.

**CAUTION**

When you reload a configuration, any unsaved changes you made to the configuration are lost.

**Removing Local Aliases**

1. Access the **Configurations** page.
2. Select the **Local Aliases** tab.
3. Select the ribbon for **Sources**, **Destinations**, or **Salvos** as appropriate.
   A list of the available items and their associated aliases is displayed in the Name/Panel Alias list box. At the top of the list box is a filter box. The filter allows you to narrow the list of selections to a defined criterion (for example, different criteria could be entries that start with "S," "SD," or "SU"). If desired, enter a filtering criterion in the filter box
4. Double-click the appropriate alias listed in the Panel Alias column, and then press the **Delete** keyboard key. (Click the onscreen **Remove All Aliases** button to delete all of the listed aliases.)
5. When all changes have been made, save the configuration.

**Removing Local Salvos**

1. Access the **Configurations** page.
2. Select the **Local Aliases** tab. Select the ribbon for **Salvos**.
   A list of the available local salvos is displayed in the Salvo Name box.
3. Highlight the name of the salvo to be removed, and then click **Remove Salvo**.
The selected salvo is removed from the local salvo list.

---

**Restarting a Panel**

1. Access the Support page.
2. Click the Reboot Panel button.

---

**Restoring Panel Defaults**

1. Access the Support page.
2. Make one of the following selections:
   - Click the Reset Panel Communications button to return the panel to its factory default communications settings (that is, Panel IP address, Panel ID, name, etc.).
   - Click the Reset Panel Configurations to return the panel to its factory default configuration settings. (This does not affect current communications settings.)

---

**Saving a Configuration**

When you finish creating or changing a configuration, you must save it.

- To save changes to an individual configuration, click the Save icon button.
- To save changes to multiple configurations, click the Save All icon button.

*Note:* Status icons to the right of the configuration name provide information about any unsaved changes.

The saved configuration is immediately downloaded to the physical panel. If the active configuration is saved and is not modified on the panel, the configuration is automatically reloaded.

---

**Selecting Panel Operation Modes**

1. Access the Configuration page.
2. Click the Panel Operation Mode drop down list box to see a list of the different configuration setups available for your particular panel
   - Select **Button Per Source** to assign individual sources and/or destinations to individual buttons. For a detailed explanation of how to build a panel in Button Per Source operation mode, see Button Per Source Operation Mode Panel (on page 113).
   - Select **Category Mode** to assign source/destination categories and select a specific index. For a detailed explanation of how to build a panel in Category operation mode, see Category Operation Mode Panel (on page 115).
- Select **Group Mode** to assign source/destination groups as defined in Navigator Database Editor. For a detailed explanation of how to build a panel in Group operation mode, see Group Operation Mode Panel (on page 117).
- Select **Selenio Preset Mode** to assign Selenio presets. For a detailed explanation of how to build a panel in Selenio Preset mode, see Selenio Preset Mode Panel (on page 119).

### Setting Screensaver Options

1. Access the **Summary** page.
2. In the **Panel Options** section, set **Screen Saver Enable** to **Yes** (default) or **No**.
3. Set the **Screen Saver Black Out** to the desired value.

   **Note:** Use the Screen Saver Black Out option to deactivate the panel screensaver flashing (which can be visually distracting). With this option, the screen saver will stay blacked out until a button is pushed to wake it up.

   Note that when the blackout is active, pressing any button wakes up the panel. Even if the button pressed is TAKE will, the TAKE will not be executed, but will only wake up the panel. You need to press TAKE again to execute. This functionality is to ensure nothing unintended gets executed when the screen is blacked out.

4. Define the screen saver activation time period in **Wait Time (minutes)**.
5. Define the **Cycle Time (seconds)**

   ![SCREENSAVER OPTIONS](image)

### Setting the Panel License ID

1. Access the **Summary** page.
2. In the **License Key** text box, enter the license key for the panel, and then click the **Set License ID** button.
Setting Up Local Aliases

1. Access the Configurations page.
2. Select the Local Aliases tab.
3. Select the ribbon for Sources, Destinations, or Salvos as appropriate.
   A list of the available items and their associated aliases is displayed in the Name/Panel Alias list box.
   At the top of the list box is a filter box. The filter allows you to narrow the list of selections to a defined criterion (for example, different criteria could be entries that start with "S," "SD," or "SU"). If desired, enter a filtering criterion in the filter box.
4. Double-click the appropriate blank space (or existing alias name) in the Panel Alias column, and then enter the desired alias.
5. When all entries have been made, save the configuration.

Show/Hide Status on Destination buttons

You can choose to show or hide status on Destination buttons. This setting can be made globally for all destination buttons, or specifically for individual destination buttons. A button's individual setting will take precedence over the global setting. When Show Status is enabled, both destinations and sources will be visible on status buttons. Destinations are displayed on the top of a button and sources below.

Global Setting

To show/hide destination status on all destination buttons

1. Go the Configurations page, Options tab.
2. Set Show Destination Status to Yes to show the destination on all status buttons or set it to No to hide destinations on Status buttons.
The option selected here becomes applicable to all status buttons in the configuration, except those with local/individual settings.

### Local Setting

To show/hide destination status on individual destination buttons

1. Go to the **Configurations** page, **Panel Buttons** Tab.
2. Click on the section of the panel to edit; then click the specific **Destination** button to edit.
3. In the **Type Properties** section, select the **Show Status** checkbox to enable destination status or clear the checkbox to hide. This individual setting overrides the global setting.
Synchronizing Database structure from another Router

There may be instances where you need to import the database structure from another router to the router being controlled by the Magellan. In such cases, you need to set/change the connection type to the main router as Coax (and use a coax cable to connect to it), and then provide the IP address of the router to import the database structure from, which will be via IP.

1. Access the **Configurations** page.
2. Select the **Options** tab. **Communication Options** are listed at the top right side.
3. Select the **Connection to Router** as **Coax**.
4. Provide the IP address of the (Router) Server to import the database structure from in the **XY Server IP** field.

Once this is configured, you can opt to sync the database directly from the panel by doing the following:

- Press **Shift+Menu** on the panel to enter Setup mode
- Select **Sync DB**, and then select **Yes** to synchronize the database.
Upgrading Multiple Panels

1. Access the **Tools** page.
2. Click **Upgrade Multiple Panels**.
   A Multiple Upgrades cautionary statement opens.
3. Click **Yes** to launch the upgrade procedure.
   The Upgrade Multiple Panels window opens.
4. In the IP Address box near the bottom of the dialog box, enter the target panel’s IP address (a warning message prompts you to make sure to enter the address properly), and then click the **Add** button.
   To add a range of similar IP addresses, click the **Add Range** check box, and then insert the ending number of the IP address range.
5. The target IP address(es) are listed in the Target Panel IPs box. All list entries are automatically selected, but you can assign, unassign, or remove the entries as desired.
6. Click **Start Upgrade**.
   The **Open** <Firmware File> dialog box opens.
7. Navigate to the location of the most current firmware file, and then select it.
8. Click **Open**.
   You are prompted to confirm the upgrade.
9. Click **OK** to launch the upgrade procedure.
   A progress box opens, and displays information about the status of each upgrade process. (Upgrades are made to target panels in parallel, so the process is relatively quick.)
   During the upgrade the panel reboots, and communications and operations are interrupted.

Upgrading Panel Firmware

1. Access the **Summary** page.
2. In the **Panel Versions and Licenses** section, click **Upgrade Firmware**.
   The **Open** <Firmware File> dialog box opens.
3. Navigate to the location of the most current firmware file, and then select it.
4. Click **Open**.
   You are prompted to confirm the upgrade.
5. Click **OK** to launch the upgrade procedure.
   During the upgrade the panel reboots, and communications and operations are interrupted.
Using the Offline Configuration Editor

Use offline configuration when

- You have a panel that is not installed in your routing setup
- You want to set up a configuration that may be imported into a Magellan Router Control Panel at a later time
- You do not have access to a Magellan Router Control Panel

**Note:** If you have not previously installed the Offline Configuration Editor tool, follow the steps outlined in Installing the Offline Configuration Editor (on page 40).

1. Click the Magellan RCP Config icon installed on your Start menu or desktop.
   The Configuration Offline Mode dialog box opens.

   ![Figure 59: Configuration Offline Mode Dialog Box](image)

   **Magellan Panel Offline Options**

   Welcome to the Magellan Panel Configuration running in offline mode. In this mode you can create panel configurations for a specific panel type based on a blank configuration or an exported configuration. You can take this configuration and then import this into a live panel.

   **Please select what type of configuration to start with:**

   - [ ] Edit an Existing Configuration
   - [ ] Start from a Blank configuration

   **OK**

2. Make your selection for how to start or edit the configuration.

Importing an Existing Magellan Router Control Panel Configuration

1. Click **Import an existing configuration** if you want to open an already-created Magellan configuration.

2. Click **OK**, and then navigate to the location of the Magellan Router Control Panel configuration file (in XML) format you want to use. (This configuration file could have been exported from a panel or created in another offline session.)

3. Highlight the desired file name, and then click **Open**.

4. When the Loading Process Status box says "Loading Complete," click **OK**.
   The Configurations page opens. (See Configurations Page (on page 54) for a detailed description.)
Note: The Save All, Reload, Export, Export All, Import, and Activate icons are not available when configuring offline.

You may now edit, add, or remove configurations as desired. For more information, see Common Configuration Tasks (on page 161).

Starting from a Blank Configuration

1. Click **Start from a blank configuration** to create a configuration from scratch.
   The Select Panel Type drop-down list box opens.
2. Select the desired panel type from the list, and then click **OK**.
   The Configurations page opens. (See Configurations Page (on page 54) for a detailed description.)
3. Click the **New...** button, and then see Creating a New Panel Configuration (on page 62) for the instructions on how to create a new panel configuration.

Panel Gang Configuration in the Offline Configuration Tool

Magellan Router Control Panel software version 3.0 onwards supports panel gang configurations in the offline configuration tool. Slave panel IPs and types must be correctly specified, since the offline tool cannot check the panel info provided. Slave panel information will be validated once the configuration is imported into the online environment.

Creation of panel gang configurations in the offline configuration tool are similar to the functionality in the online tool. See Panel Gang Configuration (on page 66) for details.
Front Panel Configuration Tasks

Some configuration tasks can be performed directly on the front panel:

**Note:** You can bring up menu options on the Magellan Router Control Panel by first pressing the shift button (it will light up) and then pressing the menu button. The available menu options will then be displayed.

---

Adding a Device

You can opt to add a device (such as a router, an X50/75/85/100, Selenio MCP, etc.) directly from the panel instead of via the Web UI. When added via the panel, the device is added to the currently active configuration, in the Processing configuration section.

If your currently active configuration does not have a Processing configuration enabled, it will get created and enabled on adding a non-router device.

1. Press the Shift button, and then press the Menu button on the front of the control panel. The panel clears the current selections and displays the Mode selection buttons.
2. Press the Add Device button.
3. Press the button with the first octet and then use the numeric keys on the left to enter the IP address of the Device.
4. Once complete, the Take button flashes. Press the Take button to confirm the IP Address.
5. The panel then searches for the device and once found, it gets added to the Processing configuration in the currently active configuration.
6. Press the Exit button to return to the previous screen OR

Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

**Note:** The ability to add a device directly from the panel is controlled from the Options tab for individual configuration tabs (Router/Processing/Multiviewer) in the Configuration Editor. By default, the Add Device from Panel option is set to No. When set to No, you will not be able to add a device of that type directly from the panel.

---

Selecting a Panel Configuration

1. Press the Shift button, and then press the Menu button on the front of the control panel. The panel clears the current selections and displays the Mode selection buttons.
2. Press the Config mode button.

   The different panel configurations available are labeled on the front of the panel buttons. You can choose to View, Restore, or Save configuration.
If you select View, the panel buttons will change to display the defined configurations, and the currently active one will show ACTIVE below the configuration name. You can change the active configuration by pressing the button for a different configuration. The TAKE button will then flash and you can press it to accept changes. The newly selected configuration will then become active.

Selecting Destinations

1. To select destinations, press the Shift button, and then press the Menu button on the front of the control panel.
   The panel clears the current selections and displays the Mode selection buttons.
2. Press the Dest mode button.
   The different panel destinations available are labeled on the front of the panel buttons.
3. Press the button that shows the label for the destination you want to launch.
   The Take button flashes.
4. Press the Take button to confirm the selection.
   The panel reverts back to the destination selections; buttons for the active destinations are illuminated.
5. Press the Shift + Home button to exit Dest mode.
   The panel returns to the "home" state.

Selecting Sources

1. To select sources, press the Shift button, and then press the Menu button on the front of the control panel.
   The panel clears the current selections and displays the Mode selection buttons.
2. Press the SRC mode button.
   The different panel sources available are labeled on the front of the panel buttons.
3. Press the button that shows the label for the source you want to launch.
   The Take button flashes.
4. Press the Take button to confirm the selection.
   The panel reverts back to the source selections; buttons for the active sources are illuminated.
5. Press the Shift + Home button to exit SRC mode.
   The panel returns to the "home" state.
Selecting Salvos

1. To select salvos, press the Shift button, and then press the Menu button on the front of the control panel.
   The panel clears the current selections and displays the Mode selection buttons.
2. Press the Salvo mode button.
   The different panel salvos available are labeled on the front of the panel buttons.
3. Press the button that shows the label for the salvo you want to launch.
   The Take button flashes.
4. Press the Take button to confirm the selection.
   The panel reverts back to the salvo selections; buttons for the active salvos are illuminated.
5. Press the Shift + Home button to exit Salvo mode.
   The panel returns to the "home" state.

Selecting Display Names

You can view sources and destinations by their standard names, long names, or aliases as originally created in Navigator Database Editor.

Tip: Long names can be entered as unicode text in Navigator Database Editor. Select Long Name to display sources and destinations to use Unicode text on the panel front.

1. To select the type of name to display, press the Shift button, and then press the Menu button on the front of the control panel.
   The panel clears the current selections and displays the Mode selection buttons.
2. Press the Name Use mode button.
   The different selections available are Name, Alias, and Long.
3. Press the button that shows the label for the configuration you want.
   The Take button flashes.
4. Press the Take button to confirm the selection.
   The panel returns to the "home" state.

Setting Connection Type

1. Press the Shift button, and then press the Menu button on the front of the control panel.
2. Press the Conn Type button.
3. Select the desired connection time, for example, Ethernet.
Setup Mode

1. To select Setup mode, press the **Shift** button, and then press the **Menu** button on the front of the control panel. The panel clears the current selections and displays the Mode selection buttons.

2. Press the **Setup** mode button. Available options are displayed.

   **Note:** If only viewing the settings, press the **Clear** or **Shift + Home** buttons to get back to the panel's "home" state.

Changing a Panel ID

Press the **Setup** button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the **ID** button.
   - The panel clears all the buttons and the ID is displayed in the top-left.

2. Press the button with the ID and then use the numeric keys on the left to enter a new ID address.

3. Once complete, the **Take** button flashes. Press the **Take** button to confirm the new number and finish with that option’s settings.

4. Press the **Exit** button to return to the previous screen OR

Press **Shift + Home** button to exit Setup mode. The panel returns to the "home" state.

Changing a Panel IP Address

Press the **Setup** button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the **IP** button.
   - The panel clears all the buttons and the IP address is displayed in top-left buttons.

2. Press the button with the first octet and then use the numeric keys on the left to enter a new IP address.

3. Once complete, the **Take** button flashes. Press the **Take** button to confirm the new number and finish with that option’s settings.

4. Press the **Exit** button to return to the previous screen OR

Press **Shift + Home** button to exit Setup mode. The panel returns to the "home" state.
Changing a Panel Gateway Address

Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the Gateway button.
   The panel clears all the buttons and the Gateway address is displayed in top-left buttons.
2. Press the first button with the first octet and then use the numeric keys on the left to enter a new gateway address.
3. Once complete, the Take button flashes. Press the Take button to confirm the new number and finish with that option’s settings.
4. Press the Exit button to return to the previous screen OR
   Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

Changing a Panel Subnet

Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the Subnet button.
   The panel clears all the buttons and the Subnet address is displayed in top-left buttons.
2. Press the first button with the first octet and then use the numeric keys on the left to enter a new address.
3. Once complete, the Take button flashes. Press the Take button to confirm the new number and finish with that option’s settings.
4. Press the Exit button to return to the previous screen OR
   Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

Changing a MAC Address

Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the MAC button.
   The panel clears all the buttons and the MAC address is displayed in top-left buttons.
2. Press the first button with the first octet and then use the numeric keys on the left to enter a new gateway address.
3. Once complete, the Take button flashes. Press the Take button to confirm the new number and finish with that option’s settings.
4. Press the Exit button to return to the previous screen OR
   Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.
Setting Primary and Secondary Server

Press the Setup button. The panel displays available options.

1. Press the 1st Server (to set the primary server) or the 2nd Server button (to set the secondary server).
   The panel clears all the buttons and the IP address is displayed in top-left buttons.
2. Press the first button with the first octet and then use the numeric keys on the left to enter a new address.
3. Once complete, the Take button flashes. Press the Take button to confirm the new number and finish with that option’s settings.
4. Press the Exit button to return to the previous screen OR

Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

Toggling Primary and Secondary Server

Note: Toggling between servers uses the IP addresses set in the 1st Server and 2nd Server options.

1. Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.
2. Press the Toggle Server button.
3. Press Yes to toggle between servers or No to cancel.
4. Press the Exit button to return to the previous screen OR

Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

Viewing Hardware and Software Versions

Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the HW Ver button to see the hardware address or the SW Ver button to see the software address.
2. Press Yes to toggle between servers or No to cancel.
3. Press the Exit button to return to the previous screen OR

Press Shift + Home button to exit Setup mode. The panel returns to the "home" state.

Rebooting a Panel

Press the Setup button (see Setup Mode (on page 207)). The panel displays available options.

1. Press the Reboot Panel button to restart the panel.
Invoking a Chop

First, define a chop function. See To edit a Chop button.

Next, follow these steps to invoke a chop:

1. Select (Press) the Destination to chop on the panel
2. Press the first Source button that the destination should chop
3. Press the Chop button and then press the second Source button

- If you have set Require Take for Switches to No, the chop is invoked immediately after the source button is pressed.
- If you have set Require Take for Switches to Yes, press the Take button to invoke the chop

When Chop occurs, the source buttons are lit active. The chop button with the right transition rate is lit as active.

To cancel a chop:

1. Press the currently active source button or any new source to be switched into

- If Require Take for Switches (on the Options page) is set to "No", the Chop is canceled immediately.
- If Require Take for Switches is set to "Yes", the Take button then blinks. Press Take to cancel the Chop.

**Note:**
Switching a destination to a source cancels an active Chop.

Chop is supported by Platinum via XY protocol only.

USB

1. Press the Shift button, and then press the Menu button on the front of the control panel.
2. Press the USB button.
3. The current state of the USB will be indicated as Enabled or Disabled.
4. You have the option to Run, Copy, or Backup from the USB.

Screensaver

1. Press the Shift button, and then press the Menu button on the front of the control panel.
2. Press the Screen Saver button.
3. You have the option to Enable/Disable, set Wait Time, or set Cycle Time.
   - To enable the screensaver, press Enable and then press Yes.
   - To disable the screensaver, press Enable and then press No.
- To set the Wait Time, press **Wait Time** and then use the numeric keypad to enter time in minutes
- To set the Cycle Time, press **Cycle Time** and then use the numeric keypad to enter time in minutes
Frequently Asked Questions

How many Magellan Router Control Panels are available?

There are 10 panels available.
- RCP-16PB, RCP-48PB, RCP-96PB have pushbuttons only
- RCP-32PB-OLED, RCP-64PB-OLED have pushbuttons and OLED displays
- RCP-16LCD, RCP-32LCD, RCP-64LCD) have pushbuttons and LCD buttons only; and two panel styles (RCP-24LCD-OLED, RCP-48LCD-OLED) have pushbuttons, LCD buttons, and OLED displays.

Do they have the same feature set?

All panels use the same software code and logic module. The front panel stuffing determines the functionality.

What are the connection interfaces?

All panels are shipped standard with both coax and Ethernet connectivity.

What protocols are supported by the panels?

The panels support both legacy Pass Through Protocol on both coax and Ethernet connections, as well as the new LRC protocol available via Ethernet only.

What is the default protocol and what is recommended?

The default communication protocol is set to XY on the Magellan panel. However, we recommend to use the LRC Protocol if the system contains Platinum, Platinum IP3, or Platinum VX (routers). LRC protocol is a name based protocol which provides additional routing level control and status reporting mechanism.

Can you use them with other Imagine Communications routers?

Yes. The standard Pass Through Protocol is available to use on both the ethernet and coax comm ports. This will allow for similar functionality and operations for any legacy router as well as interfacing to any Panacea that does not support ethernet clients.

What are the key feature differences lost when using Pass Through Protocol versus LRC?

Basic functionality remains the same. However, the ability to automatically update when there is a database change is lost. In addition, speed may be affected as Pass Through is a significantly slower connection.

How are the panels configured?
Each panel has its own built in web server. Configuration is done via a PC.

**Do I need a special program to configure the panels?**

The only requirement is that the configuration PC has Microsoft Silverlight resident.

**How can I access the web server on the panel?**

There are two ways. First, a customer can type the IP address of the panel directly. Second, if a customer has discovered the panels in Navigator, they can access the panels through the Navigator GUI.

**Can I copy panel configurations to other panels?**

Yes, you can copy configurations directly from one panel’s web server by specifying the IP addresses of other panels. You can also copy a panel configuration via the panel’s USB port.

---

**Note:** Configurations can only be copied to like panel types.

**Do Magellan Control Panels support Unicode names?**

Yes, Magellan LCD control panels support Unicode names. You must set up the Long Name field in Navigator to input Unicode names, and set the display name property of the panel to Long Name. A compatible Unicode font must also be installed on the panel for the name to be displayed properly.

**I do not see group or category as an option for my panel button.**

To set the panel button type to Group or Category, ensure you are in their respective operation modes. See Control Panel Operation Modes for a list of the operation modes available for each control panel type.

**How can I edit generated button labels?**

1. Click the Generate Buttons Label icon.
2. Select Microsoft Word as the output file type.
3. Open the generated Word file, and then edit and format the text as desired.

**How do I return panel button colors to their default settings?**

At any button color selection, select the first option in the Button Appearance drop-down list. This option appears as a blank selection.

**The control panel displays for my web configuration are not clear.**
The web configuration is optimized for use with monitors having screen resolutions of 1280×1024 pixels. Larger resolutions will allow better visibility of panels with more buttons.

**How can I create favorite source or favorite destination buttons?**

Favorite source and destination buttons are created by assigning a source or destination button type (in grouping or category mode) to an LCD button.
Specifications

Note: All specifications and designs are subject to change without notice

Electrical Specifications

Table 19: Magellan Router Control Panel Electrical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>1RU portable desktop power supply module available as an option</td>
</tr>
<tr>
<td>Desktop power supply</td>
<td>Universal input</td>
</tr>
<tr>
<td></td>
<td>50/60 Hz, 25 W</td>
</tr>
<tr>
<td></td>
<td>100-240 VAC</td>
</tr>
<tr>
<td>Output</td>
<td>5 VDC</td>
</tr>
<tr>
<td>Total power</td>
<td>25 W</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>41° – 104°F (5° – 40°C)</td>
</tr>
</tbody>
</table>

Mechanical Specifications

Table 20: Magellan Router Control Panel Mechanical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td></td>
</tr>
<tr>
<td>1RU</td>
<td>19 in. × 1.75 in. × 1.75 in. (48.3 cm × 4.5 cm × 4.5 cm)</td>
</tr>
<tr>
<td>2RU</td>
<td>19 in. × 1.75 in. × 3.5 in. (48.3 cm × 4.5 cm × 8.9 cm)</td>
</tr>
<tr>
<td>Weight (fully loaded)</td>
<td></td>
</tr>
<tr>
<td>1RU</td>
<td>1.7 lb (0.78 kg)</td>
</tr>
<tr>
<td>2RU</td>
<td>3.2 lb (1.5 kg)</td>
</tr>
<tr>
<td>LED indicators</td>
<td>• Power</td>
</tr>
<tr>
<td></td>
<td>• Network</td>
</tr>
<tr>
<td></td>
<td>• Connection</td>
</tr>
<tr>
<td></td>
<td>• Enabled</td>
</tr>
<tr>
<td></td>
<td>• Alarm 1 and Alarm 2</td>
</tr>
</tbody>
</table>
## Input/Output Specifications

### Table 21: Input/Output Signal Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 serial communication</td>
<td>DB-9 pin connector</td>
</tr>
<tr>
<td>X-Y (coaxial communication)</td>
<td>75Ω BNC</td>
</tr>
<tr>
<td>Ethernet</td>
<td>RJ-45</td>
</tr>
</tbody>
</table>
Configuring the Magellan Router Control Panel • 123
Configuring TRAX • 144
Contact Information • 2
Control Buttons • 86
Control Mode • 46
Control Mode Display • 48
Control Mode Notes • 50
Controlling a Selenio (MCP) Device • 105
Controlling a Selenio™ Clean and Quiet (CQS) Module • 94
Copying a Panel Configuration to Other Control Panels • 177
Create a New Router Configuration • 151
Create a Routing System with the Router and Magellan Router Control Panel • 105
Create New Multiviewer Configuration • 157
Create New Router Configuration • 98
Creating a Multiviewer Configuration • 156
Creating a Multiviewer Configuration on PB Only Panels • 160
Creating a New Panel Configuration • 62
Creating a Processing Configuration • 78
Creating a Processing Configuration on PB-OLED Panels • 94
Creating Custom Pages • 178
Current Configuration • 45

D
Defining Alarm Conditions • 179
Defining Dynamic Crosspoints from the Web UI (LCD/PB-OLED Panels) • 140
Deleting a Panel Configuration • 68, 180
Deleting a Processing Configuration • 93
Destination Mode • 129
Detailed Settings for Operation Mode Panels • 132
Device Discovery • 80
Device Discovery and Mapping • 83
Device Name • 147
Devices You Can Control • 61
Directives and Compliances • 16
Discovery - Selenio 6800+, NEO, Selenio X50/75/85/100, Selenio MCP, Platinum, Platinum IP3, Multiviewers • 83
Discovery Interface • 80
Duplicating a Panel Configuration • 180
Duplicating an Existing Panel Configuration • 68
Dynamic Crosspoints • 140
Dynamic Crosspoints - LCD Panels • 141
Dynamic Crosspoints - PB-OLED Panels • 144

E
Edit Mode • 46
Editing Button Colors • 180
Editing Button Types • 181
Electrical Requirements • 33
Electrical specifications • 214
Electrical Specifications • 214
Emulating the Alarm LEDs • 53
Emulating the Knob • 52
Enabling and Disabling Panels • 133
Enabling or Disabling USB Port Functions • 189
Enabling User Access • 189
Enhanced Salvos • 189
Ensuring Safety • 14
Error Logs • 162
Ethernet Connection • 34
Ethernet Setup • 36
Example of how to use Control Mode • 50
Executing Dynamic Crosspoints from a PB-OLED Panel • 144
Executing Dynamic Crosspoints from an LCD Panel • 142
Exporting Configurations • 190
Exporting Discoverered Device Configurations • 80
Exporting the Database from Navigator • 123
Exporting the Database from RouterMapper • 121

F
Favorites Tab • 79
Finding Panel-Specific Information • 191
Fonts based on Configuration • 191
Frequently Asked Questions • 211
Front and Back Panel Views • 19
Front Panel Configuration Tasks • 204
Front Panel Controls • 26
Function Buttons • 69

G
Ganging Parameters • 92
General Configuration • 65
Generating Button Labels • 192
Generating Service Reports • 192
Global Button Text Settings • 167
Global Setting • 198
Group Mode • 117
Group Mode with Multibus • 119
Group Operation Mode Panel • 118

H
History Mode • 126
How to Save (Map) a Preset • 97

I
Identifying a Panel • 193
Import Multiviewer Configuration • 157
Import Router Configuration • 100
Importing a Configuration into an Existing Configuration • 69
Importing Configurations • 193
Input/output specifications • 215
Input/Output Specifications • 215
Installation • 32
Installing and Removing Fonts • 194
Installing the Offline Configuration Editor • 40
Introduction • 19
Invoking a Chop • 209
Invoking the Multiviewer • 159
Invoking TRAX from the Panel • 146

K
Knob Press Action • 82

L
LCD Button Panels • 21
LCD Button Panels with OLED Displays • 22
LCD Panels • 24
LCD Panels with OLED • 25
LCD Panels without OLED • 164
Load Limitations • 33
Local Button Text Settings • 169
Local Setting • 199
Locking a Destination • 131
Login Credentials • 38
Logs • 162

M
Magellan Router Control Panel Alarms in CCS Navigator • 76
Magellan Router Control Panel Applications • 10
Magellan Router Control Panel Discovery via Magellan™ CCS Navigator • 72

Magellan Router Control Panel Parameters in CCS Navigator • 75
Magellan Router Control Panel Service and Support • 31
Manual Information • 10
Manual Mode • 148
Mapping Buttons to Frame/Module Elements • 88
Mapping buttons to Multiviewer Elements • 158
Mapping Buttons to Multiviewer Elements • 91
Mapping Platinum SX Hybrid/IP • 159
Mapping Platinum SX Pro • 158
Mapping Selenio 6800+/Platinum Predator II • 159
Master Panels • 66
Maximum Power Dissipation • 33
Mechanical specifications • 214
Mechanical Specifications • 214
Mounting Panels • 35
Mounting Requirements • 35
Multibus Mode • 119
Multiviewer Configuration • 156
Multiviewer Configuration for Pushbutton (PB) Only Panels • 160
Multiviewer Discovery • 157

N
Navigation of Discovered Devices • 85
Notes • 135
Notes on Panel Gang Configurations • 68
Notes while creating CQ Pairs • 152
Notes: • 136

O
Obtaining Documents • 12
Offline Configuration • 59
Offline Configuration Editor • 40
On-Line Configuration • 60
Operation Modes • 46
Operation Modes available for each panel type (* = Default) • 113
Operator • 59
Options Tab • 82
Other Devices in a Router Configuration • 103

P
Page Up/Down In Status Display • 133
Panel Buttons Tab • 81
Panel Configuration • 61
  Creating • 62
  Deleting • 68
  Duplicating • 68
  Home Buttons • 69
Panel Configuration with non-Ethernet Routers
  (XY Coax Connection) • 120
Panel Gang Configuration • 66
Panel Installation Procedure • 35
Panel Modes • 125
Panel Options • 44
Panel Tasks
  Setup Mode
    Hardware Version • 209
    Panel Gateway Address • 207
    Panel ID • 207
    Panel IP Address • 207
    Panel Subnet • 208
    Primary Server • 208
    Rebooting Panel • 209
    Secondary Server • 208
    Software Version • 209
    Toggling Servers • 209
  USB • 210
Panel Versions and Licenses • 43
Parameter Mode • 125
Parameters
  Ganging • 92
  PB Only Panels: Notes • 160
  PB-OLED Panels: Notes • 94
  Physical Settings • 43
  Pin/Unpin Functionality • 135
Platinum Frame Synchronizer (PT-FSDMX-IBG)
  in a Router Configuration • 112
Platinum MADI (PT-MADI4X-OBG) in a Router
  Configuration • 105
Preface • 10
Presets • 96
Previous/Next Buttons • 137
Primary and Secondary Server IPs • 194
Process Templates in a Router Configuration • 139
Process to Discover a Magellan Router Control
  Panel in Magellan CCS Navigator • 73
Process to Discover another Magellan Router
  Control Panel • 76
Processing Configuration • 78
Processing/Multiviewer License • 43
Product Description • 19
Product Features • 23
Product Servicing • 13
Proper Temperature • 33
Protective Ground • 33
Publication Information • 2
Purpose • 10
Pushbutton Panels • 20, 23
Pushbutton Panels with OLED • 24
Pushbutton Panels with OLED Displays • 21
R
  RCP-16LCD • 21
  RCP-16PB • 20
  RCP-24LCD-OLED • 22
  RCP-32LCD • 22
  RCP-32PB-OLED • 21
  RCP-48LCD-OLED • 23
  RCP-48PB • 20
  RCP-64LCD • 22
  RCP-64PB-OLED • 21
  RCP-96PB • 20
  Rebooting a Panel • 209
  References • 15
  Reloading Configurations • 195
  Removing Local Aliases • 195
  Removing Local Salvos • 195
  Report Levels • 154
  Restarting a Panel • 196
  Restoring Panel Defaults • 196
  Restriction on Hazardous Substances (RoHS)
    Compliance • 17
  Returning a Product • 13
  Revision History • 11
  Router Configuration • 98
  Router Configuration - Button Functions • 134
  Router Configuration - Other Functions • 139
  Router Configuration - Panel Functions • 125
  Router Configuration - Panel Operation Modes
    • 112
  Routers in Tieline Mode - Handling ThreadFull
    messages • 151
  Routing • 153
  Run the Device Type Wizard • 106
S
  Safety • 13
  Safety Standards and Instructions • 31
  Safety Terms and Symbols in this Manual • 14
Save Configuration • 153
Saving a Configuration • 196
Screensaver • 210
Scrolling Dynamic Sources/Destinations • 137
Select Item with children • 85
Selecting a Panel Configuration • 204
Selecting Destinations • 129, 205
Selecting Display Names • 206
Selecting Panel Operation Modes • 196
Selecting Salvos • 205
Selecting Sources • 128, 205
Selection from Favorite Destination • 130
Selenio MCP1/MCP3 Frame/Module Presets in a Router Configuration • 104
Selenio Preset Mode Panel • 120
Service • 31
Service (Serial) Connection • 34
Setting Connection Type • 206
Setting Primary and Secondary Server • 208
Setting Screensaver Options • 197
Setting the Panel License ID • 197
Setting Up Local Aliases • 198
Setting Up Microsoft Internet Explorer • 37
Setup Mode • 206
Show Parameter Value • 88
Show/Hide Status on Destination buttons • 198
Siting Requirements • 32
Slave Panels • 67
Software Configuration • 42
Software Configuration Tool Configurations Page • 54
Summary Page • 42
    Current Configuration • 45
    Licenses • 43
    Panel Versions • 43
    Screensaver Options • 44
Support Page • 56
Tools Page • 57
Source Mode • 127
Special Cases • 154
Specifications • 214
electrical • 214
input/output • 215
mechanical • 214
Starting Panel Configuration • 38
Steps to create a Configuration Template • 96
Sticky Mode • 52
Summary Page • 42
Support Contact Information • 2
Support for 64 Levels • 102
Support for Copy/Cut/Paste/Drag and Drop Button Assignations • 134
Support Page • 56
Supported Browsers • 37
Switching Favorite Sources • 129
Synchronizing Database structure from another Router • 200
T
Tabs in a Processing Configuration • 78
Tabs in a Router Configuration • 101
Toggling Primary and Secondary Server • 209
Tools Page • 57
Tools You Will Need • 35
Trademarks • 2
TRAX functionality • 144
TRAX Functionality • 144
TRAX Options • 147
Types of Slave Panels • 67
U
Undoing a Take • 70
Unity • 72
Unlocking a Destination • 130
Unpacking a Product • 13
Unpacking Panels • 32
Unpacking/Shipping Information • 13
Up and Down Buttons • 85
Upgrading Multiple Panels • 201
Upgrading Panel Firmware • 201
USB • 210
USB Notes • 45
Users • 58
Using the Offline Configuration Editor • 202
V
Viewing Hardware and Software Versions • 209
W
Waste from Electrical and Electronic Equipment (WEEE) Compliance • 17
Working with Button Per Source mode • 114
Working with Categories • 115
Working with Grouping • 117
Writing Conventions • 10
X

X-Y Ports • 34